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How to Use this Guide

This guide describes the features of the DataStage® Designer. It is 

intended for application developers and system administrators who 

want to use DataStage to design and develop data warehousing 

applications. 

If you are new to DataStage, read the first two chapters for an 

overview of data warehousing and the concepts and use of 

DataStage. 

The manual contains enough information to get you started in 

designing DataStage jobs. For more detailed information about 

particular types of data source or data target, refer to DataStage 

Server: Server Job Developer’s Guide, DataStage Enterprise Edition: 

Parallel Job Developer’s Guide, and DataStage Enterprise MVS 

Edition: Mainframe Job Developer's Guide.

To find particular topics in this guide, you can:

Use the Guide’s contents list (at the beginning of the Guide).

Use the Guide’s index (at the end of the Guide).

Use the Adobe Acrobat Reader bookmarks.

Use the Adobe Acrobat Reader search facility (select Edit ➤ 
Search).

The guide contains links both to other topics within the guide, and to 

other guides in the DataStage manual set. The links are shown in blue. 

Note that, if you follow a link to another manual, you will jump to that 

manual and lose your place in this manual. Such links are shown in 

italics.

Organization of This Manual
This manual contains the following:

Chapter 1 contains an overview of data warehousing and 
describes how DataStage can aid the development and population 
of a data warehouse. It introduces the DataStage client and server 
components and covers DataStage concepts and terminology.
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Chapter 2 guides you through an example DataStage job to get 
you familiar with the project.

Chapter 3 Gives an overview of the DataStage Designer and its 
user interface.

Chapter 4 describes how to develop a DataStage job using the 
DataStage Designer.

Chapter 5 describes the use of local and shared containers in 
DataStage.

Chapter 6 describes how to use the graphical job sequence 
designer.

Chapter 7 describes the facilities in for generating html format job 
reports.

Chapter 8 describes the Intelligent Assistant which helps you 
create simple jobs in DataStage.

Chapter 9 describes table definitions and their use within the 
DataStage Designer.

Chapter 10 gives an overview of the powerful programming 
facilities available within DataStage which make it easy to 
customize your applications.

Chapter A covers how to navigate and edit the grids that appear in 
many DataStage dialog boxes.

Chapter B provides troubleshooting advice.

Documentation Conventions
This manual uses the following conventions: 

Convention Usage

Bold In syntax, bold indicates commands, function names, keywords, 
and options that must be input exactly as shown. In text, bold 
indicates keys to press, function names, and menu selections.

UPPERCASE In syntax, uppercase indicates BASIC statements and functions 
and SQL statements and keywords.

Italic In syntax, italic indicates information that you supply. In text, 
italic also indicates UNIX commands and options, file names, 
and pathnames.

Plain In text, plain indicates Windows commands and options, file 
names, and path names.

Lucida 
Typewriter

The Lucida Typewriter font indicates examples of source code 
and system output.
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The following conventions are also used:

Syntax definitions and examples are indented for ease in reading.

All punctuation marks included in the syntax – for example, 
commas, parentheses, or quotation marks – are required unless 
otherwise indicated.

Syntax lines that do not fit on one line in this manual are 
continued on subsequent lines. The continuation lines are 
indented. When entering syntax, type the entire syntax entry, 
including the continuation lines, on the same input line.

Lucida 
Typewriter

In examples, Lucida Typewriter bold indicates characters that 
the user types or keys the user presses (for example, 
<Return>).

[ ] Brackets enclose optional items. Do not type the brackets unless 
indicated.

{ } Braces enclose nonoptional items from which you must select 
at least one. Do not type the braces.

itemA | itemB A vertical bar separating items indicates that you can choose 
only one item. Do not type the vertical bar.

... Three periods indicate that more of the same type of item can 
optionally follow.

➤ A right arrow between menu commands indicates you should 
choose each command in sequence. For example, “Choose File 
➤ Exit” means you should choose File from the menu bar, 
then choose Exit from the File pull-down menu.

This line 
➥ continues

The continuation character is used in source code examples to 
indicate a line that is too long to fit on the page, but must be 
entered as a single line on screen.

Convention Usage
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User Interface Conventions
The following picture of a typical DataStage dialog box illustrates the 

terminology used in describing user interface elements:

The DataStage user interface makes extensive use of tabbed pages, 

sometimes nesting them to enable you to reach the controls you need 

from within a single dialog box. At the top level, these are called 

“pages”, at the inner level these are called “tabs”. In the example 

above, we are looking at the General tab of the Inputs page. When 

using context sensitive online help you will find that each page has a 

separate help topic, but each tab uses the help topic for the parent 

page. You can jump to the help pages for the separate tabs from 

within the online help.

DataStage Documentation
DataStage documentation includes the following:

DataStage Designer Guide. This guide describes the DataStage 
Designer, and gives a general description of how to create, design, 
and develop a DataStage application. 

DataStage Manager Guide. This guide describes the DataStage 
Manager and describes how to use and maintain the DataStage 
Repository.

Option
Button

Button

Check
Box

Browse 
Button

Drop

List
Down

The Inputs Page

The

Tab
General

Field
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DataStage Server: Server Job Developer’s Guide: This guide 
describes the tools that are used in building a server job, and it 
supplies programmer’s reference information.

DataStage Enterprise Edition: Parallel Job Developer’s 
Guide: This guide describes the tools that are used in building a 
parallel job, and it supplies programmer’s reference information.

DataStage Enterprise Edition: Parallel Job Advanced 
Developer’s Guide: This guide gives more specialized 
information about parallel job design.

DataStage Enterprise MVS Edition: Mainframe Job 
Developer’s Guide: This guide describes the tools that are used 
in building a mainframe job, and it supplies programmer’s 
reference information.

DataStage Director Guide: This guide describes the DataStage 
Director and how to validate, schedule, run, and monitor 
DataStage server jobs. 

DataStage Administrator Guide: This guide describes 
DataStage setup, routine housekeeping, and administration.

DataStage Install and Upgrade Guide: This guide contains 
instructions for installing DataStage on Windows and UNIX 
platforms, and for upgrading existing installations of DataStage.

DataStage NLS Guide: This guide contains information about 
using the NLS features that are available in DataStage when NLS 
is installed.

These guides are also available online in PDF format. You can read 

them with the Adobe Acrobat Reader supplied with DataStage. See 

DataStage Install and Upgrade Guide for details about installing the 

manuals and the Adobe Acrobat Reader.

You can use the Acrobat search facilities to search the whole 

DataStage document set. To use this feature, To use this feature, 

select Edit ➤ Search then choose the All PDF documents in option 

and specify the DataStage docs directory (by default this is 

C:\Program Files\Ascential\DataStage\Docs).

Extensive online help is also supplied. This is especially useful when 

you have become familiar with using DataStage and need to look up 

particular pieces of information.
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1
Introduction

This chapter is an overview of data warehousing and DataStage. 

The last few years have seen the continued growth of IT (information 

technology) and the requirement of organizations to make better use 

of the data they have at their disposal. This involves analyzing data in 

active databases and comparing it with data in archive systems. 

Although offering the advantage of a competitive edge, the cost of 

consolidating data into a data mart or data warehouse was high. It 

also required the use of data warehousing tools from a number of 

vendors and the skill to create a data warehouse.

Developing a data warehouse or data mart involves design of the data 

warehouse and development of operational processes to populate 

and maintain it. In addition to the initial setup, you must be able to 

handle on-going evolution to accommodate new data sources, 

processing, and goals. 

DataStage simplifies the data warehousing process. It is an integrated 

product that supports extraction of the source data, cleansing, 

decoding, transformation, integration, aggregation, and loading of 

target databases. 

Although primarily aimed at data warehousing environments, 

DataStage can also be used in any data handling, data migration, or 

data reengineering projects. 
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About Data Warehousing
The aim of data warehousing is to make more effective use of the data 

available in an organization and to aid decision-making processes. 

A data warehouse is a central integrated database containing data 

from all the operational sources and archive systems in an 

organization. It contains a copy of transaction data specifically 

structured for query analysis. This database can be accessed by all 

users, ensuring that each group in an organization is accessing 

valuable, stable data. 

A data warehouse is a “snapshot” of the operational databases 

combined with data from archives. The data warehouse can be 

created or updated at any time, with minimum disruption to 

operational systems. Any number of analyses can be performed on 

the data, which would otherwise be impractical on the operational 

sources. 

Operational Databases Versus Data Warehouses
Operational databases are usually accessed by many concurrent 

users. The data in the database changes quickly and often. It is very 

difficult to obtain an accurate picture of the contents of the database 

at any one time. 

Because operational databases are task oriented, for example, stock 

inventory systems, they are likely to contain “dirty” data. The high 

throughput of data into operational databases makes it difficult to trap 

mistakes or incomplete entries. However, you can cleanse data before 

loading it into a data warehouse, ensuring that you store only “good” 

complete records. 

Constructing the Data Warehouse
A data warehouse is created by extracting data from one or more 

operational databases. The data is transformed to eliminate 

inconsistencies, aggregated to summarize data, and loaded into the 

data warehouse. The end result is a dedicated database which 

contains stable, nonvolatile, integrated data. This data also represents 

a number of time variants (for example, daily, weekly, or monthly 

values), allowing the user to analyze trends in the data.

The data in a data warehouse is classified based on the subjects of 

interest to the organization. For a bank, these subjects may be 

customer, account number, and transaction details. For a retailer, 

these may include product, price, quantity sold, and order number.
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Introduction About Data Warehousing
Each data warehouse includes detailed data. However, where only a 

portion of this detailed data is required, a data mart may be more 

suitable. A data mart is generated from the data contained in the data 

warehouse and contains focused data that is frequently accessed or 

summarized, for example, sales or marketing data. 

The person who constructs the data warehouse must know the needs 

of users who will use the data warehouse or data marts. This means 

knowing the data contained in each operational database and how 

each database is related (if at all). 

Defining the Data Warehouse
Defining the warehouse is one of the first steps in creating a data 

warehouse. The definition describes the content of the data 

warehouse by specifying the data elements and any transforms 

(conversions) required before the data is stored. The definition of the 

data warehouse is described in terms of meta data. Meta data is data 

about the data you are handling – typically a set of column definitions 

describing the structure of the data.

Meta data can be created using the schemas or subschemas that are 

used to define the operational databases. Although meta data can be 

difficult to define and be a time-consuming process, it holds the key to 

a successful data warehouse. 

Data Extraction
The data in operational or archive systems is the primary source of 

data for the data warehouse. Operational databases can be indexed 

files, networked databases, or relational database systems. Data 

extraction is the process used to obtain data from operational 

sources, archives, and external data sources. 

Data Aggregation
An operational data source usually contains records of individual 

transactions such as product sales. If the user of a data warehouse 

only needs a summed total, you can reduce records to a more 

manageable number by aggregating the data. 

The summed (aggregated) total is stored in the data warehouse. 

Because the number of records stored in the data warehouse is 

greatly reduced, it is easier for the end user to browse and analyze the 

data.
Designer Guide 1-3



About DataStage Introduction
Data Transformation
Because the data in a data warehouse comes from many sources, the 

data may be in different formats or be inconsistent. Transformation is 

the process that converts data to a required definition and value. 

Data is transformed using routines based on a transformation rule, for 

example, product codes can be mapped to a common format using a 

transformation rule that applies only to product codes. 

After data has been transformed it can be loaded into the data 

warehouse in a recognized and required format.

Advantages of Data Warehousing
A data warehousing strategy provides the following advantages:

Capitalizes on the potential value of the organization’s information

Improves the quality and accessibility of data

Combines valuable archive data with the latest data in operational 
sources

Increases the amount of information available to users

Reduces the requirement of users to access operational data

Reduces the strain on IT departments, as they can produce one 
database to serve all user groups

Allows new reports and studies to be introduced without 
disrupting operational systems

Promotes users to be self sufficient

About DataStage
DataStage has the following features to aid the design and processing 

required to build a data warehouse:

Uses graphical design tools. With simple point-and-click 
techniques you can draw a scheme to represent your processing 
requirements. 

Extracts data from any number or type of database. 

Handles all the meta data definitions required to define your data 
warehouse. You can view and modify the table definitions at any 
point during the design of your application.

Aggregates data. You can modify SQL SELECT statements used to 
extract data. 
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Transforms data. DataStage has a set of predefined transforms 
and functions you can use to convert your data. You can easily 
extend the functionality by defining your own transforms to use. 

Loads the data warehouse. 

DataStage consists of a number of client and server components. For 

more information, see "Client Components" on page 1-5 and "Server 

Components" on page 1-5.

DataStage server and parallel jobs are compiled and run on the 

DataStage server. The job will connect to databases on other 

machines as necessary, extract data, process it, then write the data to 

the target data warehouse. 

DataStage mainframe jobs are compiled and run on a mainframe. 

Data extracted by such jobs is then loaded into the data warehouse. 

Client Components
DataStage has four client components which are installed on any PC 

running Windows 2000 or Windows XP: 

DataStage Designer. A design interface used to create 
DataStage applications (known as jobs). Each job specifies the 
data sources, the transforms required, and the destination of the 
data. Jobs are compiled to create executables that are scheduled 
by the Director and run by the Server (mainframe jobs are 
transferred and run on the mainframe).

DataStage Director. A user interface used to validate, schedule, 
run, and monitor DataStage server jobs and parallel jobs.

DataStage Manager. A user interface used to view and edit the 
contents of the Repository.

DataStage Administrator. A user interface used to perform 
administration tasks such as setting up DataStage users, creating 
and moving projects, and setting up purging criteria.

Server Components
There are three server components:

Repository. A central store that contains all the information 
required to build a data mart or data warehouse. 

DataStage Server. Runs executable jobs that extract, transform, 
and load data into a data warehouse. 

DataStage Package Installer. A user interface used to install 
packaged DataStage jobs and plug-ins.
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DataStage Projects
You always enter DataStage through a DataStage project. When you 

start a DataStage client you are prompted to attach to a project. Each 

project contains:

DataStage jobs. 

Built-in components. These are predefined components used in a 
job. 

User-defined components. These are customized components 
created using the DataStage Manager. Each user-defined 
component performs a specific task in a job. 

A complete project may contain several jobs and user-defined 

components. 

There is a special class of project called a protected project. Normally 

nothing can be added, deleted, or changed in a protected project. 

Users can view objects in the project, and perform tasks that affect the 

way a job runs rather than the job’s design. Users with Production 

Manager status can import existing DataStage components into a 

protected project and manipulate projects in other ways.

DataStage Jobs
There are three basic types of DataStage job:

Server jobs. These are compiled and run on the DataStage 
server. A server job will connect to databases on other machines 
as necessary, extract data, process it, then write the data to the 
target data warehouse.

Parallel jobs. These are compiled and run on the DataStage 
server in a similar way to server jobs, but support parallel 
processing on SMP, MPP, and cluster systems.

Mainframe jobs. These are available only if you have Enterprise 
MVS Edition installed. A mainframe job is compiled and run on 
the mainframe. Data extracted by such jobs is then loaded into the 
data warehouse. 

There are two other entities that are similar to jobs in the way they 

appear in the DataStage Designer, and are handled by it. These are:

Shared containers. These are reusable job elements. They 
typically comprise a number of stages and links. Copies of shared 
containers can be used in any number of server jobs or parallel 
jobs and edited as required.
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Job Sequences. A job sequence allows you to specify a 
sequence of DataStage jobs to be executed, and actions to take 
depending on results.

DataStage jobs consist of individual stages. Each stage describes a 

particular database or process. For example, one stage may extract 

data from a data source, while another transforms it. Stages are 

added to a job and linked together using the Designer.

There are three basic types of stage:

Built-in stages. Supplied with DataStage and used for extracting, 
aggregating, transforming, or writing data. All types of job have 
these stages.

Plug-in stages. Additional stages that can be installed in 
DataStage to perform specialized tasks that the built-in stages do 
not support. Server jobs and parallel jobs can make use of these.

Job Sequence Stages. Special built-in stages which allow you to 
define sequences of activities to run. Only Job Sequences have 
these.

The following diagram represents one of the simplest jobs you could 

have: a data source, a Transformer (conversion) stage, and the final 

database. The links between the stages represent the flow of data into 

or out of a stage.

You must specify the data you want at each stage, and how it is 

handled. For example, do you want all the columns in the source data, 

or only a select few? Should the data be aggregated or converted 

before being passed on to the next stage?

You can use DataStage with MetaBrokers in order to exchange meta 

data with other data warehousing tools. You might, for example, 

import table definitions from a data modelling tool.

Data
Source

Transformer
Stage

Data
Warehouse
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DataStage NLS
DataStage has built-in National Language Support (NLS). With NLS 

installed, DataStage can do the following:

Process data in a wide range of languages

Accept data in any character set into most DataStage fields

Use local formats for dates, times, and money (server jobs) 

Sort data according to local rules 

Convert data between different encodings of the same language 
(for example, for Japanese it can convert JIS to EUC)

DataStage NLS is optionally installed as part of the DataStage server. 

If NLS is installed, various extra features (such as dialog box pages 

and drop-down lists) appear in the product. If NLS is not installed, 

these features do not appear.

NLS is implemented in different ways for server jobs and parallel jobs, 

and each has its own set of maps:

For server jobs, NLS is implemented by the DataStage server 
engine. 

For parallel jobs, NLS is implemented using the ICU library. 

Data is processed in Unicode format. This is an international standard 

character set that contains nearly all the characters used in languages 

around the world. DataStage maps data to or from Unicode format as 

required. 

For more detailed information about DataStage’s implementation of 

NLS, see DataStage NLS Guide.

Character Set Maps and Locales
Each DataStage project has a language assigned to it during 

installation. This equates to one or more character set maps and 

locales which support that language. One map and one locale are 

assigned as project defaults.

The maps define the character sets that the project can use. 

The locales define the local formats for dates, times, sorting order, 
and so on that the project can use. For parallel jobs the locale only 
affects the sorting order.

The DataStage client and server components also have maps 

assigned to them during installation to ensure that data is transferred 

between them in the correct character set. For more information, see 

"NLS Configuration" in DataStage Administrator Guide. 
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When you design a DataStage job, you can override the project 

default map at several levels:

For a job 

For a stage within a job

For a column within a stage (for certain stage types)

For transforms and routines used to manipulate data within a 
stage

For imported meta data and table definitions

The locale and character set information becomes an integral part of 

the job. When you package and release a job, the NLS support can be 

used on another system, provided that the correct maps and locales 

are installed and loaded.

DataStage Terms and Concepts
The following terms are used in DataStage: 

Term Description

administrator The person who is responsible for the maintenance 
and configuration of DataStage, and for DataStage 
users.

after-job subroutine A routine that is executed after a job runs.

after-stage subroutine A routine that is executed after a stage processes 
data. 

Aggregator stage A stage type that computes totals or other functions 
of sets of data.

Annotation A note attached to a DataStage job in the Diagram 
window. 

BCPLoad stage A plug-in stage supplied with DataStage that bulk 
loads data into a Microsoft SQL Server or Sybase 
table. (Server jobs only.)

before-job subroutine A routine that is executed before a job is run.

before-stage subroutine A routine that is executed before a stage processes 
any data.

built-in data elements There are two types of built-in data elements: those 
that represent the base types used by DataStage 
during processing and those that describe different 
date/time formats.
Designer Guide 1-9



DataStage Terms and Concepts Introduction
built-in transforms The transforms supplied with DataStage. See Server 
Job Developer’s Guide for a complete list.

Change Apply stage A parallel job stage that applies a set of captured 
changes to a data set.

Change Capture stage A parallel job stage that compares two data sets and 
records the differences between them.

Cluster Type of system providing parallel processing. In 
cluster systems, there are multiple processors, and 
each has its own hardware resources such as disk 
and memory.

column definition Defines the columns contained in a data table. 
Includes the column name and the type of data 
contained in the column.

Column Export stage A parallel job stage that exports a column of another 
type to a string or binary column.

Column Import stage A parallel job stage that imports a column from a 
string or binary column.

Combine Records stage A parallel job stage that combines several columns 
associated by a key field to build a vector.

Compare stage A parallel job stage that performs a column by 
column compare of two pre-sorted data sets.

Complex Flat File stage A mainframe source stage or parallel stage that 
extracts data from a flat file containing complex data 
structures, such as arrays, groups, and redefines. 
The parallel stage can also write to complex flat files.

Compress stage A parallel job stage that compresses a data set.

container A group of stages and links in a job design. 

Container stage A built-in stage type that represents a group of 
stages and links in a job design. 

Copy stage A parallel job stage that copies a data set.

custom transform A transform function defined by the DataStage 
developer.

Data Browser A tool used from within the DataStage Manager or 
DataStage Designer to view the content of a table or 
file.

data element A specification that describes the type of data in a 
column and how the data is converted. (Server jobs 
only.)

Term Description
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DataStage Administrator A tool used to configure DataStage projects and 
users. For more details, see DataStage Administrator 
Guide.

DataStage Designer A graphical design tool used by the developer to 
design and develop a DataStage job. 

DataStage Director A tool used by the operator to run and monitor 
DataStage server jobs.

DataStage Manager A tool used to view and edit definitions in the 
Repository.

DataStage Package Installer A tool used to install packaged DataStage jobs and 
plug-ins.

Data Set stage A parallel job stage. Stores a set of data.

DB2stage A parallel stage that allows you to read and write a 
DB2 database.

DB2 Load Ready Flat File 
stage

A mainframe target stage. It writes data to a flat file 
in Load Ready format and defines the meta data 
required to generate the JCL and control statements 
for invoking the DB2 Bulk Loader.

Decode stage A parallel job stage that uses a UNIX command to 
decode a previously encoded data set.

Delimited Flat File stage A mainframe target stage that writes data to a 
delimited flat file.

developer The person designing and developing DataStage 
jobs.

Difference stage A parallel job stage that compares two data sets and 
works out the difference between them.

Encode stage A parallel job stage that encodes a data set using a 
UNIX command.

Expand stage A parallel job stage that expands a previously 
compressed data set.

Expression Editor An interactive editor that helps you to enter correct 
expressions into a Transformer stage in a DataStage 
job design.

External Filter stage A parallel job stage that uses an external program to 
filter a data set.

External Routine stage A mainframe processing stage that calls an external 
routine and passes row elements to it.

Term Description
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External Source stage A mainframe source stage that allows a mainframe 
job to read data from an external source.

A parallel job stage that allows a parallel job to read 
a data source. 

External Target stage A mainframe target stage that allows a mainframe 
job to write data to an external source.

A parallel job stage that allows a parallel job to write 
to a data source.

File Set stage Parallel job stage. A set of files used to store data.

Filter stage Parallel job stage. Filters out records from 

an input data set.

Fixed-Width Flat File stage A mainframe source/target stage. It extracts data 
from binary fixed-width flat files, or writes data to 
such a file.

FTP stage A mainframe post-processing stage that generates 
JCL to perform an FTP operation.

Funnel stage A parallel job stage that copies multiple data sets to 
a single data set.

Generator stage A parallel job stage that generates a dummy data 
set.

Graphical performance 
monitor

A monitor that displays status information and 
performance statistics against links in a job open in 
the DataStage Designer canvas as the job runs in the 
Director or debugger.

Hashed File stage A stage that extracts data from or loads data into a 
database that contains hashed files. (Server jobs 
only)

Head stage A parallel job stage that copies the specified number 
of records from the beginning of a data partition.

Informix Enterprise stage A parallel job stage that allows you to read and write 
an Informix XPS database.

Intelligent Assistant DataStage comes complete with a number of 
intelligent assistants. These lead you step by step 
through some of the basic DataStage operations.

Inter-process stage A server job stage that allows you to run server jobs 
in parallel on an SMP system.

Term Description
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job A collection of linked stages, data elements, and 
transforms that define how to extract, cleanse, 
transform, integrate, and load data into a target 
database. Jobs can either be server jobs or 
mainframe jobs.

job control routine A routine that is used to create a controlling job, 
which invokes and runs other jobs.

job sequence A controlling job which invokes and runs other jobs, 
built using the graphical job sequencer.

Join stage A mainframe processing stage or parallel job active 
stage that joins two input sources.

Link collector stage A server job stage that collects previously 
partitioned data together.

Link partitioner stage A server job stage that allows you to 

partition data so that it can be processed in 

parallel on an SMP system.

local container A container which is local to the job in which it was 
created.

Lookup stage A mainframe processing stage and Parallel active 
stage that performs table lookups.

Lookup File stage A parallel job stage that provides storage for a 
lookup table.

mainframe job A job that is transferred to a mainframe, then 
compiled and run there.

Make Subrecord stage A parallel job stage that combines a number of 
vectors to form a subrecord.

Make Vector stage A parallel job stage that combines a number of fields 
to form a vector.

Merge stage A parallel job stage that combines data sets.

meta data Data about data, for example, a table definition 
describing columns in which data is structured.

MetaBroker A tool that allows you to exchange meta data 
between DataStage and other data warehousing 
tools.

MPP Type of system providing parallel processing. In 
MPP (massively parallel processing) systems, there 
are multiple processors, and each has its own 
hardware resources such as disk and memory.

Term Description
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Modify stage A parallel job stage that alters the column definitions 
of the output data set.

Multi-Format Flat File stage A mainframe source stage that handles different 
formats in flat file data sources.

NLS National Language Support. With NLS enabled, 
DataStage can support the handling of data in a 
variety of character sets.

normalization The conversion of records in NF2 (nonfirst-normal 
form) format, containing multivalued data, into one 
or more 1NF (first normal form) rows.

null value A special value representing an unknown value. This 
is not the same as 0 (zero), a blank, or an empty 
string.

ODBC stage A stage that extracts data from or loads data into a 
database that implements the industry standard 
Open Database Connectivity API. Used to represent 
a data source, an aggregation step, or a target data 
table. (Server jobs only)

operator The person scheduling and monitoring DataStage 
jobs.

Oracle 7 Load stage A plug-in stage supplied with DataStage that bulk 
loads data into an Oracle 7 database table. (Server 
jobs only)

Oracle Enterprise stage A parallel job stage that allows you to read and write 
an Oracle database.

parallel extender The DataStage option that allows you to run parallel 
jobs. 

parallel job A type of DataStage job that allows you to take 
advantage of parallel processing on SMP, MPP, and 
cluster systems.

Peek Stage A parallel job stage that prints column 

values to the screen as records are copied 

from its input data set to one or more 

output data sets.

plug-in A definition for a plug-in stage. 

plug-in stage A stage that performs specific processing that is not 
supported by the standard server job or parallel job 
stages.

Promote Subrecord stage A parallel job stage that promotes the members of a 
subrecord to a top level field.

Term Description
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Relational stage A mainframe source/target stage that reads from or 
writes to an MVS/DB2 database.

Remove duplicates stage A parallel job stage that removes duplicate entries 
from a data set.

Repository A DataStage area where projects and jobs are stored 
as well as definitions for all standard and user-
defined data elements, transforms, and stages.

SAS stage A parallel job stage that allows you to run SAS 
applications from within the DataStage job.

Parallel SAS Data Set stage A parallel job stage that provides storage for SAS 
data sets.

Sample stage A parallel job stage that samples a data set.

Sequential File stage A stage that extracts data from, or writes data to, a 
text file. (Server job and parallel job only)

server job A job that is compiled and run on the DataStage 
server.

shared container A container which exists as a separate item in the 
Repository and can be used by any server job in the 
project. DataStage supports both server and parallel 
shared containers.

SMP Type of system providing parallel processing. In 
SMP (symmetric multiprocessing) systems, there 
are multiple processors, but these share other 
hardware resources such as disk and memory.

Sort stage A mainframe processing stage or parallel job active 
stage that sorts input columns.

source A source in DataStage terms means any database, 
whether you are extracting data from it or writing 
data to it.

Split Subrecord stage A parallel job stage that separates a number of 
subrecords into top level columns.

Split Vector stage A parallel job stage that separates a number of 
vector members into separate columns.

stage A component that represents a data source, a 
processing step, or the data mart in a DataStage job.

Switch stage A parallel job stage which splits an input data set 
into different output sets depending on the value of 
a selector field.

Term Description
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table definition A definition describing the data you want including 
information about the data table and the columns 
associated with it. Also referred to as meta data.

Tail stage A parallel job stage that copies the specified number 
of records from the end of a data partition.

Teradata Enterprise stage A parallel stage that allows you to read and write a 
Teradata database.

transform function A function that takes one value and computes 
another value from it.

Term Description
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2
Your First

DataStage Project

This chapter describes the steps you need to follow to create your first 

data warehouse, using the sample data provided. The example builds 

a server job and uses a UniVerse table called EXAMPLE1, which is 

automatically copied into your DataStage project during server 

installation. 

EXAMPLE1 represents an SQL table from a wholesaler who deals in 

car parts. It contains details of the wheels they have in stock. There are 

approximately 255 rows of data and four columns: 

CODE. The product code for each type of wheel.

PRODUCT. A text description of each type of wheel.

DATE. The date new wheels arrived in stock (given in terms of 
year, month, and day). 

QTY. The number of wheels in stock.

The aim of this example is to develop and run a DataStage job that:

Extracts the data from the file.

Converts (transforms) the data in the DATE column from a 
complete date (YYYY-MM-DD) stored in internal data format, to a 
year and month (YYYY-MM) stored as a string.

Loads data from the DATE, CODE, and QTY columns into a data 
warehouse. The data warehouse is a sequential file that is created 
when you run the job. 

To load a data mart or data warehouse, you must do the following:

Set up your project

Create a job
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Develop the job

Edit the stages in the job

Compile the job

Run the job

This chapter describes the minimum tasks required to create a 

DataStage job. In the example, you will use the built-in settings and 

options supplied with DataStage. However, because DataStage allows 

you to customize and extend the built-in functionality provided, it is 

possible to perform additional processing at each step. Where this is 

possible, additional procedures are listed under a section called 

Advanced Procedures. These advanced procedures are discussed in 

detail in subsequent chapters. 

Setting Up Your Project
Before you create any DataStage jobs, you must set up your project 

by entering information about your data. This includes the name and 

location of the tables or files holding your data and a definition of the 

columns they contain. Information is stored in table definitions in the 

Repository. The easiest way to enter a table definition is to import 

directly from the source data.

If you were working on a large data warehousing project, you would 

probably use the DataStage Manager to set up the project. As this 

example is simple, and requires you only to import a single table 

definition, you are better doing this directly from the DataStage 

Designer.
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Starting the DataStage Designer
To start the DataStage Designer, choose Start ➤ Programs ➤ 

Ascential DataStage ➤ DataStage Designer. The Attach to 
Project dialog box appears:

This dialog box appears when you start the DataStage Designer, 

Manager, or Director client components from the DataStage program 

folder. In all cases, you must attach to a project by entering your logon 

details. 

Note The program group may be called something other than 

DataStage, depending on how DataStage was installed.

To connect to a project:

1 Enter the name of your host in the Host system field. This is the 
name of the system where the DataStage Server components are 
installed.

2 Enter your user name in the User name field. This is your user 
name on the server system.

3 Enter your password in the Password field. 

Note If you are connecting to the server via LAN Manager, you 

can select the Omit check box. The User name and 

Password fields gray out and you log on to the server 

using your Windows Domain account details. 

4 Choose the project to connect to from the Project drop-down list 
box. This list box displays all the projects installed on your 
DataStage server. Choose your project from the list box. At this 
point, you may only have one project installed on your system 
and this is displayed by default. 
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5 Click OK. The DataStage Designer window appears with the New 
dialog box open, ready for you to create a new job:

Creating a Job
When a DataStage project is installed, it is empty and you must create 

the jobs you need. Each DataStage job can load one or more data 

tables in the final data warehouse. The number of jobs you have in a 

project depends on your data sources and how often you want to 

extract data or load the data warehouse. 

Jobs are created using the DataStage Designer. For this example, you 

need to create a server job, so double-click the New Server Job icon. 

The diagram window appears, in the right pane of the Designer, along 
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with the Tool palette for server jobs. You can now save the job and 

give it a name.

To save the job:

1 Choose File ➤ Save. The Create new job dialog box appears:

2 Enter Example1 in the Job name field. 

3 Enter Example in the Category field.

4 Click OK to save the job. The updated DataStage Designer 
window displays the name of the saved job.
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Defining Table Definitions
For most data sources, the quickest and simplest way to specify a 

table definition is to import it directly from your data source or data 

warehouse. In this example, you must specify a table definition for 

EXAMPLE1.

Importing a Table Definition

The following steps describe how to import a table definition for 

EXAMPLE1:

1 In the Repository window of the DataStage Designer, select the 
Table Definitions branch, and choose Import ➤ UniVerse Table 
Definitions… from the shortcut menu. The Import Meta data 
(UniVerse Tables) dialog box appears:

2 Choose localuv from the DSN drop-down list box. 

3 Click OK. The updated Import Meta data (UniVerse Tables) 
dialog box displays all the files for the chosen data source name:
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Note The screen shot shows an example of tables found 

under localuv. Your system may contain different files to 

the ones shown here.

4 Select project.EXAMPLE1 from the Tables list box, where 
project is the name of your DataStage project. 

5 Click OK. The column information from EXAMPLE1 is imported 
into DataStage. A table definition is created and is stored under 
the Table Definitions ➤ UniVerse ➤ localuv branch in the 
Repository. The updated DataStage Designer window displays the 
new table definition entry in the Repository window.

To view the new table definition, double-click the 

project.EXAMPLE1 item in the Repository window. The Table 
Definition dialog box appears. 

This dialog box has up to five pages. Click the tabs to display each 

page. The General page contains information about where the data is 

found and when the definition was created. 

The Columns page contains information about the columns in the 

data source table. You should see the following columns for 

project.EXAMPLE1:

The Format page contains information describing how the data 

would be formatted when written to a sequential file. You do not need 

to edit this page.

The Relationships page gives foreign key information about the 

table. We are not using foreign keys in this exercise, so you do not 

need to edit this page.
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The NLS page is present if you have NLS installed. It shows the 

current character set map for the table definitions. The map defines 

the character set that the data is in. You do not need to edit this page.

Advanced Procedures
To manually enter table definitions, see Chapter 7, "Job Reports.".

Developing a Job
Jobs are designed and developed using the Designer. The job design 

is developed in the Diagram window (the one with grid lines). Each 

data source, the data warehouse, and each processing step is 

represented by a stage in the job design. The stages are linked 

together to show the flow of data. 

This example requires three stages: 

A UniVerse stage to represent EXAMPLE1 (the data source).

A Transformer stage to convert the data in the DATE column from 
a YYYY-MM-DD date in internal date format to a string giving just 
year and month (YYYY-MM).

A Sequential File stage to represent the file created at run time 
(the data warehouse in this example).

Adding Stages
Stages are added using the tool palette. This palette contains icons 

that represent the components you can add to a job. The palette has 
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different groups to organize the tools available. Click the group title to 

open the group.A typical tool palette is shown below:

To add a stage:

1 Click the stage button on the tool palette that represents the stage 
type you want to add.

2 Click in the Diagram window where you want the stage to be 
positioned. The stage appears in the Diagram window as a 
square. 

You can also drag items from the palette to the Diagram window. 

We recommend that you position your stages as follows:

Data sources on the left

Data warehouse on the right

Transformer stage in the center

When you add stages, they are automatically assigned default names. 

These names are based on the type of stage and the number of the 

item in the Diagram window. You can use the default names in the 

example. 

Once all the stages are in place, you can link them together to show 

the flow of data.

Linking Stages
You need to add two links:

One between the UniVerse and Transformer stages
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One between the Transformer and Sequential File stages

Links are always made in the direction the data will flow, that is, 

usually left to right. When you add links, they are assigned default 

names. You can use the default names in the example.

To add a link:

1 Right-click the first stage, hold the mouse button down and drag 
the link to the transformer stage. Release the mouse button.

2 Right-click the Transformer stage and drag the link to the 
Sequential File stage. The following screen shows how the 
Diagram window looks when you have added the stages and 
links:

3 Save the job design by choosing File ➤ Save. 

Keep the Designer open as you will need it for the next step.

Advanced Procedures

For more advanced procedures, see the following topics in Chapter 4:

"Moving Stages" on page 4-25

"Renaming Stages" on page 4-25

"Deleting Stages" on page 4-26

Editing the Stages
Your job design currently displays the stages and the links between 

them. You must edit each stage in the job to specify the data to use 

and what to do with it. Stages are edited in the job design by double-

clicking each stage in turn. Each stage type has its own editor.
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Editing the UniVerse Stage
The data source (EXAMPLE1) is represented by a UniVerse stage. You 

must specify the data you want to extract from this file by editing the 

stage.

Double-click the stage to edit it. The UniVerse Stage dialog box 

appears:

This dialog box has two pages:

Stage. Displayed by default. This page contains the name of the 
stage you are editing. The General tab specifies where the file is 
found and the connection type. 

Outputs. Contains information describing the data flowing from 
the stage. You edit this page to describe the data you want to 
extract from the file. In this example, the output from this stage 
goes to the Transformer stage. 

To edit the UniVerse stage:

1 Check that you are displaying the General tab on the Stage page. 
Choose localuv from the Data source name drop-down list. 
localuv is where EXAMPLE1 is copied to during installation.

The remaining parameters on the General and Details tabs are 

used to enter logon details and describe where to find the file. 

Because EXAMPLE1 is installed in localuv, you do not have to 

complete these fields, which are disabled. 

2 Click the Outputs tab. The Outputs page appears:
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The Outputs page contains the name of the link the data flows 

along and the following four tabs:

– General. Contains the name of the table to use and an optional 
description of the link.

– Columns. Contains information about the columns in the 
table.

– Selection. Used to enter an optional SQL SELECT clause (an 
Advanced procedure).

– View SQL. Displays the SQL SELECT statement used to 
extract the data. 

3 Choose dstage.EXAMPLE1 from the Available tables drop-
down list. 

4 Click Add to add dstage.EXAMPLE1 to the Table names field.

5 Click the Columns tab. The Columns tab appears at the front of 
the dialog box.

You must specify the columns contained in the file you want to 

use. Because the column definitions are stored in a table 

definition in the Repository, you can load them directly. 

6 Click Load… . The Table Definitions window appears with the 
UniVerse ➤ localuv branch highlighted. 

7 Select dstage.EXAMPLE1. The Select Columns dialog box 
appears, allowing you to select which column definitions you 
want to load. 
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8 In this case you want to load all available columns definitions, so 
just click OK. The column definitions specified in the table 
definition are copied to the stage. The Columns tab contains 
definitions for the four columns in EXAMPLE1:

9 You can use the Data Browser to view the actual data that is to be 
output from the UniVerse stage. Click the View Data… button to 
open the Data Browser window.
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10 Click OK to save the stage edits and close the UniVerse Stage 
dialog box. Notice that a small table icon appears on the output 
link to indicate that it now has column definitions associated with 
it.

11 Choose File ➤ Save to save your job design so far.

Note In server jobs column definitions are attached to a link. You 

can view or edit them at either end of the link. If you change 

them in a stage at one end of the link, the changes are 

automatically seen in the stage at the other end of the link. 

This is how column definitions are propagated through all 

the stages in a DataStage server job, so the column 

definitions you loaded into the UniVerse stage are viewed 

when you edit the Transformer stage.

Editing the Transformer Stage
The Transformer stage performs any data conversion required before 

the data is output to another stage in the job design. In this example, 

the Transformer stage is used to convert the data in the DATE column 

from a YYYY-MM-DD date in internal date format to a string giving 

just the year and month (YYYY-MM). 

There are two links in the stage:

The input from the data source (EXAMPLE1)

The output to the Sequential File stage

To enable the use of one of the built-in DataStage transforms, you will 

assign data elements to the DATE columns input and output from the 

Transformer stage. A DataStage data element defines more precisely 

the kind of data that can appear in a given column. 

In this example, you assign the Date data element to the input 

column, to specify the date is input to the transform in internal format, 

and the MONTH.TAG data element to the output column, to specify 

that the transform produces a string of the format YYYY-MM.

Note If the data in the other columns required transforming, you 

could assign DataStage data elements to these columns 

too.
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Double-click the Transformer stage to edit it. The Transformer Editor 

appears:

Input columns are shown on the left, output columns on the right. The 

upper panes show the columns together with derivation details, the 

lower panes show the column meta data. In this case, input columns 

have already been defined for input link DSLink3. No output columns 

have been defined for output link DSLink4, so the right panes are 

blank.

The next steps are to define the columns that will be output by the 

Transformer stage, and to specify the transform that will enable the 

stage to convert the type and format of dates before they are output.
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1 Working in the upper-left pane of the Transformer Editor, select the 
input columns that you want to derive output columns from. Click 
on the CODE, DATE, and QTY columns while holding down the 
Ctrl key.

2 Click the left mouse button again and, keeping it held down, drag 
the selected columns to the output link in the upper-right pane. 
Drop the columns over the Column Name field by releasing the 
mouse button. The columns appear in the top pane and the 
associated meta data appears in the lower-right pane:

The next step is to edit the meta data for the input and output 

links. You will be transforming dates from YYYY-MM-DD, 

presented in internal date format, to strings containing the date in 

the form YYYY-MM. You need to select a data element for the 

input DATE column, to specify that the date is input to the 

transform in internal format, and a new SQL type and data 

element for the output DATE column, to specify that it will be 

carrying a string. You do this in the lower-left and lower-right 

panes of the Transformer Editor.

3 In the Data element field for the DSLink3.DATE column, select 
Date from the drop-down list.

4 In the SQL type field for the DSLink4 DATE column, select Char 
from the drop-down list.

5 In the Length field or the DSLink4 DATE column, enter 7.

6 In the Data element field for the DSLink4 DATE column, select 
MONTH.TAG from the drop-down list.

Next you will specify the transform to apply to the input DATE 

column to produce the output DATE column. You do this in the 

upper-right pane of the Transformer Editor.
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7 Double-click the Derivation field for the DSLink4 DATE column. 
The Expression Editor box appears. At the moment, the box 
contains the text DSLink3.DATE, which indicates that the output 
DATE column is directly derived from the input DATE column. 
Select the text DSLink3 and delete it by pressing the Delete key.

8 Right-click in the Expression Editor box to open the Suggest 
Operand menu:
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9 Select DS Transform… from the menu. The Expression Editor 
then displays the transforms that are applicable to the 
MONTH.TAG data element:

10 Select the MONTH.TAG transform. It appears in the Expression 
Editor box with the argument field [%Arg1%] highlighted.

11 Right-click to open the Suggest Operand menu again. This time, 
select Input Column. A list of available input columns appears:

12 Select DSLink3.DATE. This then becomes the argument for the 
transform.

13 Click OK to save the changes and exit the Transformer Editor. 
Once more the small icon appears on the output link from the 
transformer stage to indicate that the link now has column 
definitions associated with it.

Editing the Sequential File Stage
The data warehouse is represented by a Sequential File stage. The 

data to be written to the data warehouse is already specified in the 

Transformer stage. However, you must enter the name of a file to 

which the data is written when the job runs. If the file does not exist, it 

is created. 
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Double-click the stage to edit it. The Sequential File Stage dialog 

box appears:

This dialog box has two pages:

Stage. Displayed by default. This page contains the name of the 
stage you are editing and two tabs. The General tab specifies the 
line termination type, and the NLS tab specifies a character set 
map to use with the stage (this appears if you have NLS installed). 

Inputs. Describes the data flowing into the stage. This page only 
appears when you have an input to a Sequential File stage. You do 
not need to edit the column definitions on this page, because they 
were all specified in the Transformer stage. 

To edit the Sequential File stage:

1 Click the Inputs tab. The Inputs page appears. This page 
contains:

– The name of the link. This is automatically set to the link name 
used in the job design.

– General tab. Contains the pathname of the file, an optional 
description of the link, and update action choices. You can use 
the default settings for this example, but you may want to enter 
a file name (by default the file is named after the input link). 

– Format tab. Determines how the data is written to the file. In 
this example, the data is written using the default settings, that 
is, as a comma-delimited file.

– Columns tab. Contains the column definitions for the data you 
want to extract. This tab contains the column definitions 
specified in the Transformer stage’s output link.
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2 Enter the pathname of the text file you want to create in the File 
name field, for example, seqfile.txt. By default the file is 
placed in the server project directory (for example, 
c:\Ascential\DataStage\Projects\datastage) and is named after the 
input link, but you can enter, or browse for, a different directory.

3 Click OK to close the Sequential File Stage dialog box.

4 Choose File ➤ Save to save the job design. 

The job design is now complete and ready to be compiled. 

Compiling a Job
When you finish your design you must compile it to create an 

executable job. Jobs are compiled using the Designer. To compile the 

job, do one of the following:

Choose File ➤ Compile. 

Click the Compile button on the toolbar.

The Compile Job window appears: 

The job is compiled. The result of the compilation appears in the 

display area. If the result of the compilation is Job successfully 
compiled with no errors you can go on to schedule or run the job. 

The executable version of the job is stored in your project along with 

your job design.

If an error is displayed, click Show Error. The stage where the 

problem occurs is highlighted in the job design. Check that all the 

input and output column definitions have been specified correctly, 

and that you have entered directory paths and file or table names 

where appropriate. 

For more information about the error, click More. Click Close to close 

the Compile Job window.
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Running a Job
Executable jobs are scheduled by the DataStage Director and run by 

the DataStage Server. You can start the Director from the Designer by 

choosing Tools ➤ Run Director. 

When the Director is started, the DataStage Director window appears 

with the status of all the jobs in your project:

Highlight your job in the Job name column. To run the job, choose 

Job ➤ Run Now or click the Run button on the toolbar. The Job 
Run Options dialog box appears and allows you to specify any 

parameter values and to specify any job run limits. In this case, just 

click Run. The status changes to Running. When the job is complete, 

the status changes to Finished. 

Choose File ➤ Exit to close the DataStage Director window.

Refer to DataStage Director Guide for more information about 

scheduling and running jobs.

Advanced Procedures

It is possible to run a job from within another job. For more 

information, see "Job Control Routines" on page 4-63 and Chapter 6, 

"Job Sequences."

Analyzing Your Data Warehouse
When you have data in your data mart or data warehouse, you can 

use any BI (business intelligence) tool to analyze and report on the 

data.
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In the example, you can confirm that the data was converted and 

loaded correctly by viewing your text file using the Windows 

WordPad. Alternatively, you could use the built-in Data Browser to 

view the data from the Inputs page of the Sequential File stage. See 

"Using the Data Browser" on page 4-37. The following is an example 

of the file produced in WordPad:
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3
DataStage Designer Overview

This chapter describes the main features of the DataStage Designer. It 

tells you how to start the Designer and takes a quick tour of the user 

interface.

Starting the DataStage Designer
To start the DataStage Designer, choose Start ➤ Programs ➤ 
Ascential DataStage ➤ DataStage Designer. The Attach to 
Project dialog box appears:

You can also start the Designer from the shortcut icon on the desktop, 

or from the DataStage Suite applications bar if you have it installed.

You must connect to a project as follows:
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1 Enter the name of your host in the Host system field. This is the 
name of the system where the DataStage Server components are 
installed.

2 Enter your user name in the User name field. This is your user 
name on the server system.

3 Enter your password in the Password field. 

Note If you are connecting to the server via LAN Manager, you 

can select the Omit check box. The User name and 

Password fields gray out and you log on to the server 

using your Windows Domain account details. 

4 Choose the project to connect to from the Project drop-down list 
box. This list box displays all the projects installed on your 
DataStage server. 

5 Click OK. The DataStage Designer window appears, by default 
with the New dialog box open, allowing you to choose a type of 
job to create. You can set options to specify that the Designer 
opens with an empty server or mainframe job, or nothing at all, 
see "Specifying Designer Options" on page 3-20.

Note You can also start the DataStage Designer directly from the 

DataStage Manager or Director by choosing Tools ➤ Run 
Designer. 

The DataStage Designer Window
By default, DataStage initially starts with the New dialog box open. 

You can choose to create a new job as follows:

Server job. These run on the DataStage Server, connecting to 
other data sources as necessary. These are available if you have 
installed Server.

Mainframe job. These are available only if you have installed 
Enterprise MVS Edition. Mainframe jobs are uploaded to a 
mainframe, where they are compiled and run. 

Parallel job. These are available only if you have installed the 
Enterprise Edition. These run on DataStage servers that are SMP, 
MPP, or cluster systems. 

Server Shared containers. These are reusable job elements. 
Copies of shared containers can be used in any number of server 
jobs and edited as required. They can also be used in parallel jobs 
to make server job functionality available.

Parallel Shared containers. These are reusable job elements. 
Copies of shared containers can be used in any number of parallel 
jobs and edited as required.
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Job Sequences. A job sequence allows you to specify a 
sequence of DataStage server and parallel jobs to be executed, 
and actions to take depending on results.

New Data Migration Job. This quickly generates a parallel job 
to move data from a single source to a single target.

Or you can choose to open an existing job of any of these types. You 

can use the DataStage options to specify that the Designer always 

opens a new server or mainframe job, shared container or job 

sequence when its starts.

The initial appearance of the DataStage Designer is shown below:

The design pane on the right side and the Property browser are both 

empty, and a limited number of menus appear on the menu bar. To 

see a more fully populated Designer window, choose File ➤ New and 

choose the type of job to create from the New dialog box (this process 

will be familiar to you if you worked through the example in 
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Chapter 2, "Your First DataStage Project.") For the purposes of this 

example, we created a server job.

Menu Bar

There are nine pull-down menus. The commands available in each 

menu change depending on whether you are currently displaying a 

server job, parallel job, or a mainframe job.

File. Creates, opens, closes, and saves 

DataStage jobs. Generates reports on 

DataStage jobs. Also sets up printers, compiles 

server and parallel jobs, runs server and 

parallel jobs, generates and uploads mainframe 

jobs, and exits the Designer.

Mainframe JobServer Job
Parallel Job
3-4 Designer Guide



DataStage Designer Overview Starting the DataStage Designer
Edit. Allows you to undo and redo actions, and 

cut or copy items on the current diagram and 

paste them into another job or a new shared 

container. Renames or deletes stages and links 

in the Diagram window. Defines job properties 

(Job Properties item), and displays the stage 

dialog boxes (Properties item). Allows you to 

construct local or shared containers, 

deconstruct local containers, and convert local 

containers to shared containers and vice versa. 

Selects all items in a diagram window.

View. Determines what is displayed in the 

DataStage Designer window. Displays or hides 

the toolbar, tool palette, status bar, Repository 

window, and Property browser. For server jobs 

and server shared containers only, allows you 

to display or hide the debug bar. Other 

commands allow you to customize the tool 

palette and refresh the view of the Repository 

items in the Repository window.

Diagram. Determines what actions are 

performed in the Diagram window. Displays or 

hides the grid or print lines, enables or disables 

annotations, activates or deactivates the Snap 
to Grid option, zooms in or out of the Diagram 

window and aligns selected items to the grid. 

For parallel jobs, enables/disables visual cues in 

job designs. Also turns performance monitoring 

on for server or parallel jobs. The snap to grid 

and zoom properties are applied to the job or 

container window currently selected. The 

settings are saved when the job or container is 

saved and restored when it is open. The other 

settings are personal to you, and are saved 

between DataStage sessions ready for you to 

use again. When you change personal settings 

they affect all open windows immediately.
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Debug. This menu is available only for server 

jobs and server shared containers. Gives 

access to the debugger commands.

Tools. Allows you to define the Designer 

options. Starts the DataStage Manager or 

Director, and, if they are installed, MetaStage, 

QualityStage, ProfileStage, AuditStage, and 

Version Control. If you are running Parallel 

Extender on a UNIX server, you can open the 

Data Set Manager and create new stage types. 

Also lets you invoke third-party applications, or 

add third-party applications to the Designer. 

Window. Allows you to close the current 

window, or all windows. Specifies how the 

windows are displayed and arranges the icons.

Help. Invokes the Help system. Help is 

available from all areas of the Designer.

The Property Browser

You can choose to view the Property Browser from the View menu. It 

is located by default in the top left corner of the DataStage Designer 

window (you can move it if required). It displays the properties of the 

object currently selected in the Diagram window. The properties given 

depend on the type of object selected. It allows you to edit some of 

the properties without opening a dialog box.

For stages and containers, it gives:

Stage type

Shared container name (shared container stages only)
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Name

Description

You can edit the name, and add or edit a description, but you cannot 

change the stage type.

For links, the property browser gives:

Name

Input link description

Output link description

You can edit the name, and add or edit a description.

The Repository Window

The Repository window gives details of the items associated with the 

current project which are held in the DataStage Repository. The 

window provides a subset of the DataStage Manager functionality. 

From the Designer you can add, delete, and edit the following:

Data elements

IMS Databases (DBDs)

IMS Viewsets (PSBs/PCBs)

Job and job sequence properties

Mainframe machine profiles

Routines

Shared container properties

Stage type properties
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Table definitions

Transforms

You can hide some of these branches if required by choosing 

Customization from the shortcut menu in the Repository window. 

Deselect the branches you do not want to see. By default, only jobs, 

shared containers, and table definition categories are visible when 

you first open DataStage.

Detailed information is in DataStage Developer’s Help and DataStage 

Manager Guide. A guide to defining and editing table definitions is 

given in this guide (Chapter 7) because table definitions are so central 

to job design.

In the Designer Repository window you can perform any of the 

actions that you can perform from the Repository tree in the Manager. 

When you select a category in the tree, a shortcut menu allows you to 

create a new item under that category or a new subcategory, or, for 

Table Definition categories, import a table definition from a data 

source. When you select an item in the tree, a shortcut menu allows 

you to perform various tasks depending on the type of item selected:

Data elements, machine profiles, routines, transforms, IMS 
Databases, IMS Viewsets

You can create a copy of these items, rename them, delete them, 

and display the properties of the item. Provided the item is not 

read-only, you can edit the properties.

Jobs, shared containers

You can create a copy of these items, add them to the palette, 

rename them, delete them, and edit them in the diagram window.

Stage types

You can add stage types to the diagram window palette and 

display their properties. If the stage belongs in a shortcut 

container, DataStage will add it there. Otherwise it will add it to 
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the correct group. Provided the item is not read-only, you can edit 

the properties.

Table definitions

You can create a copy of table definitions, rename them, delete 

them and display the properties of the item. Provided the item is 

not read-only, you can edit the properties. You can also import 

table definitions from data sources.

It is a good idea to choose View ➤ Refresh from the main menu bar 

before acting on any Repository items to ensure that you have a 

completely up-to-date view.

You can drag certain types of item from the Repository window onto a 

diagram window or the diagram window, or onto specific 

components within a job:

Jobs – the job opens in a new diagram window or, if dragged to a 
job sequence window, is added to the job sequence.

Shared containers – if you drag one onto an open diagram 
window, the shared container appears in the job. If you drag a 
shared container onto the background a new diagram window 
opens showing the contents of the shared container.

Stage types – drag a stage type onto an open diagram window to 
add it to the job or container. You can also drag it to the tool 
palette to add it as a tool.

Table definitions – drag a table definition onto a link to load the 
column definitions for that link. The Select Columns dialog box 
allows you to select a subset of columns from the table definition 
to load if required.

You can also drag items of these types to the palette for easy access.

The Diagram Window

The area to the right of the DataStage Designer holds the Diagram 

windows. A Diagram window appears for each job, job sequence, 

server or parallel shared container that you open in your project. By 

default the diagram window has a colored background. You can turn 

this off using the Options dialog box (see "Default Options" on 
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page 3-24). Most of the screenshots in this guide have the background 

turned off. 

The diagram window is the canvas on which you design and display 

your job. This window has the following components:

Title bar. Displays the name of the job or shared container.

Page tabs. If you use local containers in your job, the contents of 
these containers are displayed in separate windows within the 
job’s diagram window. Switch between views using the tabs at the 
bottom of the diagram window.

Grid lines. Allow you to position stages more precisely in the 
window. The grid lines are not displayed by default. Choose 
Diagram ➤ Show Grid Lines to enable them. 

Scroll bars. Allow you to view the job components that do not fit 
in the display area. 

Print lines. Display the area that is printed when you choose File 
➤ Print. The print lines also indicate page boundaries. When you 
cross these, you have the choice of printing over several pages or 
scaling to fit a single page when printing. The print lines are not 
displayed by default. Choose Diagram ➤ Show Print Lines to 
enable them.
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You can use the resize handle or the Maximize button to resize a 

diagram window. To resize the contents of the window, use the zoom 

commands in the Diagram shortcut menu. If you maximize a window 

an additional menu appears to the left of the File menu, giving access 

to Diagram window controls.

By default, any stages you add to the Diagram window will snap to the 

grid lines. You can, however, turn this option off by unchecking 

Diagram ➤ Snap to Grid, clicking the Snap to Grid button in the 

toolbar, or from the Designer Options dialog box.

The diagram window has a shortcut menu which gives you access to 

the settings on the Diagram menu (see "Menu Bar" on page 3-4) plus 

cut, copy, and paste:
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Toolbar

The Designer toolbar contains the following buttons:

The toolbar appears under the menu bar by default, but you can drag 

and drop it anywhere on the screen. It will dock and un-dock as 

required. Alternatively, you can hide the toolbar by choosing View ➤ 

Toolbar.

Tool Palette

The tool palette contains shortcuts to the components you can add to 

your job design. By default the tool palette is docked to the DataStage 

Designer, but you can drag and drop it anywhere on the screen. It will 

dock and un-dock as required. Alternatively, you can hide the tool 

palette by choosing View ➤ Palette.

There is a separate tool palette for server jobs, parallel jobs, 

mainframe jobs, and job sequences (parallel shared containers use 

the parallel job palette, server shared containers use the server job 

palette). Which one is displayed depends on what is currently active in 

the Designer.

The palette has different groups to organize the tools available. Click 

the group title to open the group. The Favorites group allows you to 

drag frequently used tools there so you can access them quickly. You 

can also drag other items there from the Repository window, such as 

jobs and shared containers.

Each group and each shortcut has properties which you can edit by 

choosing Properties from the shortcut menu. 

New Job

Open 
job

(choose type
from drop-down
list)

Save
Properties
Job

Compile Zoom

out

in

 Link

Grid
lines

Visual
grid

Print

Help
Annotations

Save
All Zoomcontainer

container
Construct

shared
Construct

markingRun
Cut

Copy

Paste

Undo
Redo Snap tocues

Report
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The following is an example parallel job tool palette:

To add a stage to the Diagram window, choose its shortcut from the 

tool palette and click the Diagram window. The stage is added at the 

insertion point in the diagram window. If you click and drag on the 

diagram window to draw a rectangle as an insertion point, the stage 

will be sized to fit that rectangle. You can also drag stages from the 

tool palette or from the Repository window and drop them on the 

Diagram window.

Some of the shortcuts on the tool palette give access to several 

stages, these are called shortcut containers and you can recognize 

them because down arrows appear when you hover the mouse 

pointer over them. Click on the arrow to see the list of items this icon 

gives access to:

You can add the default Shortcut container item in the same way as 

ordinary palette items – it can be dragged and dropped, renamed, 

deleted etc. Shortcut containers also have properties you can view in 

the same way as palette groups and ordinary shortcuts do, and these 

allow you to change the default item. 

To link two stages, choose the Link button. Click the first stage, then 

drag the mouse to the second stage. The stages are linked when you 

release the mouse button.
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You can customize the tool palette to add or remove various shortcuts. 

You can add the shortcuts for plug-ins you have installed, and remove 

the shortcuts for stages you know you will not use. You can also add 

your own shortcut containers. There are various ways in which you 

can customize the palette:

In the palette itself.

From the Repository window.

From the Customize Toolbar dialog box.

To customize the tool palette from the palette itself:

To remove an existing item from the palette, select it and choose 
Edit ➤ Delete Shortcut.

To move an item to another position in the palette, select it and 
drag it to the desired position.

To reset to the default settings for DataStage choose 
Customization ➤ Reset to factory default or Customization 
➤ Reset to compact default from the palette shortcut menu.

To customize the palette from the Repository window:

To add an additional item to the palette, select it in the Repository 
window and drag it to the palette or select Add to Palette from 
the item’s shortcut menu. In addition to stage types, you can also 
add other Repository items such as table definitions and shared 
containers. 

To customize the palette using the Customize Palette dialog box, 

open the Customize Palette dialog box by doing one of: 

Choose View ➤ Customize Palette from the main menu. 

Choose Customization ➤ Customize from the palette shortcut 
menu.

Choose Customize Palette from the background shortcut menu.

The Customize Palette dialog box shows all the Repository items 

and the default palette groups and shortcut containers in two tree 

structures in the left pane and all the available palette groups in the 

right pane. Use the right arrows to add items from the trees on the left 

to the groups on the right, or use drag and drop. Use the left arrow to 
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remove an item from a palette group. Use the up and down arrows to 

rearrange items within a palette group.

Status Bar

The status bar appears at the bottom of the DataStage Designer 

window. It displays one-line help for the window components and 

information on the current state of job operations, for example, 

compilation of server jobs. You can hide the status bar by choosing 

View ➤ Status Bar.

Debugger Toolbar
Server jobs DataStage has a built-in debugger that can be used with server jobs or 

server shared containers. The debugger toolbar contains buttons 

representing debugger functions. You can hide the debugger toolbar 

by choosing View ➤ Debug Bar. The debug bar has a drop-down list 

displaying currently open server jobs, allowing you to select one of 

these as the debug focus.

Go Stop Job

Job Edit

Toggle

Parameters

Breakpoint

Breakpoints
Clear All
Breakpoints

Step to
Next Link

Step to
Next Row

Debug
Window

View Job Log

Target debug job
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Shortcut Menus

There are a number of shortcut menus available which you display by 

clicking the right mouse button. The menu displayed depends on 

where you clicked.

Background. Appears when you right-click on the background 
area in the left of the Designer (i.e. the space around Diagram 
windows), or in any of the toolbar background areas. Gives access 
to the same items as the View menu (see page 3-5).

Diagram window background. Appears when you right-click on 
a window background. Gives access to the same items as the 
Diagram menu (see page 3-5).

Stage. Appears when you click the right mouse button on a 
highlighted stage. The menu contents depends on what type of 
stage you have clicked on. All menus enable you to open the stage 
editor by choosing Properties, and to rename and delete the 
stage, and to delete the stage complete with its links. If the stage 
has links, you can choose the link name to open the stage editor 
on the page giving details of that link. If there is data associated 
with the link of a server job passive, built-in stage or parallel job 
file or database stage, you can choose View link data… to open 
the Data Browser on that link. The Transformer stage shortcut 
menu offers additional items. Choose Propagate columns to 
propagate columns from a selected input link to a selected output 
link. Choose Auto-Match columns to map columns on the 
selected input link to columns on the selected output link with 
matching names.

Link. Appears when you click the right mouse button on a 
highlighted link. This menu contains options to move or delete the 
link, change the link type, and, for server jobs only, toggle any 
breakpoint on the link, or open the Edit Breakpoints dialog box.
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Palette Group. Appears when you right-click on the background 
area in the palette. Allows you to add a new shortcut container, 
add, delete, or rename a group, view the group properties. The 
Customization item gives access to a range of customization 
options:

– Open the Customize Palette dialog box to add more items to 
the group.

– Display the group items as small icons or large icons, with or 
without text labels.

– Sort the items by name.

– Show or hide the various groups in the current palette.

– Clean up the palette so that any icons that point to items no 
longer in the DataStage repository are removed.

– Load a previously saved palette configuration.

– Load the default settings for the project.

– Save the current palette configuration to a file.

– Make the current palette configuration the default for the 
project.

– Reset the palette to the original configuration as at initial 
install.

– Reset the palette to use small icons, without text, all in one 
group. This is similar to how the palette appeared in previous 
versions of DataStage

Palette Item. Allows you to select an item, view its properties, 
delete, or rename it. Also gives the same customization options as 
described for palette groups.

Using Annotations
DataStage allows you to insert notes into a Diagram window. These 

are called annotations and there are two types:

Annotation. You enter the text for this yourself. Use it to 
annotate stages and links in your job design. These can be cut and 
copied and paste into other jobs.

Description Annotation. This displays either the short or full 
description from the job properties. You can edit the description 
within the annotation if required. There can only be one of these 
per job, they cannot be cut and copied and pasted into other jobs.
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You can use annotations in server, parallel, or mainframe jobs, job 

sequences or shared containers. The following example shows a 

server job with a description annotation and an ordinary annotation:

The Toggle Annotations button in the Tool bar allows you to specify 

whether the Annotations are shown or not. 

To insert an annotation, assure the annotation option is on then drag 

the annotation icon from the tool palette onto the Diagram window. 

An annotation box appears, you can resize it as required using the 

controls in the boundary box. Alternatively, click an Annotation button 

in the tool palette, then draw a bounding box of the required size of 

annotation on the Diagram window. Annotations will always appear 

behind normal stages and links.

Annotations have a shortcut menu containing the following 

commands:

Properties. Select this to open the properties dialog box. There is 
a different dialog for annotations and description annotations.

Edit Text. Select this to put the annotation into edit mode.

Delete. Select this to delete the annotation.
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Description Annotation Properties
The description Annotation Properties dialog box is as follows:

Annotation text. Displays the text in the annotation. You can edit 
this here if required.

Vertical Justification. Choose whether the text aligns to the 
top, middle, or bottom of the annotation box.

Horizontal Justification. Choose whether the text aligns to the 
left, center, or right of the annotation box.

Font. Click this to open a dialog box which allows you to specify a 
different font for the annotation text.

Color. Click this to open a dialog box which allows you to specify 
a different color for the annotation text.

Background color. Click this to open a dialog box which allows 
you to specify a different background color for the annotation.

Border. Select this to specify that the border of the annotation is 
visible.

Transparent. Select this to choose a transparent background.

Description Type. Choose whether the Description Annotation 
displays the full description or short description from the job 
properties.
Designer Guide 3-19



Specifying Designer Options DataStage Designer Overview
Annotation Properties
The Annotation Properties dialog box is as follows:

The properties are the same as described for description annotations, 

except there are no Description Type options.

Specifying Designer Options
You can specify default display settings and the level of prompting 

used when the Designer is started. To specify the Designer options, 

choose Tools ➤ Options… . The Options dialog box appears. The 

dialog box has a tree in the left pane. This contains a number of 

branches, each giving access to pages containing settings for 

individual areas of the DataStage Designer.

Click OK to save any changes and to close the Options dialog box. 

The chosen settings take effect immediately (but do not alter Diagram 

windows that are currently open).

Appearance Options
The Appearance options branch lets you control the appearance of the 

DataStage Designer. It gives access to four pages: General, Repository 

Tree, Palette, and Graphical Performance Monitor.
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General

The General page has the following sections:

Appearance. These options allow you to decide how the 
Designer background canvas is displayed and how the stage icons 
appear on the canvas. 

By default the canvas has a background image which tells you 

whether you are editing a server job, parallel job, mainframe job, 

shared container, or job sequence. Clear the Show background 
images check box to replace these with a white background. 

By default the stage icons have no background. To display them 

with a blue background, select the Show stage outlines check 

box. You can also choose to show or hide the Ascential banner, 

and to limit the display to standard Windows colors for the 

Designer client (as in previous versions of DataStage).

Unattached links. This option lets you choose the display color 
for unattached links. This is red by default. To change it, click on 
the color button and choose a new color in the Color dialog box 
that appears.
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Repository Tree

This section allows you to choose what type of items are displayed in 

the Repository tree in the Designer.

Select the check boxes for each type of item you want to be displayed. 

By default all types of item are displayed.

Palette

This section allows you to control how your tool palette is displayed.

It controls the following options:
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Animate group when expanding. Select this to have the 
groups scroll down and scroll up when opening and closing. 
Otherwise they open and close instantly.

Show expanded group in bold text. Select this to show the 
title of an expanded group in bold text.

Different customization for each project. This is selected by 
default, and allows you to specify different palette options for 
different projects. 

Common customization between all Projects. Select this if 
you want the palette on all projects to share the same options as 
set in this project.

Automatically add newly installed stage types. Select this to 
have any new stage types added to the appropriate group in the 
appropriate palette.

Show text labels. Select this to display the names of items in the 
palette. Otherwise just the icons are displayed.

Icons. Choose whether to display large icons or small icons in the 
palette.

Graphical Performance Monitor

The Graphical Performance Monitor page allows you to set the colors 

used by the monitor to indicate status as a job runs. It also allows you 

to set the refresh interval at which the monitor updates statistical 

information. For details on the monitor, see "Using the Performance 

Monitor" on page 4-40.
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Default Options
The Default options branch gives access to two pages: General and 

Mainframe.

General

The General page determines how the DataStage Designer behaves 

when started. 

The page has three areas:

When Designer starts. Determines whether the Designer 
automatically opens a new job when started, or prompts you for a 
job to create or open.

– Nothing Open. This is the default option. The Designer opens 
with no jobs, shared containers, or job sequences open, you 
can then decide whether to open and existing item, or create a 
new one.

– Prompt for. Select this and choose New, Existing or Recent 
from the drop-down list. The New dialog box appears when 
you start the DataStage Designer, with the New, Existing, or 
Recent page on top, allowing you to choose an item to open. 

– Create new. Select this and choose Server, Mainframe, 
Parallel, Sequence job, or Shared container from the drop-
down list. If this is selected, a new job of the specified type is 
automatically created when the DataStage Designer is started. 

New job/container view attributes. Determines whether the 
snap to grid option will be on or not for any new jobs, job 
sequences, or shared containers that are opened. 
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Shared Container/Job Activity double-click action. This 
allows you to specify the action the Designer takes when you 
double click on a shared container or job activity on the canvas. 
The options are to:

– Show the shared container's or job activity's properties (this is 
the default), OR

– Open the shared container or job the item references.

Mainframe

This page allows you to specify options that apply to mainframe jobs 

only.

Base location for generated code. This specifies the base 
location on the DataStage client where the generated code and 
JCL files for a mainframe job are held. Each mainframe job holds 
these files in a subdirectory of the base location reflecting the 
server host name, project name, and job. For example, where the 
base location is c:\Ascential\DataStage\Gencode, a complete 
pathname might be 
c:\Ascential\DataStage\Gencode\R101\dstage\mjob1.

Source Viewer. Allows you to specify which program should be 
used for viewing generated source. This defaults to Notepad.

Column push option. This option is selected by default. With the 
option on, all the columns loaded in a mainframe source stage are 
selected and appear on the output link without you needing to 
visit any of the Output pages. Just define the necessary 
information on the Stage page, and click OK. The columns 
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defined for the input link of a mainframe active stage are similarly 
automatically mapped to the columns of the output link. Clear the 
option to specify that all selection and mapping is done manually.

Expression Editor Options
Server jobs and 
Parallel jobs

The Expression Editor branch gives access to the server and 

parallel page which allows you to specify the features available in the 

DataStage Expression Editor. For more details on how to use the 

Expression Editor, see Server Job Developer’s Guide and Parallel Job 

Developer’s Guide.

There are four check boxes on this page:

Check expression syntax 

Check variable names in expressions 

Suggest expression elements

Complete variable names in expressions 

These check boxes are selected by default. The settings are stored in 

the Repository and are used when you edit any job on this client 

machine. 

Job Sequencer Options
This branch has two pages; SMTP Defaults and Default Trigger 
Colors. Both determine operation details for the graphical job 

sequence editor. See Chapter 6 "Job Sequences," for information 

about job sequences.
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SMTP Defaults

This page allows you to specify default details for Email Notification 

activities in job sequences.

SMTP Mail server name. The name of the server or its IP 
address.

Senders email address. Given in the form 
bill.gamsworth@paddock.com.

Recipients email address. Given in the form 
bill.gamsworth@paddock.com.

Include job status in email. Select this to include available job 
status information in the message.
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Default Trigger Colors

This page allows you to specify colors for the different types of trigger 

used in job sequences.

Meta Data Options
This allows you to specify which column definition items are 

preserved when you merge column meta data. All the items are 

selected by default. See page 4-33 for details.
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You can also specify whether the Select Columns dialog box is 

always shown when you drag and drop meta data, or whether you 

need to hold down ALT as you drag and drop in order to display it.

Printing Options
The Printer branch allows you to specify the printing orientation. 

When you choose File ➤ Print, the default printing orientation is 

determined by the setting on this page. You can choose portrait or 

landscape orientation. To use portrait, select the Portrait 
orientation check box. The default setting for this option is cleared, 

i.e., landscape orientation is used.
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Prompting Options
The Prompting branch gives access to pages which determine the 

level of prompting displayed when you perform various operations in 

the Designer. There are three pages: General, Mainframe, and 

Server.

General

This page determines various prompting actions for server jobs and 

parallel jobs.

Automatic Actions. Allows you to set options relating to the 
saving, compiling, and debugging of jobs.

– Autosave before compile. Select this to specify that a job 
will be automatically saved, without prompting, when you 
compile it.

– Autocompile before debug. Select this to specify that a job 
will be automatically compiled, without prompting, when you 
debug it.

– Autosave referenced Shared Containers before compile. 
Select this to specify that a shared container referenced by a 
job will be automatically saved, without prompting, when you 
compile the job.

Container actions
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– Generate names automatically on name conflicts. If 
name conflicts occur when constructing or deconstructing 
containers, you are normally prompted for replacement 
names. Choose this option to have DataStage generate names 
automatically in case of conflict.

Confirmation

This page has options for specifying whether you should be warned 

when performing various deletion and construction actions, allowing 

you to confirm that you really want to carry out the action. Tick the 

boxes to have the warnings, clear them otherwise.

Transformer Options
The Transformer branch allows you to specify colors used in the 

Transformer editor. (Selected column highlight and relationship arrow 
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colors are set by altering the Windows active title bar color from the 

Windows Control Panel). 

Exiting the DataStage Designer
To exit the DataStage Designer, choose File ➤ Exit from the 

DataStage Designer window. If you are currently debugging a job, it is 

stopped. Your personal settings, such as Diagram window size and 

position, are preserved and restored when you next use the 

DataStage Designer.
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Developing a Job

The DataStage Designer is used to create and develop DataStage jobs. 

A DataStage job populates one or more tables in the target database. 

There is no limit to the number of jobs you can create in a DataStage 

project. This chapter gives an overview of how to develop a job and 

how to specify job properties using the Designer. A job design 

contains:

Stages to represent the processing steps required

Links between the stages to represent the flow of data

There are three different types of job in DataStage: 

Server jobs. These are available if you have installed Server. 
They run on the DataStage Server, connecting to other data 
sources as necessary. 

Mainframe jobs. These are available only if you have installed 
Enterprise MVS Edition. Mainframe jobs are uploaded to a 
mainframe, where they are compiled and run.

Parallel jobs. These are available only if you have installed the 
Enterprise Edition. These run on DataStage servers that are SMP, 
MPP, or cluster systems.

There are two other entities that are similar to jobs in the way they 

appear in the DataStage Designer, and are handled by it. These are:

Shared containers. These are reusable job elements. They 
typically comprise a number of stages and links. Copies of shared 
containers can be used in any number of server jobs and parallel 
jobs and edited as required. Shared containers are described in 
Chapter 5.
Designer Guide 4-1



Getting Started with Jobs Developing a Job
Job Sequences. A job sequence allows you to specify a 
sequence of DataStage server or parallel jobs to be executed, and 
actions to take depending on results. Job sequences are described 
in Chapter 6.

Note If you want to use the DataStage Manager Reporting Tool 

(described in "Reporting" in DataStage Manager Guide) you 

should ensure that the names of your DataStage 

components (jobs, stage, links etc.) do not exceed 64 

characters.

Getting Started with Jobs

Creating a Job
To create a job, choose File ➤ New from the DataStage Designer 

menu. The New dialog box appears, choose one of the icons, 

depending on the type of job or shared container you want to create, 

and click OK.

The Diagram window appears, in the right pane of the Designer, along 

with the Toolbox for the chosen type of job. You can now save the job 

and give it a name.

Opening an Existing Job
If you have previously worked on the job you want to open, then you 

can select it from the list of most recently used jobs in the File menu 
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in the DataStage Designer window. Otherwise, to open a job, do one 

of the following:

Choose File ➤ Open Job… . 

Click the Open button on the toolbar.

The Open dialog box appears. This is the same as the New dialog 

box, except that it appears with the Existing page on top, allowing 

you to pick an existing job from the tree structure. The job last opened 

is highlighted, so you can simply click OK if you want to reopen the 

last job you worked on. Otherwise, choose the job you want to open 

and click OK. Alternatively, you can select the Recent page to see a 

list of the most recently opened jobs.

You can also find the job in the tree in the Repository window and 

double-click it, or select it and choose Edit from its shortcut menu, or 

drag it onto the background to open it.

The updated DataStage Designer window displays the chosen job in a 

Diagram window.

Saving a Job
To save the job:
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1 Choose File ➤ Save. If this is the first time you have saved the 
job, the Create new job dialog box appears:

2 Enter the name of the job in the Job name field.

3 Type a category for the job or select a category from the existing 
categories shown in the tree structure by clicking it. It appears in 
the Category box. (If you have already specified a job category in 
the Job Properties dialog box, this will be displayed in the 
Category box when you open the Create new job dialog box.)

4 Click OK. If the job name is unique, the job is created and saved in 
the Repository. If the job name is not unique, a message box 
appears. You must acknowledge this message before you can 
enter an alternative name. 

To save an existing job with a different name choose File ➤ Save 
As… and fill in the Create new dialog box, specifying the new name 

and the category in which the job is to be saved.

Organizing your jobs into categories gives faster operation of the 

DataStage Director when displaying job status.

Naming a Job
The following rules apply to the names that you can give DataStage 

jobs:

Job names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.

Job category names can be any length and consist of any characters, 

including spaces.
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Stages
A job consists of stages linked together which describe the flow of 

data from a data source to a data target (for example, a final data 

warehouse). A stage usually has at least one data input and/or one 

data output. However, some stages can accept more than one data 

input, and output to more than one stage. 

The different types of job have different stage types. The stages that 

are available in the DataStage Designer depend on the type of job that 

is currently open in the Designer.

Server Job Stages 
Server jobs DataStage offers several built-in stage types for use in server jobs. 

These are used to represent data sources, data targets, or conversion 

stages. These stages are either passive or active stages. A passive 

stage handles access to databases for the extraction or writing of 

data. Active stages model the flow of data and provide mechanisms 

for combining data streams, aggregating data, and converting data 

from one data type to another. 

As well as using the built-in stage types, you can also use plug-in 

stages for specific operations that the built-in stages do not support. 

The Palette organizes stage types into different groups, according to 

function:

Database

File

PlugIn

Processing

Real Time

Stages and links can be grouped in a shared container. Instances of 

the shared container can then be reused in different server jobs. You 

can also define a local container within a job, this groups stages and 

links into a single unit, but can only be used within the job in which it 

is defined. 

Each stage type has a set of predefined and editable properties. These 

properties are viewed or edited using stage editors. A stage editor 

exists for each stage type and these are described in detail in 

individual chapters in Server Job Developer’s Guide. 

At this point in your job development you need to decide which stage 

types to use in your job design. The following built-in stage types are 

available for server jobs:
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Database

ODBC. Extracts data from or loads data into databases that 
support the industry standard Open Database Connectivity API. 
This stage is also used as an intermediate stage for aggregating 
data. This is a passive stage.

UniVerse. Extracts data from or loads data into UniVerse 
databases. This stage is also used as an intermediate stage for 
aggregating data. This is a passive stage.

UniData. Extracts data from or loads data into UniData 
databases. This is a passive stage.

Oracle 7 Load. Bulk loads an Oracle 7 database. Previously 
known as ORABULK.

Sybase BCP Load. Bulk loads a Sybase 6 database. Previously 
known as BCPLoad.

File

Hashed File. Extracts data from or loads data into databases that 
contain hashed files. Also acts as an intermediate stage for quick 
lookups. This is a passive stage.

Sequential File. Extracts data from, or loads data into, operating 
system text files. This is a passive stage.

Processing

Aggregator. Classifies incoming data into groups, computes 
totals and other summary functions for each group, and passes 
them to another stage in the job. This is an active stage.

BASIC Transformer. Receives incoming data, transforms it in a 
variety of ways, and outputs it to another stage in the job. This is 
an active stage.

Folder. Folder stages are used to read or write data as files in a 
directory located on the DataStage server.

Inter-process. Provides a communication channel between 
DataStage processes running simultaneously in the same job. 
This is a passive stage.

Link Partitioner. Allows you to partition a data set into up to 64 
partitions. Enables server jobs to run in parallel on SMP systems. 
This is an active stage.
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Link Collector. Collects partitioned data from up to 64 partitions. 
Enables server jobs to run in parallel on SMP systems. This is an 
active stage.

Real Time

RTI Source. Entry point for a Job exposed as an RTI service. The 
Table Definition specified on the output link dictates the input 
arguments of the generated RTI service.

RTI Target. Exit point for a Job exposed as an RTI service. The 
Table Definition on the input link dictates the output arguments of 
the generated RTI service.

Containers

Server Shared Container. Represents a group of stages and 
links. The group is replaced by a single Shared Container stage in 
the Diagram window. Shared Container stages are handled 
differently to other stage types, they do not appear on the palette. 
You insert specific shared containers in your job by dragging them 
from the Repository window (Server group). 

Local Container. Represents a group of stages and links. The 
group is replaced by a single Container stage in the Diagram 
window (these are similar to shared containers but are entirely 
private to the job they are created in and cannot be reused in 
other jobs). These appear in a shortcut container in the General 
group.

Container Input and Output. Represent the interface that links 
a container stage to the rest of the job design. These appear in a 
shortcut container in the General group.

You may find that the built-in stage types do not meet all your 

requirements for data extraction or transformation. In this case, you 

need to use a plug-in stage. The function and properties of a plug-in 

stage are determined by the particular plug-in specified when the 

stage is inserted. Plug-ins are written to perform specific tasks, for 

example, to bulk load data into a data warehouse. Plug-ins are 

supplied with DataStage for you to install if required. 

Mainframe Job Stages
Mainframe jobs DataStage offers several built-in stage types for use in mainframe 

jobs. These are used to represent data sources, data targets, or 

conversion stages. 
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The Palette organizes stage types into different groups, according to 

function:

Database

File

Processing

Each stage type has a set of predefined and editable properties. Some 

stages can be used as data sources and some as data targets. Some 

can be used as both. Processing stages read data from a source, 

process it and write it to a data target target. These properties are 

viewed or edited using stage editors. A stage editor exists for each 

stage type and these are fully described in individual chapters in 

Mainframe Job Developer’s Guide. 

At this point in your job development you need to decide which stage 

types to use in your job design. The following stages are available for 

mainframe jobs:

Database

IMS. This is a source stage. It extracts data from an IMS database 
or viewset.

Relational. This can be a source or a target stage. It reads data 
from, or writes data to, a relational database.

Teradata. This can be a source or a target stage. It reads data 
from, or writes data to, a Teradata database.

File

Complex Flat File. This is a source stage. It reads data from a 
complex flat file.

DB2 Load Read Flat File. This is a target stage. It is used to write 
data to a DB2 load ready flat file.

Delimited Flat File. This can be a source or target stage. It is 
used to read data from, or write it to, a delimited flat file.

External Source. This is a source file. It is used to read data from 
an external program.

External Target. This is a target stage. It is used to write data to 
an external program.
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Fixed Width Flat File. This can be a source or target stage. It is 
used to read data from, or write it to, a fixed width flat file.

Multi-Format Flat File. This is a source stage. It is used to read 
data from a file containing multiple record types.

Processing

Transformer. This performs data transformation on extracted 
data.

Aggregator. Groups data from a single input link and performs 
aggregation functions such as count, sum, average, first, last, min, 
and max.

Business Rule. Allows you to perform complex transformations 
using SQL business rule logic.

External Routine. This calls COBOL subroutines in libraries 
external to DataStage.

FTP. This transfers files to another machine.

Join. This is used to join data from two input tables and produce 
one output table.

Link Collector.

Lookup. Allows you to perform table lookups.

Sort. Allows you to perform Sort operations.

Parallel Job Stages
Parallel stages are organized into different groups on the palette:

Database

Development/Debug

File

Processing

Real Time

Restructure
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Each stage type has a set of predefined and editable properties. These 

properties are viewed or edited using stage editors. A stage editor 

exists for each stage type and these are fully described in individual 

chapters in Parallel Job Developer’s Guide. 

At this point in your job development you need to decide which stage 

types to use in your job design.

Database Stages

DB2/UDB Enterprise. Allows you to read and write a DB2 
database.

Informix Enterprise. Allows you to read and write an Informix 
XPS database.

Oracle Enterprise. Allows you to read and write an Oracle 
database.

Teradata Enterprise. Allows you to read and write a Teradata 
database.

Development/Debug Stages

Row Generator. Generates a dummy data set.

Column Generator. Adds extra columns to a data set. 

Head. Copies the specified number of records from the beginning 
of a data partition.

Peek. Prints column values to the screen as records are copied 
from its input data set to one or more output data sets.

Sample. Samples a data set.

Tail. Copies the specified number of records from the end of a 
data partition.

Write range map. Enables you to carry out range map 
partitioning on a data set.

File Stages

Complex Flat File. Allows you to read or write complex flat files 
on a mainframe machine. This is intended for use on USS systems
4-10 Designer Guide



Developing a Job Stages
Data set. Stores a set of data. 

External source. Allows a parallel job to read an external data 
source.

External target. Allows a parallel job to write to an external data 
source.

File set. A set of files used to store data.

Lookup file set. Provides storage for a lookup table.

SAS data set. Provides storage for SAS data sets.

Sequential file. Extracts data from, or writes data to, a text file.

Processing Stages

Transformer. Receives incoming data, transforms it in a variety 
of ways, and outputs it to another stage in the job. 

Aggregator. Classifies incoming data into groups, computes 
totals and other summary functions for each group, and passes 
them to another stage in the job. 

Change apply. Applies a set of captured changes to a data set.

Change Capture. Compares two data sets and records the 
differences between them.

Compare. Performs a column by column compare of two pre-
sorted data sets.

Compress. Compresses a data set.

Copy. Copies a data set.

Decode. Uses an operating system command to decode a 
previously encoded data set.

Difference. Compares two data sets and works out the difference 
between them.

Encode. Encodes a data set using an operating system command.
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Expand. Expands a previously compressed data set.

External Filter. Uses an external program to filter a data set.

Filter. Transfers, unmodified, the records of the input data set 
which satisfy requirements that you specify, and filters out all 
other records.

Funnel. Copies multiple data sets to a single data set.

Generic. Allows Orchestrate experts to specify their own custom 
commands.

Join. Joins two input sources.

Lookup. Performs table lookups.

Merge. Combines data sets.

Modify. Alters the record schema of its input data set.

Remove duplicates. Removes duplicate entries from a data set.

SAS. Allows you to run SAS applications from within the 
DataStage job.

Sort. Sorts input columns.

Switch. Takes a single data set as input and assigns each input 
record to an output data set based on the value of a selector field.

Surrogate Key. Generates one or more surrogate key columns 
and adds them to an existing data set.

Real Time

RTI Source. Entry point for a Job exposed as an RTI service. The 
Table Definition specified on the output link dictates the input 
arguments of the generated RTI service.

RTI Target. Exit point for a Job exposed as an RTI service. The 
Table Definition on the input link dictates the output arguments of 
the generated RTI service.

Restructure

 Column export. Exports a column of another type to a string or 
binary column.
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Column import. Imports a column from a string or binary 
column.

Combine records. Combines several columns associated by a 
key field to build a vector.

Make subrecord. Combines a number of vectors to form a 
subrecord.

Make vector. Combines a number of fields to form a vector.

Promote subrecord. Promotes the members of a subrecord to a 
top level field.

Split subrecord. Separates a number of subrecords into top 
level fields.

Split vector. Separates a number of vector members into 
separate columns.

Other Stages
Parallel Shared Container. Represents a group of stages and 
links. The group is replaced by a single Parallel Shared Container 
stage in the Diagram window. Parallel Shared Container stages 
are handled differently to other stage types, they do not appear on 
the palette. You insert specific shared containers in your job by 
dragging them from the Repository window. 

Local Container. Represents a group of stages and links. The 
group is replaced by a single Container stage in the Diagram 
window (these are similar to shared containers but are entirely 
private to the job they are created in and cannot be reused in 
other jobs). 

Container Input and Output. Represent the interface that links 
a container stage to the rest of the job design.

Naming Stages and Shared Containers
The following rules apply to the names that you can give DataStage 

stages and shared containers:

Names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.
Designer Guide 4-13



Links Developing a Job
Links
Links join the various stages in a job together and are used to specify 

how data flows when the job is run.

Linking Server Stages
Server jobs Passive stages in server jobs (e.g., ODBC stages, Sequential File 

stages, UniVerse stages), are used to read or write data from a data 

source. The read/write link to the data source is represented by the 

stage itself, and connection details are given on the Stage general 

tabs.

Input links connected to the stage generally carry data to be written to 

the underlying data target. Output links carry data read from the 

underlying data source. The column definitions on an input link define 

the data that will be written to a data target. The column definitions on 

an output link define the data to be read from a data source.

An important point to note about linking stages in server jobs is that 

column definitions actually belong to, and travel with, the links as 

opposed to the stages. When you define column definitions for a 

stage's output link, those same column definitions will appear at the 

other end of the link where it is input to another stage. If you move 

either end of a link to another stage, the column definitions will 

appear on the new stage. If you change the details of a column 

definition at one end of a link, those changes will appear in the 

column definitions at the other end of the link.

There are rules covering how links are used, depending on whether 

the link is an input or an output and what type of stages are being 

linked.

DataStage server jobs support two types of input link:

Stream. A link representing the flow of data. This is the principal 
type of link, and is used by both active and passive stages.

Reference. A link representing a table lookup. Reference links are 
only used by active stages. They are used to provide information 
that might affect the way data is changed, but do not supply the 
data to be changed.

The two link types are displayed differently in the Designer Diagram 

window: stream links are represented by solid lines and reference 

links by dotted lines.

There is only one type of output link, although some stages permit an 

output link to be used as a reference input to the next stage and some 

do not.
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Built-in stages have maximum and minimum numbers of links as 

follows:

Plug-in stages supplied with DataStage generally have the following 

maximums and minimums:

When designing your own plug-ins, you can specify maximum and 

minimum inputs and outputs as required.

Stage Type Stream Inputs Reference Inputs Outputs Reference

Max Min Max Min Max Min Outputs?

Container no limit 0 no limit 0 no limit 0 yes

ODBC no limit 0 0 0 no limit 0 yes

UniVerse no limit 0 0 0 no limit 0 yes

Hashed File no limit 0 0 0 no limit 0 yes

UniData no limit 0 0 0 no limit 0 yes

Sequential File no limit 0 0 0 no limit 0 no

Folder no limit 0 0 0 no limit 0 yes

Inter- process 1 1 0 0 1 1 no

Transformer 1 1 no limit 0 no limit 1 no

Aggregator 1 1 0 0 no limit 1 no

Link Partitioner 1 1 0 0 64 1 no

Link Collector 64 1 0 0 1 1 no

Stage Type Stream 
Inputs

Reference 
Inputs

Outputs Reference

Max Min Max Min Max Min Outputs?

Active 1 1 no limit 0 no limit 1 no

Passive no limit 0 0 0 no limit 0 yes
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Link Marking
Server jobs For server jobs, meta data is associated with a link, not a stage. If you 

have link marking enabled, a small icon attaches to the link to indicate 

if meta data is currently associated with it.

Link marking is enabled by default. To disable it, click on the link mark 

icon in the Designer toolbar, or deselect it in the Diagram menu, or 

the Diagram shortcut menu.

Unattached Links

You can add links that are only attached to a stage at one end, 

although they will need to be attached to a second stage before the 

job can successfully compile and run. Unattached links are shown in a 

special color (red by default – but you can change this using the 

Options dialog, see page 3-20).

By default, when you delete a stage, any attached links and their meta 

data are left behind, with the link shown in red. You can choose 

Delete including links from the Edit or shortcut menus to delete a 

selected stage along with its connected links.

Linking Parallel Jobs
Parallel jobs File and database stages in parallel jobs (e.g., Data Set stages, 

Sequential File stages, Oracle Enterprise stages), are used to read or 

write data from a data source. The read/write link to the data source is 

represented by the stage itself, and connection details are given in the 

stage properties.

Input links connected to the stage generally carry data to be written to 

the underlying data target. Output links carry data read from the 

underlying data source. The column definitions on an input link define 

the data that will be written to a data target. The column definitions on 

an output link define the data to be read from a data source. 

Active stages generally have an input link carrying data to be 

processed, and an output link passing on processed data.
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An important point to note about linking stages in parallel jobs is that 

column definitions actually belong to, and travel with, the links as 

opposed to the stages. When you define column definitions for a 

stage's output link, those same column definitions will appear at the 

other end of the link where it is input to another stage. If you move 

either end of a link to another stage, the column definitions will 

appear on the new stage. If you change the details of a column 

definition at one end of a link, those changes will appear in the 

column definitions at the other end of the link.

There are rules covering how links are used, depending on whether 

the link is an input or an output and what type of stages are being 

linked.

DataStage parallel jobs support three types of link:

Stream. A link representing the flow of data. This is the principal 
type of link, and is used by all stage types.

Reference. A link representing a table lookup. Reference links can 
only be input to Lookup stages, they can only be output from 
certain types of stage. 

Reject. Some parallel job stages allow you to output records that 
have been rejected for some reason onto an output link. Note that 
reject links derive their meta data from the associated output link 
and this cannot be edited.

You can usually only have an input stream link or an output stream 

link on a File or Database stage, you can’t have both together. The 

three link types are displayed differently in the Designer Diagram 

window: stream links are represented by solid lines, reference links by 

dotted lines, and reject links by dashed lines.

The following rules apply to linking parallel stages:

Stage Name Stage Type  Inputs Outputs

Number  Type Number Type

Aggregator Active 1 stream 1 stream

Change apply Active 2 stream 1 stream

Change capture Active 2 stream 1 stream

Column export Active 1 stream 1
1

stream
reject

Column import Active 1 stream 1
1

stream
reject

Combine records Active 1 stream 1 stream

Compare Active 2 stream 1 stream
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Copy Active 1 stream N stream

Decode Active 1 stream 1 stream

Difference Active 2 stream 1 stream

Encode Active 1 stream 1 stream

External filter Active 1 stream 1 stream

Funnel Active N stream 1 stream

Generator Active 0/1 stream 1 stream

Head Active 1 stream 1 stream

Join Active 2 stream 1 stream

Lookup Active 1 stream 1
1

stream
reject

Make subrecord Active 1 stream 1 stream

Make vector Active 1 stream 1 stream

Merge Active N stream 1
N

stream
reject

Peek Active 1 stream N stream

Promote 
subrecord

Active 1 stream 1 stream

Remove 
duplicates

Active 1 stream 1 stream

SAS Active N stream N stream

Sort Active 1 stream 1 stream

Split subrecord Active 1 stream 1 stream

Split vector Active 1 stream 1 stream

Tail Active 1 stream 1 stream

Transformer Active 1 stream N stream

Data set File 1 stream 1 stream

External source File 0 stream 1
1

stream
reject

External target File 1 stream 0
1

stream
reject

Stage Name Stage Type  Inputs Outputs

Number  Type Number Type
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Link Marking
Parallel jobs For parallel jobs, meta data is associated with a link, not a stage. If you 

have link marking enabled, a small icon attaches to the link to indicate 

if meta data is currently associated with it.

Link marking also shows you how data is partitioned or collected 

between stages, and whether data is sorted. The following diagram 

shows the different types of link marking. For an explanation, see 

"Partitioning, Repartitioning, and Collecting Data" in Parallel Job 

Developer’s Guide. If you double click on a partitioning/collecting 

File set File 1 stream 1
1

stream
reject

Lookup file File 1 stream 1 stream

Parallel SAS data 
set

File 1 stream 1 stream

Sequential file File 1 stream 1
1

stream
reject

Write range map File 1 stream 0 stream

DB2 Database 1 stream 1
1

stream
reject

Informix XPS Database 1 stream 1 stream

Oracle Database 1 stream 1
1

stream

reject

Teradata Database 1 stream 1 stream

Stage Name Stage Type  Inputs Outputs

Number  Type Number Type
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marker the stage editor for the stage the link is input to is opened on 

the Partitioning tab. 

Link marking is enabled by default. To disable it, click on the link mark 

icon in the Designer toolbar, or deselect it in the Diagram menu, or 

the Diagram shortcut menu.

Unattached Links

You can add links that are only attached to a stage at one end, 

although they will need to be attached to a second stage before the 

job can successfully compile and run. Unattached links are shown in a 

special color (red by default – but you can change this using the 

Options dialog, see page 3-20).

By default, when you delete a stage, any attached links and their meta 

data are left behind, with the link shown in red. You can choose 

Delete including links from the Edit or shortcut menus to delete a 

selected stage along with its connected links.

Linking Mainframe Stages
Mainframe jobs Target stages in Mainframe jobs are used to write data to a data 

target. Source stages are used to read data from a data source. Some 

stages can act as a source or a target. The read/write link to the data 

Auto partition marker

Same partition marker

Specific partition marker

Collection marker

Partition marker
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source is represented by the stage itself, and connection details are 

given on the Stage general tabs. Links to and from source and target 

stages are used to carry data to or from a processing or post-

processing stage.

For source and target stage types, column definitions are associated 

with stages rather than with links. You decide what appears on the 

outputs link of a stage by selecting column definitions on the 

Selection page. You can set the Column Push Option to specify 

that stage column definitions be automatically mapped to output 

columns (this happens if you set the option, define the stage columns 

then click OK to leave the stage without visiting the Selection page).

There are rules covering how links are used, depending on whether 

the link is an input or an output and what type of stages are being 

linked.

Mainframe stages have only one type of link, which is shown as a 

solid line. (A table lookup function is supplied by the Lookup stage, 

and the input links to this which acts as a reference is shown with 

dotted lines to illustrate its function.)

The following rules apply to linking mainframe stages:

Stage 
Name

Stage Type  Inputs Outputs

Number Source 
Type

Number Destination
Type

Fixed-Width 
Flat File

source or 
target

multiple processing multiple processing or
post-
processing 
(FTP)

Complex Flat 
File

source NA NA multiple processing or
post-
processing 
(FTP)

Multi-format 
Flat File

source NA NA multiple processing

External 
Source

source NA NA multiple processing

Delimited 
Flat File

target multiple processing multiple post-
processing 
(FTP)

External 
Target

target multiple processing NA NA
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Link Marking
Mainframe jobs For mainframe jobs, meta data is associated with the stage and flows 

down the links. If you have link marking enabled, a small icon attaches 

to the link to indicate if meta data is currently associated with it.

DB2 Load 
Ready Flat 
File

target multiple processing single post-
processing 
(FTP)

Relational source or 
target

multiple processing multiple processing

FTP post-
processing

single flat file NA NA

Join processing two source single target, 
processing

Lookup processing two source
(reference or 
primary link),

processing 
(primary link)

single target

Aggregator processing single source single target, 
processing

Sort processing single source single target, 
processing

External 
Routine

processing single source, 
processing

single target, 
processing

Transformer processing two source, 
processing

single target, 
processing

Stage 
Name

Stage Type  Inputs Outputs

Number Source 
Type

Number Destination
Type
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Link marking is enabled by default. To disable it, click on the link mark 

icon in the Designer toolbar, or deselect it in the Diagram menu, or the 

Diagram shortcut menu.

Unattached Links

Unlike server and parallel jobs, you cannot have unattached links in a 

mainframe job; both ends of a link must be attached to a stage. If you 

delete a stage, the attached links are automatically deleted too.

Link Ordering
The Transformer stage in server jobs and various active stages in 

parallel jobs allow you to specify the execution order of links coming 

into and/or going out from the stage. When looking at a job design in 

DataStage, there are two ways to look at the link execution order:

Place the mouse pointer over a link that is an input to or an output 
from a Transformer stage. A ToolTip appears displaying the 
message:

Input execution order = n

for input links, and:

Output execution order = n

for output links. In both cases n gives the link’s place in the 

execution order. If an input link is no. 1, then it is the primary link. 

Where a link is an output from the Transformer stage and an input 

to another Transformer stage, then the output link information is 

shown when you rest the pointer over it.

Select a stage and right-click to display the shortcut menu. Choose 
Input Links or Output Links to list all the input and output links 
for that Transformer stage and their order of execution.
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Naming Links
The following rules apply to the names that you can give DataStage 

links:

Link names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.

Developing the Job Design
Jobs are designed and developed in the Diagram window. Stages are 

added and linked together using the tool palette. The stages that 

appear in the tool palette depend on whether you have a server, 

parallel, or mainframe job, or a job sequence open, and on whether 

you have customized the tool palette (see "Tool Palette" on page 3-12).

You can add, move, rename, delete, link, or edit stages in a job design. 

Adding Stages
There is no limit to the number of stages you can add to a job. We 

recommend you position the stages as follows in the Diagram 

window:

Server jobs

– Data sources on the left

– Data targets on the right

– Transformer or Aggregator stages in the middle of the diagram

Parallel Jobs

– Data sources on the left

– Data targets on the right

– Processing stages in the middle of the diagram

Mainframe jobs

– Source stages on the left

– Processing stages in the middle

– Target stages on the right

There are a number of ways in which you can add a stage:
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Click the stage button on the tool palette. Click in the Diagram 
window where you want to position the stage. The stage appears 
in the Diagram window.

Click the stage button on the tool palette. Drag it onto the Diagram 
window.

Select the desired stage type in the tree in the Repository window 
and drag it to the Diagram window.

When you insert a stage by clicking (as opposed to dragging) you can 

draw a rectangle as you click on the Diagram window to specify the 

size and shape of the stage you are inserting as well as its location. 

Each stage is given a default name which you can change if required 

(see "Renaming Stages" on page 4-25).

If you want to add more than one stage of a particular type, press 

Shift after clicking the button on the tool palette and before clicking 

on the Diagram window. You can continue to click the Diagram 

window without having to reselect the button. Release the Shift key 

when you have added the stages you need; press Esc if you change 

your mind.

Moving Stages
Once positioned, stages can be moved by clicking and dragging them 

to a new location in the Diagram window. If you have the Snap to 
Grid option activated, the stage is attached to the nearest grid 

position when you release the mouse button. If stages are linked 

together, the link is maintained when you move a stage. 

Renaming Stages 
There are a number of ways to rename a stage:

You can change its name in its stage editor.

You can select the stage in the Diagram window and then edit the 
name in the Property Browser.

You can select the stage in the Diagram window, press Ctrl-R, 
choose Rename from its shortcut menu, or choose Edit ➤ 
Rename from the main menu and type a new name in the text 
box that appears beneath the stage.

Select the stage in the diagram window and start typing.
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Deleting Stages
Stages can be deleted from the Diagram window. Choose one or more 

stages and do one of the following:

Press the Delete key.

Choose Edit ➤ Delete.

Choose Delete from the shortcut menu.

A message box appears. Click Yes to delete the stage or stages and 

remove them from the Diagram window. (This confirmation 

prompting can be turned off if required.)

When you delete stages in mainframe jobs, attached links are also 

deleted. When you delete stages in server or parallel jobs, the links 

are left behind, unless you choose Delete including links from the 

edit or shortcut menu.

Linking Stages
You can link stages in three ways:

Using the Link button. Choose the Link button from the tool 
palette. Click the first stage and drag the link to the second stage. 
The link is made when you release the mouse button.

Using the mouse. Select the first stage. Position the mouse cursor 
on the edge of a stage until the mouse cursor changes to a circle. 
Click and drag the mouse to the other stage. The link is made 
when you release the mouse button.

Using the mouse. Point at the first stage and right click then drag 
the link to the second stage and release it.

Each link is given a default name which you can change.

Moving Links

Once positioned, a link can be moved to a new location in the 

Diagram window. You can choose a new source or destination for the 

link, but not both. 

To move a link:

1 Click the link to move in the Diagram window. The link is 
highlighted.

2 Click in the box at the end you want to move and drag the end to 
its new location.
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In server and parallel jobs you can move one end of a link without 

reattaching it to another stage. In mainframe jobs both ends must be 

attached to a stage.

Deleting Links

Links can be deleted from the Diagram window. Choose the link and 

do one of the following:

Press the Delete key.

Choose Edit ➤ Delete.

Choose Delete from the shortcut menu.

A message box appears. Click Yes to delete the link. The link is 

removed from the Diagram window.

Note For server jobs, meta data is associated with a link, not a 

stage. If you delete a link, the associated meta data is 

deleted too. If you want to retain the meta data you have 

defined, do not delete the link; move it instead.

Renaming Links

There are a number of ways to rename a link:

You can select it and start typing in a name in the text box that 
appears.

You can select the link in the Diagram window and then edit the 
name in the Property Browser.

You can select the link in the Diagram window, press Ctrl-R, 
choose Rename from its shortcut menu, or choose Edit ➤ 
Rename from the main menu and type a new name in the text 
box that appears beneath the link.

Select the link in the diagram window and start typing.

Dealing with Multiple Links

If you have multiple links from one stage to another, you may want to 

resize the stages in order to make the links clearer by spreading them 

out. Do this by selecting each stage and dragging on one of the sizing 

handles in the bounding box.

Editing Stages
When you have added the stages and links to the Diagram window, 

you must edit the stages to specify the data you want to use and any 

aggregations or conversions required. 
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Data arrives into a stage on an input link and is output from a stage on 

an output link. The properties of the stage and the data on each input 

and output link are specified using a stage editor. 

To edit a stage, do one of the following:

Double-click the stage in the Diagram window.

Select the stage and choose Properties… from the shortcut 
menu.

Select the stage and choose Edit ➤ Properties.

A dialog box appears. The content of this dialog box depends on the 

type of stage you are editing. See the individual stage chapters in 

Server Job Developer’s Guide, Parallel Job Developer’s Guide or 

Mainframe Job Developer’s Guide for a detailed description of the 

stage dialog box. 

The data on a link is specified using column definitions. The column 

definitions for a link are specified by editing a stage at either end of 

the link. Column definitions are entered and edited identically for each 

stage type. 

Specifying Column Definitions

Each stage dialog box has a page for data inputs and/or data outputs 

(depending on stage type and what links are present on the stage). 

The data flowing along each input or output link is specified using 

column definitions. The column definitions are displayed in a grid on 

the Columns tab for each link.

The Columns grid has a row for each column definition. The columns 

present depend on the type of stage. Some entries contain text (which 

you can edit) and others have a drop-down list containing all the 

available options for the cell. 

You can edit the grid to add new column definitions or change values 

for existing definitions. Any changes are saved when you save your 

job design. 

The Columns tab for each link also contains the following buttons 

which you can use to edit the column definitions:

Save… . Saves column definitions as a table definition in 
the Repository.

Load… . Loads (copies) the column definitions from a table 
definition in the Repository. 

Details of how to import or manually enter column definitions in the 

Repository are given in Chapter 7.
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Editing Column Definitions

You can edit the column definitions for any input or output link. 

To edit a row in the Columns grid, click in the row and do one of the 

following: 

Right-click and choose Edit row… from the shortcut menu.

Press Ctrl-E.

Inserting Column Definitions

If you want to create a new output column or write to a table that does 

not have a table definition, you can manually enter column definitions 

by editing the Columns grid.

To add a new column at the bottom of the grid, edit the empty row.

To add a new column between existing rows, position the cursor in 

the row below the desired position and press the Insert key or choose 
Insert row… from the shortcut menu. 

Once you have defined the new row, you can right-click on it and drag 

it to a new position in the grid.

Naming Columns

The rules for naming columns depend on the type of job the table 

definition will be used in:

Server and Parallel Jobs

Column names can be any length. They must begin with an alphabetic 

character or $ and contain alphanumeric, underscore, period, and $ 

characters.

Mainframe Jobs

Column names can be any length. They must begin with an alphabetic 

character and contain alphanumeric, underscore, #, @, and $ 

characters.

Deleting Column Definitions

If you have a column definition you do not want, you can delete it. 

Unwanted column definitions can arise if you load column definitions 

from a table definition in the Repository (see "Loading Column 

Definitions" on page 4-31). 

To delete a column definition, click anywhere in the row you want to 

remove and press the Delete key or choose Delete row from the 
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shortcut menu. The column definition is removed from the grid. 

Click OK to close the Stage dialog box. Changes are saved when you 

save your job design.

If you want to delete more than one column definition at once, press 

Ctrl and click in the row selector column for the rows you want to 

remove. Press the Delete key or choose Delete row from the 

shortcut menu to remove the selected column definitions.

Saving Column Definitions

If you edit column definitions or insert new definitions, you can save 

them in a table definition in the Repository. You can then load the 

definitions into other stages in your job design. 

To save the column definitions:

1 Click Save… . The Save Table Definition dialog box appears:

2 Enter a category name in the Data source type field. The name 
entered here determines how the definition will be stored under 
the main Table Definitions branch. By default, this field contains 
Saved. 

3 Enter a name in the Data source name field. This forms the 
second part of the table definition identifier and is the name of the 
branch created under the data source type branch. By default, this 
field contains the name of the stage you are editing.

4 Enter a name in the Table/file name field. This is the last part of 
the table definition identifier and is the name of the leaf created 
under the data source name branch. By default, this field contains 
the name of the link you are editing.

5 Optionally enter a brief description of the table definition in the 
Short description field. By default, this field contains the date 
and time you clicked Save… . The format of the date and time 
depend on your Windows setup. 
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6 Optionally enter a more detailed description of the table definition 
in the Long description field.

7 Click OK. The column definitions are saved under the specified 
branches in the Repository.

Naming Table Definitions

When you save your column definitions as a table definition, the 

following naming rules apply:

Table names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric, period, and underscore 
characters. 

Loading Column Definitions

You can load column definitions from a table definition in the 

Repository. For a description of how to create or import table 

definitions, see Chapter 7, "Job Reports."

Most stages allow you to selectively load columns, that is, specify the 

exact columns you want to load. 

To load column definitions:

1 Click Load… . The Table Definitions window appears. This 
window displays all the table definitions in your project in the 
form of a table definition tree. The table definition categories are 
listed alphabetically in the tree.

2 Double-click the appropriate category branch.

3 Continue to expand the categories until you see the table 
definition items.
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4 Select the table definition you want.

Note You can use Find… to enter the name of the table 

definition you want. The table definition is selected in 

the tree when you click OK.

5 If you cannot find the table definition, you can click Import ➤ 
Data source type to import a table definition from a data source 
(see "Importing a Table Definition" on page 9-12 for details).

6 Click OK. One of two things happens, depending on the type of 
stage you are editing:

If the stage type does not support selective meta data loading, all 
the column definitions from the chosen table definition are copied 
into the Columns grid. 

If the stage type does support selective meta data loading, the 
Select Columns dialog box appears, allowing you to specify 
which column definitions you want to load.

Use the arrow keys to move columns back and forth between the 

Available columns list and the Selected columns list. The 

single arrow buttons move highlighted columns, the double arrow 

buttons move all items. By default all columns are selected for 

loading. Click Find… to open a dialog box which lets you search 

for a particular column. The shortcut menu also gives access to 

Find… and Find Next. Click OK when you are happy with your 

selection. This closes the Select Columns dialog box and loads 

the selected columns into the stage.

For mainframe stages and certain parallel stages where the 

column definitions derive from a CFD file, the Select Columns 

dialog box may also contain a Create Filler check box. This 

happens when the table definition the columns are being loaded 

from represents a fixed-width table. Select this to cause 

sequences of unselected columns to be collapsed into filler items. 
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Filler columns are sized appropriately, their datatype set to 

character, and name set to FILLER_XX_YY where XX is the start 

offset and YY the end offset. Using fillers results in a smaller set of 

columns, saving space and processing time and making the 

column set easier to understand.

If you are importing column definitions that have been derived 

from a CFD file into server or parallel job stages, you are warned if 

any of the selected columns redefine other selected columns. You 

can choose to carry on with the load or go back and select 

columns again.

7 Click OK to proceed. If the stage you are loading already has 
column definitions of the same name, you are prompted to 
confirm that you want to overwrite them. The Merge Column 
Meta Data check box is selected by default and specifies that, if 
you confirm the overwrite, the Derivation, Description, Display 
Size and Field Position from the existing definition will be 
preserved (these contain information that is not necessarily part of 
the table definition and that you have possibly added manually). 
Note that the behavior of the merge is affected by the settings of 
the Meta Data options in the Designer Options dialog box (see 
"Meta Data Options" on page 3-28). 

8 Click Yes or Yes to All to confirm the load. Changes are saved 
when you save your job design.

Importing or Entering Column Definitions

If the column definitions you want to assign to a link are not held in 

the Repository, you may be able to import them from a data source 

into the Repository and then load them. You can import definitions 

from a number of different data sources. Alternatively you can define 

the column definitions manually.

You can import or enter table definitions from the DataStage Designer 

or the DataStage Manager. For instructions, see Chapter 7.

Server jobs and 
Parallel jobs 

Browsing Server Directories

When you edit certain server or parallel stages (i.e. one that access 

files), you may need to specify a directory path on the DataStage 
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server where the required files are found. You can specify a directory 

path in one of three ways:

Enter a job parameter in the respective text entry box in the stage 
dialog box. For more information about defining and using job 
parameters, see "Specifying Job Parameters" on page 4-55.

Enter the directory path directly in the respective text entry box in 
the Stage dialog box.

Use Browse… or Browse for file… . 

If you choose to browse, the Browse directories or Browse files 

dialog box appears. 

The Browse directories dialog box is as follows:

Look in. Displays the name of the current directory (or can be a 
drive if browsing a Windows system). This has a drop down that 
shows where in the directory hierarchy you are currently located.

Directory list. Displays the directories on the chosen directory. 
Double-click the directory you want. 

Directory name. The name of the selected directory.

Back button. Moves to the previous directory visited (is disabled 
if you have visited no other directories).

Up button. Takes you to the parent of the current directory.

View button. Offers a choice of different ways of viewing the 
directory tree.

OK button. Accepts the directory path in the Look in field and 
closes the Browse directories dialog box.
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Cancel button. Closes the dialog box without specifying a 
directory path.

Help button. Invokes the Help system.

The Browse files dialog box is as follows:

Look in. Displays the name of the current directory (or can be a 
drive if browsing a Windows system). This has a drop down that 
shows where in the directory hierarchy you are currently located.

Directory/File list. Displays the directories and files on the 
chosen directory. Double-click the file you want, or double-click a 
directory to move to it.

File name. The name of the selected file. You can use wildcards 
here to browse for files of a particular type.

Files of type. Select a file type to limit the types of file that are 
displayed. 

Back button. Moves to the previous directory visited (is disabled 
if you have visited no other directories).

Up button. Takes you to the parent of the current directory.

View button. Offers a choice of different ways of viewing the 
directory/file tree.

OK button. Accepts the file in the File name field and closes the 
Browse files dialog box.

Cancel button. Closes the dialog box without specifying a file.

Help button. Invokes the Help system.
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Cutting or Copying and Pasting Stages
You can cut or copy stages and links from one job and paste them into 

another. You can paste them into another job canvas of the same type. 

This can be in the same Designer, or another one, and you can paste 

them into different projects. You can also use Paste Special to paste 

stages and links into a new shared container.

Note Be careful when cutting from one context and pasting into 

another. For example, if you cut columns from an input link 

and paste them onto an output link they could carry 

information that is wrong for an output link and needs 

editing.

To cut a stage, select it in the canvas and select Edit ➤ Cut (or press 

CTRL-X). To copy a stage, select it in the canvas and select Edit ➤ 
Copy (or press CTRL-C). To paste the stage, select the destination 

canvas and select Edit ➤ Paste (or press CTRL-V). Any links attached 

to a stage will be cut and pasted too, complete with meta data. If there 

are name conflicts with stages or links in the job into which you are 

pasting, DataStage will automatically update the names.

There is a special feature that allows you to paste components into a 

shared container and add the shared container to the palette. This 

allows you to have pre-configured stages ready to drop into a job.

To paste a stage into a new shared container, select Edit ➤ Paste 
Special ➤ Into new Shared Container. The Paste Special into 
new Shared Container dialog box appears. This allows you to 

select a category and name for the new shared container, enter a 

description and optionally add a shortcut to the tool palette.
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If you want to cut or copy meta data along with the stages, you should 

select source and destination stages, which will automatically select 

links and associated meta data. These can then be cut or copied and 

pasted as a group.

Using the Data Browser
Server jobs and 
Parallel jobs

The Data Browser allows you to view the actual data that will flow 

through a server job or parallel stage. You can browse the data 

associated with the input or output links of any server job built-in 

passive stage or with the links to certain parallel job stages as follows:

Data Set stage

External Source stage

File Set stage (output links)

DB2 stage (output links)

Informix XPS stage (output links)

Oracle stage (output links)

Teradata stage (output links)

SAS Parallel Data Set stage

Row Generator stage (output links)

The Data Browser is invoked by clicking the View Data… button from 

a stage Inputs or Outputs page, or by choosing the View link 
Data… option from the shortcut menu. 

For parallel job stages a supplementary dialog box lets you select a 

subset of data to view by specifying the following:

Rows to display. Specify the number of rows of data you want 
the data browser to display.

Skip count. Skip the specified number of rows before viewing 
data.

Period. Display every Pth record where P is the period. You can 
start after records have been skipped by using the Skip property. P 
must equal or be greater than 1.

If your administrator has enabled the Generated OSH Visible option 

in the DataStage Administrator, the supplementary dialog box also 

has a Show OSH button. Click this to open a window showing the OSH 

that will be run to generate the data view. It is intended for expert 

users.

The Data Browser displays a grid of rows in a window. If a field 

contains a linefeed character, the field is shown in bold, and you can, 

if required, resize the grid to view the whole field.
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The Data Browser window appears:

The Data Browser uses the meta data defined for that link. If there is 

insufficient data associated with a link to allow browsing, the View 
Data… button and shortcut menu command used to invoke the Data 

Browser are disabled. If the Data Browser requires you to input some 

parameters before it can determine what data to display, the Job Run 
Options dialog box appears and collects the parameters (see "The 

Job Run Options Dialog Box" on page 4-79). 

Note You cannot specify $ENV or $PROJDEF as an environment 

variable value when using the data browser.

The Data Browser grid has the following controls:

You can select any row or column, or any cell with a row or 
column, and press CTRL-C to copy it.

You can select the whole of a very wide row by selecting the first 
cell and then pressing SHIFT+END.

If a cell contains multiple lines, you can expand it by left-clicking 
while holding down the SHIFT key. Repeat this to shrink it again.

You can view a row containing a specific data item using the Find… 

button. The Find dialog box will reposition the view to the row 
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containing the data you are interested in. The search is started from 

the current row.

The Display… button invokes the Column Display dialog box. This 

allows you to simplify the data displayed by the Data Browser by 

choosing to hide some of the columns. For server jobs, it also allows 

you to normalize multivalued data to provide a 1NF view in the Data 

Browser.

This dialog box lists all the columns in the display, all of which are 

initially selected. To hide a column, clear it.

For server jobs, the Normalize on drop-down list box allows you to 

select an association or an unassociated multivalued column on 

which to normalize the data. The default is Un-normalized, and 

choosing Un-normalized will display the data in NF2 form with each 

row shown on a single line. Alternatively you can select Un-
Normalized (formatted), which displays multivalued rows split over 

several lines. 

In the example, the Data Browser would display all columns except 

STARTDATE. The view would be normalized on the association 

PRICES.
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Using the Performance Monitor
Server jobs 
and
Parallel jobs

The Performance monitor is a useful diagnostic aid when designing 

DataStage server jobs and parallel jobs. When you turn it on and 

compile a job it displays information against each link in the job. 

When you run the job, either through the DataStage Director or the 

debugger, the link information is populated with statistics to show the 

number of rows processed on the link and the speed at which they 

were processed. The links change color as the job runs to show the 

progress of the job.

To use the performance monitor:

1 With the job open and compiled in the Designer choose 
Diagram➤ Show performance statistics. Performance 
information appears against the links. If the job has not yet been 
run, the figures will be empty.
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2 Run the job (either from the Director or by choosing Debug ➤ 
Go). Watch the links change color as the job runs and the statistics 
populate with number of rows and rows/sec.

If you alter anything on the job design you will lose the statistical 

information until the next time you compile the job.

The colors that the performance monitor uses are set via the Options 

dialog box. Chose Tools ➤ Options and select Graphical 

Performance Monitor under the Appearance branch to view the 

default colors and change them if required. You can also set the 
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refresh interval at which the monitor updates the information while 

the job is running.

Showing Stage Validation Errors
If you enable the Show stage validation errors option in the Diagram 

menu (or toolbar), the DataStage Designer will give you visual cues 

for parallel jobs or parallel shared containers. The visual cues display 

compilation errors for every stage on the canvas, without you having 

to actually compile the job. The option is enabled by default.

Here is an example of a parallel job showing visual cues:

The top Oracle stage has a warning triangle, showing that there is a 

compilation error. If you hover the mouse pointer over the stage a 

tooltip appears, showing the particular errors for that stage.

Any local containers on your canvas will behave like a stage, i.e., all 

the compile errors for stages within the container are displayed. You 

have to open a parallel shared container in order to see any compile 

problems on the individual stages.
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Note Parallel transformer stages will only show certain errors; to 

detect C++ errors in the stage, you have to actually compile 

the job containing it.

Compiling Server Jobs and Parallel Jobs
Server jobs 
and
Parallel jobs

When you have finished developing a server or a parallel job, you 

need to compile it before you can actually run it. Server jobs and 

parallel jobs are compiled on the DataStage server, and are 

subsequently run on the server using the DataStage Director.

Note For parallel jobs and parallel shared containers, the Show 

Stage Validation Errors option gives you advance warning 

of compilation errors in your job – see "Showing Stage 

Validation Errors" on page 4-42.

To compile a job, open the job in the Designer and do one of the 

following:

Choose File ➤ Compile.

Click the Compile button on the toolbar.

If the job has unsaved changes, you are prompted to save the job by 

clicking OK. The Compile Job dialog box appears. This dialog box 

contains a display area for compilation messages and has the 

following buttons:

Re-Compile. Recompiles the job if you have made any changes.

Show Error. Highlights the stage that generated a compilation 
error. This button is only active if an error is generated during 
compilation.

More. Displays the output that does not fit in the display area. 
Some errors produced by the compiler include detailed BASIC 
output. 

Close. Closes the Compile Job dialog box. 

Help. Invokes the Help system.
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The job is compiled as soon as this dialog box appears. You must 

check the display area for any compilation messages or errors that are 

generated. 

For parallel jobs there is also a force compile option. The compilation 

of parallel jobs is by default optimized such that transformer stages 

only get recompiled if they have changed since the last compilation. 

The force compile option overrides this and causes all transformer 

stages in the job to be compiled. To select this option:

Choose File ➤ Force Compile

Compilation Checks - Server Jobs

During compilation, the following criteria in the job design are 

checked:

Primary input. If you have more than one input link to a 
Transformer stage, the compiler checks that one is defined as the 
primary input link. 

Reference input. If you have reference inputs defined in a 
Transformer stage, the compiler checks that these are not from 
sequential files. 

Key expressions. If you have key fields specified in your column 
definitions, the compiler checks whether there are key expressions 
joining the data tables.

Transforms. If you have specified a transform, the compiler 
checks that this is a suitable transform for the data type. 

Successful Compilation

If the Compile Job dialog box displays the message Job 
successfully compiled with no errors. You can:

Validate the job

Run or schedule the job

Release the job

Package the job for deployment on other DataStage systems

Jobs are validated and run using the DataStage Director. See 

DataStage Director Guide for additional information. More 

information about compiling, releasing and debugging DataStage 

server jobs is in Server Job Developer’s Guide. More information 

about compiling and releasing parallel jobs is in the Parallel Job 

Developer’s Guide.
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Compiling from the Command Line

You can also compile DataStage jobs from the command line on the 

DataStage client, using the following command:

dscc 

The dscc command takes the following arguments:

/H hostname specify the DataStage server where the job or jobs 
reside.

/O specifying this is the equivalent of ticking the Omit box in the 
Attach dialog box. You do not need to specify username or 
password if you use this option.

/U username the username to use when attaching to the project.

/P password the password to use when attaching to the project.

project_name the project which the job or jobs belong to.

/J jobname |* | category_name\* specifies the jobs to be 
compiled. Use jobname to specify a single job, * to compile all 
jobs in the project and category_name\* to compile all jobs in that 
category (this will not include categories within that category). 
You can specify job sequences as well as parallel or server jobs.

/R routinename | * | category_name\* specifies routines to be 
compiled. Use routinename to specify a single routine, * to 
compile all routines in the project and category_name\* to 
compile all routines in that category (this will not include 
categories within that category).

/F force compile (for parallel jobs).

/OUC only compile uncompiled jobs.

/RD reportname specify a name and destination for a compilation 
report. Specify DESKTOP\filename to write it to your desktop or 
.\filename to write it to the current working directory.

The options are not case sensitive. 

For example:

dscc /h r101 /u fellp /p plaintextpassword dstageprj /J mybigjob

Will connect to the machine r101, with a username and password of 

fellp and plaintextpassword, attach to the project dstageprj and 

compile the job mybigjob.

Compiler Wizard

DataStage also has a compiler wizard that will guide you through the 

process of compiling jobs. You can start the wizard from the Tools 
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menu of the Designer, Manager, or Director clients. Select Tools ➤ 
Run Multiple Job Compile.

The wizard proceeds as follows:

1 A screen prompts you to specify the criteria for selecting jobs to 
compile. Choose one or more of:

– Server

– Parallel

– Mainframe

– Sequence

– Custom server routines

– Custom parallel stage types

You can also specify that only currently uncompiled jobs will be 

compiled, and that you want to manually select the items to 

compile.

2 Click Next>. 

If you chose the Show manual selection page option, the Job 

Selection Override screen appears. Choose jobs in the left pane 

and add them to the right pane by using the arrow buttons. All the 

jobs in the right pane will be compiled.

3 Click Next>, the Compiler Options screen appears, allowing you 
to specify the following:

– Force compile (for parallel jobs).

– An upload profile for mainframe jobs you are generating code 
for.

4 Click Next>. The Compile Process screen appears, displaying the 
names of the selected jobs and their current compile status. 

5 Click Start Compile to start the compilation. As the compilation 
proceeds the status changes from Not Compiled to Compiling to 
Compiled OK or Failed and details about each job are displayed in 
the compilation output window as it compiles. You can select or 
deselect the Show compile report checkbox while the 
compilation is happening.

6 Click Finish. If the Show compile report checkbox was selected 
the job compilation report screen appears, displaying the report 
generated by the compilation. 
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Running Server Jobs and Parallel Jobs
You can run server jobs and parallel jobs from within the Designer by 

clicking on the Run button in the toolbar. The job currently in focus 

will run, provided it has been compiled and saved.

Generating Code for Mainframe Jobs
Mainframe jobs When you have finished developing a mainframe job, you need to 

generate the code for the job. This code is then transferred to the 

mainframe machine, where the job is compiled and run. 

You can also generate code from the command line or using the 

compile wizard (see "Compiling from the Command Line" on 

page 4-45 and "Compiler Wizard"on page 4-45).

To generate code for a job, open the job in the Designer and do one of 

the following:

Choose File ➤ Generate Code.

Click the Generate Code button on the toolbar.

If the job has unsaved changes, you are prompted to save the job by 

clicking OK. The Mainframe Job Code Generation dialog box 

appears. This dialog box contains details of the code generation files 

and a display area for compilation messages. It has the following 

buttons:

Generate. Click this to validate the job design and generate the 
COBOL code and JCL files for transfer to the mainframe.

View. This allows you to view the generated files.

Upload job. This button is enabled if the code generation is 
successful. Clicking it opens the Remote System dialog box, 
which allows you to specify a machine to which to upload the 
generated code.
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Status messages are displayed in the Validation and code generation 

status window in the dialog box. For more information about 

generating code, see  Mainframe Job Developer’s Guide.

Job Validation

Validation of a mainframe job design involves:

Checking that all stages in the job are connected in one 
continuous flow, and that each stage has the required number of 
input and output links.

Checking the expressions used in each stage for syntax and 
semantic correctness. 

A status message is displayed as each stage is validated. If a stage 

fails, the validation will stop.

Code Generation

Code generation first validates the job design. If the validation fails, 

code generation stops. Status messages about validation are in the 

Validation and code generation status window. They give the names 

and locations of the generated files, and indicate the database name 

and user name used by each relational stage. 

Three files are produced during code generation:
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COBOL program file which contains the actual COBOL code that 
has been generated.

Compile JCL file which contains the JCL that controls the 
compilation of the COBOL code on the target mainframe machine.

Run JCL file which contains the JCL that controls the running of 
the job on the mainframe once it has been compiled.

Job Upload

Once you have successfully generated the mainframe code, you can 

upload the files to the target mainframe, where the job is compiled 

and run. 

To upload a job, choose File ➤ Upload Job. The Remote System 

dialog box appears, allowing you to specify information about 

connecting to the target mainframe system. Once you have 

successfully connected to the target machine, the Job Upload dialog 

box appears, allowing you to actually upload the job.

For more details about uploading jobs, see Mainframe Job 

Developer’s Guide.

JCL Templates 

DataStage uses JCL templates to build the required JCL files when 

you generate a mainframe job. DataStage comes with a set of 

building-block JCL templates suitable for tasks such as:

Allocate file

Cleanup existing file

Cleanup nonexistent file

Create 

Compile and link

DB2 compile, link, and bind

DB2 load

DB2 run

FTP 

JOBCARD 

New file 

Run 

Sort 
Designer Guide 4-49



Developing the Job Design Developing a Job
The supplied templates are in a directory called JCL Templates under 

the DataStage server install directory. There are also copies of the 

templates held in the DataStage Repository for each DataStage 

project.

You can edit the templates to meet the requirements of your particular 

project. This is done using the JCL Templates dialog box from the 

DataStage Manager. Open the JCL Templates dialog box by 

choosing Tools ➤ JCL Templates in the DataStage Manager. It 

contains the following fields and buttons: 

Platform type. Displays the installed platform types in a drop-
down list. 

Template name. Displays the available JCL templates for the 
chosen platform in a drop-down list. 

Short description. Briefly describes the selected template. 

Template. The code that the selected template contains.

Save. This button is enabled if you edit the code, or subsequently 
reset a modified template to the default code. Click Save to save 
your changes.

Reset. Resets the template code back to that of the default 
template.

If there are system wide changes that will apply to every project, then 

it is possible to edit the template defaults. Changes made here will be 

picked up by every DataStage project on that DataStage server. The 

JCL Templates directory contains two sets of template files: a default 

set that you can edit, and a master set which is read-only. You can 

always revert to the master templates if required, by copying the read-

only masters over the default templates. Use a standard editing tool, 

such as Microsoft Notepad, to edit the default templates.

More details about JCL templates are given in Appendix A of the 

Mainframe Job Developer’s Guide.

Code Customization

When you check the Generate COPY statement for 
customization box in the Code generation dialog box, DataStage 

provides four places in the generated COBOL program that you can 

customize. You can add code to be executed at program initialization 

or termination, or both. However, you cannot add code that would 

affect the row-by-row processing of the generated program.

When you check Generate COPY statement for customization, 

four additional COPY statements are added to the generated COBOL 

program:
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COPY ARDTUDAT. This statement is generated just before the 
PROCEDURE DIVISION statement. You can use this to add 
WORKING-STORAGE variables and/or a LINKAGE SECTION to the 
program. 

COPY ARDTUBGN. This statement is generated just after the 
PROCEDURE DIVISION statement. You can use this to add your 
own program initialization code. If you included a LINKAGE 
SECTION in ARDTUDAT, you can use this to add the USING clause 
to the PROCEDURE DIVISION statement.

COPY ARDTUEND. This statement is generated just before each 
STOP RUN statement. You can use this to add your own program 
termination code. 

COPY ARDTUCOD. This statement is generated as the last 
statement in the COBOL program. You use this to add your own 
paragraphs to the code. These paragraphs are those which are 
PERFORMed from the code in ARDTUBGN and ARDTUEND. 

DataStage provides default versions of these four COPYLIB members. 

As provided, ARDTUDAT, ARDTUEND, and ARDTUCOD contain only 

comments, and ARDTUBGN contains comments and a period.

You can either preserve these members and create your own 

COPYLIB, or you can create your own members in the DataStage 

runtime COPYLIB. If you preserve the members, then you must 

modify the DataStage compile and link JCL templates to include the 

name of your COPYLIB before the DataStage runtime COPYLIB. If you 

replace the members in the DataStage COPYLIB, you do not need to 

change the JCL templates.

Job Properties
Each job in a project has properties, including optional descriptions 

and job parameters. To view and edit the job properties from the 

Designer, open the job in the Diagram window and choose Edit ➤ 

Job Properties… or, if it is not currently open, select it in the 

Repository window and choose Properties from the shortcut menu. 

The Job Properties dialog box appears. The dialog box differs 

depending on whether it is a server job, parallel job, or a mainframe 

job. A server job has up to six pages: General, Parameters, Job 

control, Dependencies, Performance, and NLS. Parallel job 

properties are the same as server job properties except they have an 

Execution page rather than a Performance page, and also have a 

Generated OSH and Defaults page. A mainframe job has five 

pages: General, Parameters, Environment, Extensions, and 

Operational meta data.
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Server Job and Parallel Job Properties
Server jobs
and
Parallel jobs

The General page is as follows:

It has the following fields:

Category. The category to which the job belongs.

Job version number. The version number of the job. A job 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job. For more 
information about releasing jobs, see Server Job Developer’s 
Guide and Parallel Job Developer’s Guide.

– The bug fix number n.n.N. This number reflects minor changes 
to the job design or properties. To change this number, select it 
and enter a new value directly or use the arrow buttons to 
increase the number. 

Before-job subroutine and Input value. Optionally contain the 
name (and input parameter value) of a subroutine that is executed 
before the job runs. For example, you can specify a routine that 
prepares the data before processing starts. 

Choose a routine from the drop-down list box. This list box 

contains all the built routines defined as a Before/After 
Subroutine under the Routines branch in the Repository. Enter 
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an appropriate value for the routine’s input argument in the Input 

value field. 

If you use a routine that is defined in the Repository, but which 

was edited and not compiled, a warning message reminds you to 

compile the routine when you close the Job Properties dialog 

box. 

If you installed or imported a job, the Before-job subroutine 

field may reference a routine which does not exist on your system. 

In this case, a warning message appears when you close the Job 
Properties dialog box. You must install or import the “missing” 

routine or choose an alternative one to use.

A return code of 0 from the routine indicates success. Any other 

code indicates failure and causes a fatal error when the job is run.

After-job subroutine and Input value. Optionally contains the 
name (and input parameter value) of a subroutine that is executed 
after the job has finished. For example, you can specify a routine 
that sends an electronic message when the job finishes. 

Choose a routine from the drop-down list box. This list box 

contains all the built routines defined as a Before/After 
Subroutine under the Routines branch in the Repository. Enter 

an appropriate value for the routine’s input argument in the Input 

value field. 

If you use a routine that is defined in the Repository, but which 

was edited but not compiled, a warning message reminds you to 

compile the routine when you close the Job Properties dialog 

box. 

A return code of 0 from the routine indicates success. Any other 

code indicates failure and causes a fatal error when the job is run.

Only run after-job subroutine on successful job 
completion. This option is enabled if you have selected an After-
job subroutine. If you select the option, then the After-job 
subroutine will only be run if the job has successfully completed 
running all its stages.

Enable Runtime Column Propagation for new links. This checkbox 
appears for parallel jobs if you have selected Enable Runtime 
Column propagation for Parallel jobs for this project in the 
DataStage Administrator. Check it to enable runtime column 
propagation by default for all new links on this job (see "Runtime 
Column Propagation" in Parallel Job Developer’s Guide for a 
description).
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RTI Service Enabled. This checkbox only appears for server 
jobs. By selecting this checkbox, you indicate that the job is 
eligible to become a RTI Service. Eligible jobs will be available for 
deployment as services from the RTI console.

Allow Multiple Instance. Select this to enable the DataStage 
Director to run multiple instances of this job.

Enable hashed file cache sharing. Check this to enable 
multiple processes to access the same hash file in cache (the 
system checks if this is appropriate). This can save memory 
resources and speed up execution where you are, for example, 
running multiple instances of the same job. This applies to server 
jobs and to parallel jobs that used server functionality in container 
stages.

Short job description. An optional brief description of the job.

Full job description. An optional detailed description of the job.

Parallel job properties have an additional check box:

Enable Runtime Column Propagation for new links. This checkbox 
appears if you have selected Enable Runtime Column propagation 
for Parallel jobs for this project in the DataStage Administrator. 
Check it to enable runtime column propagation by default for all 
new links on this job (see "Runtime Column Propagation" in 
Parallel Job Developer’s Guide for a description).

If you installed or imported a job, the After-job subroutine field may 

reference a routine that does not exist on your system. In this case, a 

warning message appears when you close the Job Properties dialog 

box. You must install or import the “missing” routine or choose an 

alternative one to use.

Before- and After-Job Routines

The following routines are available for use as before- or after-job 

routines:

DSSendMail. This routine is an interlude to the local send mail 
program.

DSWaitForFile. This routine is called to suspend a job until a 
named job either exists, or does not exist.

DSJobReport. This routine can be called at the end of a job to 
write a job report to a file. The routine takes an argument 
comprising two or three elements separated by semi-colons as 
follows:
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– Report type. 0, 1, or 2 to specify report detail. Type 0 produces 
a text string containing start/end time, time elapsed and status 
of job. Type 1 is as a basic report but also contains information 
about individual stages and links within the job. Type 2 
produces a text string containing a full XML report. 

– Directory. Specifies the directory in which the report will be 
written.

– XSL stylesheet. Optionally specifies an XSL style sheet to 
format an XML report.

If the job had an alias ID then the report is written to 

JobName_alias.txt or JobName_alias.xml, depending on report 

type. If the job does not have an alias, the report is written to 

JobName_YYYYMMDD_HHMMSS.txt or 

JobName_YYYYMMDD_HHMMSS.xml, depending on report type.

ExecDOS. This routine executes a command via an MS-DOS 
shell. The command executed is specified in the routine’s input 
argument. 

ExecDOSSilent. As ExecDOS, but does not write the command 
line to the job log.

ExecTCL. This routine executes a command via a DataStage 
Engine shell. The command executed is specified in the routine’s 
input argument. 

ExecSH. This routine executes a command via a UNIX Korn shell.

ExecSHSilent. As ExecSH, but does not write the command line 
to the job log.

Specifying Job Parameters
Server jobs 
and
Parallel jobs

Job parameters allow you to design flexible, reusable jobs. If you 

want to process data based on the results for a particular week, 

location, or product you can include these settings as part of your job 

design. However, when you want to use the job again for a different 

week or product, you must edit the design and recompile the job. 

Instead of entering inherently variable factors as part of the job 

design, you can set up parameters which represent processing 

variables. 

For server and parallel jobs, you are prompted for values when you 

run or schedule the job. 

Job parameters are defined, edited, and deleted in the Parameters 

page of the Job Properties dialog box. 

All job parameters are defined by editing the empty row in the Job 

Parameters grid. For more information about adding and deleting 
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rows, or moving between the cells of a grid, see Appendix A, “Editing 

Grids.” 

Warning Before you remove a job parameter definition, you 

must make sure that you remove the references to this 

parameter in your job design. If you do not do this, 

your job may fail to run. 

You can also use the Parameters page to set different values for 

environment variables while the job runs. The settings only take effect 

at run-time, they do not affect the permanent settings of environment 

variables.

The server job Parameters page is as follows:

The Job Parameters grid has the following columns:

Parameter name. The name of the parameter.

Prompt. Text used as the field name in the run-time dialog box.

Type. The type of the parameter (to enable validation).

Default Value. The default setting for the parameter.

Help text. The text that appears if a user clicks Property Help in 
the Job Run Options dialog box when running the job.

Job Parameters

Specify the type of the parameter by choosing one of the following 

from the drop-down list in the Type column:
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String. The default type.

Encrypted. Used to specify a password. The default value is set 
by double-clicking the Default Value cell to open the Setup 
Password dialog box. Type the password in the Encrypted 
String field and retype it in the Confirm Encrypted String field. 
It is displayed as asterisks.

Integer. Long int (–2147483648 to +2147483647).

Float. Double (1.79769313486232E308 to –4.94065645841247E–
324 and 4.94065645841247E–324 to –1.79769313486232E308).

Pathname. Enter a default pathname or file name by typing it into 
Default Value or double-click the Default Value cell to open the 
Browse dialog box.

List. A list of valid string variables. To set up a list, double-click the 
Default Value cell to open the Setup List and Default dialog 
box. Build a list by typing in each item into the Value field, then 
clicking Add. The item then appears in the List box. To remove an 
item, select it in the List box and click Remove. Select one of the 
items from the Set Default drop-down list box to be the default.

Date. Date in the ISO format yyyy-mm-dd.

Time. Time in the format hh:mm:ss.

DataStage uses the parameter type to validate any values that are 

subsequently supplied for that parameter, be it in the Director or the 

Designer.
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Job Parameter Defaults

You can supply default values for parameters, which are used unless 

another value is specified when the job is run. For most parameter 

types, you simply type an appropriate default value into the Default 
Value cell. When specifying a password or a list variable, double-click 

the Default Value cell to open further dialog boxes which allow you 

to supply defaults.

Using Job Parameters in Server Jobs

To use the defined job parameters, you must specify them when you 

edit a stage. When you edit a field that you wish to use a parameter 

for, enter #Param#, where Param is the name of the job parameter. 

The string #Param# is replaced by the value for the job parameter 

when the job is run. (For more details about editing stages, see 

"Editing Stages" on page 4-27.) 

A job parameter can be used in any stage or link property, for 

example:

In Transformer stages. You can use job parameters in the 
following fields when you edit a Transformer stage:

– Key Expression cell of a reference input link

– Constraint on an output link

– Derivation cell of an output link

You can use the Expression Editor to insert a job parameter in 

these fields. For information about the Expression Editor, see "The 

DataStage Expression Editor" in Server Job Developer’s Guide.

In Sequential File stages. You can use job parameters in the 
following fields in the Sequential File Stage dialog box:

– File name field on the Inputs or Outputs page

In ODBC or UniVerse stages. You can use job parameters in the 
following fields in the stage dialog box:

– Data source name field on the General tab on the Stage 
page

– User name and Password fields on the General tab on the 
Stage page

– Account name or Use directory path fields on the Details 
tab on the Stage page (UniVerse stage only)

– Table name field on the General tab on the Inputs or 
Outputs page
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– WHERE clause field on the Selection tab on the Outputs 
page

– Value cell on the Parameters tab, which appears in the 
Outputs page when you use a stored procedure (ODBC stage 
only)

– Expression field on the Derivation dialog box, opened from 
the Derivation column in the Outputs page of a UniVerse or 
ODBC Stage dialog box

In Hashed File stages. You can use job parameters in the following 
fields in the Hashed File Stage dialog box:

– Use account name or Use directory path fields on the 
Stage page

– File name field on the General tab on the Inputs or Outputs 
page

In UniData stages. You can use job parameters in the following 
fields in the UniData Stage dialog box:

– Server, Database, User name, and Password fields on the 
Stage page

– File name field on the General tab on the Inputs or Outputs 
page

In Folder stages. You can use job parameters in the following 
fields in the Folder stage dialog box:

– Properties in the Properties tab of the Stage page

– Properties in the Properties tab of the Outputs page

Before and after subroutines. You can use job parameters to 
specify argument values for before and after subroutines.

Note You can also use job parameters in the Property name 

field on the Properties tab in the stage type dialog box 

when you create a plug-in. For more information, see 

Server Job Developer’s Guide.

Using Job Parameters in Parallel Jobs

You can use the defined parameters by specifying them in place of 

properties in a parallel job stage editor. Properties that you can 

substitute a job parameter for have a right arrow next to the property 

value field. Click on this to open a menu and click on the Job 
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Parameter item. This allows you to choose from the list of defined job 

parameters.

Environment Variables

To set a runtime value for an environment variable:
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1 Click Add Environment Variable… at the bottom of the 
Parameters page. The Choose environment variable list 
appears.

This shows a list of the available environment variables (the 

example shows parallel job environment variables).
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2 Click on the environment variable you want to override at runtime. 
It appears in the parameter grid, distinguished from job 
parameters by being preceded by a $. 

You can also click New… at the top of the list to define a new 

environment variable. A dialog box appears allowing you to 

specify name and prompt. The new variable is added to the 

Choose environment variable list and you can click on it to add 

it to the parameters grid.

3 Set the required value in the Default Value column. This is the 
only field you can edit for an environment variable. Depending on 
the type of variable a further dialog box may appear to help you 
enter a value. 

When you run the job and specify a value for the environment 

variable, you can specify one of the following special values:

$ENV. Instructs DataStage to use the current setting for the 
environment variable.

$PROJDEF. The current setting for the environment variable is 
retrieved and set in the job’s environment (so that value is used 
wherever in the job the environment variable is used). If the value 
of that environment variable is subsequently changed in the 
Administrator client, the job will pick up the new value without the 
need for recompiling.

$UNSET. Instructs DataStage to explicitly unset the environment 
variable.
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Environment variables are set up using the DataStage Administrator, 

see "Setting Environment Variables" in DataStage Administrator 

Guide.

Job Control Routines
Server jobs
and
Parallel jobs

A job control routine provides the means of controlling other jobs 

from the current job. A set of one or more jobs can be validated, run, 

reset, stopped, and scheduled in much the same way as the current 

job can be. You can, if required, set up a job whose only function is to 

control a set of other jobs. The graphical job sequence editor (see 

Chapter 6) produces a job control routine when you compile a job 

sequence (you can view this in the Job Sequence properties), but you 

can set up you own control job by entering your own routine on the 

Job control page of the Job Properties dialog box. The routine 

uses a set of BASIC functions provided for the purpose. For more 

information about these routines, see "DataStage Development Kit 

(Job Control Interfaces)" in Server Job Developer’s Guide, or 

"DataStage Development Kit (Job Control Interfaces)" in Parallel Job 

Developer’s Guide. You can use this same code for running parallel 

jobs. The Job control page provides a basic editor to let you 

construct a job control routine using the functions.

The toolbar contains buttons for cutting, copying, pasting, and 

formatting code, and for activating Find (and Replace). The main part 

of this page consists of a multiline text box with scroll bars. The Add 
Job button provides a drop-down list box of all the server and parallel 

jobs in the current project. When you select a compiled job from the 

list and click Add, the Job Run Options dialog box appears, allowing 

you to specify any parameters or run-time limits to apply when the 

selected job is run. The job will also be added to the list of 

dependencies (see "Specifying Job Dependencies" on page 4-65). 

When you click OK in the Job Run Options dialog box, you return to 

the Job control page, where you will find that DataStage has added 

job control code for the selected job. The code sets any required job 

parameters and/or limits, runs the job, waits for it to finish, then tests 

for success.
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Alternatively, you can type your routine directly into the text box on 

the Job control page, specifying jobs, parameters, and any run-time 

limits directly in the code.

The following is an example of a job control routine. It schedules two 

jobs, waits for them to finish running, tests their status, and then 

schedules another one. After the third job has finished, the routine 

gets its finishing status.

* get a handle for the first job
Hjob1 = DSAttachJob("DailyJob1",DSJ.ERRFATAL)
* set the job's parameters
Dummy = DSSetParam(Hjob1,"Param1","Value1")
* run the first job
Dummy = DSRunJob(Hjob1,DSJ.RUNNORMAL)
* get a handle for the second job
Hjob2 = DSAttachJob("DailyJob2",DSJ.ERRFATAL)
* set the job's parameters
Dummy = DSSetParam(Hjob2,"Param2","Value2")
* run the second job
Dummy = DSRunJob(Hjob2,DSJ.RUNNORMAL)
* Now wait for both jobs to finish before scheduling the third job
Dummy = DSWaitForJob(Hjob1)
Dummy = DSWaitForJob(Hjob2)
* Test the status of the first job (failure causes routine to exit)
J1stat = DSGetJobInfo(Hjob1, DSJ.JOBSTATUS)
If J1stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob1 failed","JobControl")
End
* Test the status of the second job (failure causes routine to 
* exit)
J2stat = DSGetJobInfo(Hjob2, DSJ.JOBSTATUS)
If J2stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob2 failed","JobControl")
End
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* Now get a handle for the third job
Hjob3 = DSAttachJob("DailyJob3",DSJ.ERRFATAL)
* and run it
Dummy = DSRunJob(Hjob3,DSJ.RUNNORMAL)
* then wait for it to finish
Dummy = DSWaitForJob(Hjob3)
* Finally, get the finishing status for the third job and test it
J3stat = DSGetJobInfo(Hjob3, DSJ.JOBSTATUS)
If J3stat = DSJS.RUNFAILED 

Then Call DSLogFatal("Job DailyJob3 failed","JobControl")
End

Possible status conditions returned for a job are as follows.

A job that is in progress is identified by:

DSJS.RUNNING – Job running; this is the only status that means 
the job is actually running.

Jobs that are not running may have the following statuses:

DSJS.RUNOK –  Job finished a normal run with no warnings.

DSJS.RUNWARN – Job finished a normal run with warnings.

DSJS.RUNFAILED – Job finished a normal run with a fatal error.

DSJS.VALOK – Job finished a validation run with no warnings.

DSJS.VALWARN – Job finished a validation run with warnings.

DSJS.VALFAILED –  Job failed a validation run.

DSJS.RESET –  Job finished a reset run.

DSJS.STOPPED – Job was stopped by operator intervention 
(cannot tell run type).

Note If a job has an active select list, but then calls another job, 

the second job will effectively wipe out the select list.

Specifying Job Dependencies
Server jobs
and
Parallel jobs

The Dependencies page of the Job Properties dialog box allows 

you to specify any dependencies a job has. These may be functions, 

routines, or other jobs that the job requires in order to run 

successfully. This is to ensure that, if the job is packaged for use on 

another system, all the required components will be included in the 

package.
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Enter details as follows:

Type. The type of item upon which the job depends. Choose from 
the following:

– Job. Released or unreleased job. If you have added a job on 
the Job control page (see page 4-63), this will automatically 
be included in the dependencies. If you subsequently delete 
the job from the job control routine, you must remove it from 
the dependencies list manually.

– Local. Locally cataloged BASIC functions and subroutines (i.e., 
Transforms and Before/After routines).

– Global. Globally cataloged BASIC functions and subroutines 
(i.e., Custom UniVerse functions).

– File. A standard file.

– ActiveX. An ActiveX (OLE) object (not available on UNIX-
based systems).

Name. The name of the function or routine. The name required 
varies according to the Type of the dependency:

– Job. The name of a released, or unreleased, job. 

– Local. The catalog name. 

– Global. The catalog name.

– File. The file name.

– ActiveX. Server jobs only. The Name entry is actually 
irrelevant for ActiveX objects. Enter something meaningful to 
you (ActiveX objects are identified by the Location field).
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Location. The location of the dependency. A browse dialog box is 
available to help with this. This location can be an absolute path, 
but it is recommended you specify a relative path using the 
following environment variables:

– %SERVERENGINE% – DataStage engine account directory 
(normally C:\Ascential\DataStage\ServerEngine).

– %PROJECT% – Current project directory.

– %SYSTEM% – System directory on Windows or /usr/lib on 
UNIX.

The Browse Files dialog box is shown below. You cannot navigate to 

the parent directory of an environment variable.

Specifying Performance Enhancements
Server Jobs The Performance page allows you to improve the performance of 

the job by specifying the way the system divides jobs into processes. 

For a full explanation of this, see "Optimizing Performance in Server 

Jobs" in Server Job Developer’s Guide.
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These settings can also be made on a project-wide basis using the 

DataStage Administrator (see"Tunables Page" in DataStage 

Administartor Guide).

The settings are: 

Use Project Defaults. Select this to use whatever setting have 
been made in the DataStage Administrator for the project to which 
this job belongs.

Enable Row Buffering. There are two types of mutually 
exclusive row buffering:

– In process. You can improve the performance of most 
DataStage jobs by turning in-process row buffering on and 
recompiling the job. This allows connected active stages to 
pass data via buffers rather than row by row.

– Inter process. Use this if you are running server jobs on an 
SMP parallel system. This enables the job to run using a 
separate process for each active stage, which will run 
simultaneously on a separate processor. 

Note You cannot use row-buffering of either sort if your job 

uses COMMON blocks in transform functions to pass 

data between stages. This is not recommended 

practice, and it is advisable to redesign your job to use 

row buffering rather than COMMON blocks.

Buffer size. Specifies the size of the buffer used by in-process or 
inter-process row buffering. Defaults to 128 Kb.
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Timeout. Only applies when inter-process row buffering is used. 
Specifies the time one process will wait to communicate with 
another via the buffer before timing out. Defaults to 10 seconds.

Specifying Maps and Locales for Server Jobs
Server jobs You can ensure that DataStage uses the correct character set map and 

formatting rules for your server job by specifying character set maps 

and locales on the NLS page of the Job Properties dialog box.

Defining Character Set Maps

The character set map defines the character set DataStage uses for 

this job. You can select a specific character set map from the list or 

accept the default setting for the whole project. 

Note The list contains all character set maps that are loaded and 

ready for use. You can view other maps that are supplied 

with DataStage by clicking Show all maps, but these maps 

cannot be used unless they are loaded using the DataStage 

Administrator. For more information, see "NLS 

Configuration" in DataStage Administrator Guide. 

Defining Data Formats with Locales

Different countries and territories have different formatting 

conventions for common data types such as times, dates, numbers, 

and currency. The set of conventions used in a particular place with a 

particular language is called a locale. For example, there is a 
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Canadian-French locale whose conventions differ from the French-

French locale. 

DataStage recognizes the locales for many territories. A default locale 

is set for each project during installation. You can override the default 

for a particular job by selecting the locale you require for each 

category on the NLS page of the Job Properties dialog box:

Time/Date specifies the locale to use for formatting times and 
dates.

Numeric specifies the locale to use for formatting numbers, for 
example, the thousands separator and radix character.

Currency specifies the locale to use for monetary amounts, for 
example, the currency symbol and where it is placed.

CType specifies the locale to use for determining character types, 
for example, which letters are uppercase and which lowercase.

Collate specifies the locale to use for determining the order for 
sorted data.

In most cases you should use the same locale for every category to 

ensure that the data is formatted consistently.

Specifying Maps and Locales for Parallel Jobs
Parallel jobs You can ensure that DataStage uses the correct character set map and 

collate formatting rules for your parallel job by specifying character 

set maps and collation locale on the NLS page of the Job Properties 

dialog box.
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The character set map defines the character set DataStage uses for 

this job. You can select a specific character set map from the list or 

accept the default setting for the whole project. 

The locale determines the order for sorted data in the job. Select the 

project default or choose one from the list. 

Generated OSH Page
This page appears if you have selected the Generated OSH visible 

option in the DataStage Administrator (see "Parallel Page" in 

DataStage Administrator Guide). The page allows you to view the 

code generated by parallel jobs when they are compiled.

Specifying Execution Page Options
Parallel jobs From this page you can switch tracing on for parallel jobs to help you 

debug them. You can also specify a collation sequence file and set the 

default runtime column propagation value setting for this job.

The page has the following options:

Compile in trace mode. Select this so that you can use the 
tracing facilities after you have compiled this job.

Force Sequential Mode. Select this to force the job to run 
sequentially on the conductor node. 

Limits per partition. These options enable you to limit data in 
each partition to make problems easier to diagnose:

– Number of Records per Link. This limits the number of 
records that will be included in each partition.
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Log Options Per Partition. These options enable you to specify 
how log data is handled for partitions. This can cut down the data 
in the log to make problems easier to diagnose.

– Skip count. Set this to N to skip the first N records in each 
partition.

– Period. Set this to N to print every Nth record per partition, 
starting with the first record. N must be >= 1.

Advanced Runtime Options. This field allows experienced 
Orchestrate users to enter parameters that are added to the OSH 
command line. Under normal circumstances this should be left 
blank.

Specifying Parallel Job Defaults
Parallel jobs You specify date/time and number formats for a job on the Defaults 

page. You can also specify a local message handler for the job.

The page shows the current defaults for date, time, timestamp, and 

decimal separator. To change the default, clear the corresponding 

Project default check box, then either select a new format from the 

drop-down list or type in a new format.

The Message Handler for Parallel Jobs field allows you to choose 

a message handler to be included in this job. The message handler 

will be compiled with the job and become part of its executable. The 

drop-down list offers a choice of currently defined message handlers. 

For more information, see "Managing Message Handlers" in 

DataStage Director Guide.
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Mainframe Job Properties
Mainframe jobs The mainframe job General page is as follows:

Category. The category to which the job belongs.

Job version number. The version number of the job. A job 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job.

– The bug fix number n.n.N. This number reflects minor changes 
to the job design or properties. To change this number, select it 
and enter a new value directly or use the arrow buttons to 
increase the number. 

Century break year. Where a two-digit year is used in the data, this 
is used to specify the year that is used to separate 19nn years from 
20nn years.

Date format Specifies the default date format for the job. Choose 
a setting from the drop-down list, possible settings are:

– MM/DD/CCYY

– DD.MM.CCYY

– CCYY-MM-DD
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The default date is used by a number of stages to interpret the 

date field in their column definitions. It is also used where a date 

type from an active stage is mapped to character or other data 

types in a following passive stage.

The default date is also specified at project level using the 

DataStage Administrator client. The job default overrides the 

project default.

Perform expression semantic checking. Click this to enable 
semantic checking in the mainframe expression editor. Be aware 
that selecting this can incur performance overheads. This is most 
likely to affect jobs with large numbers of column derivations.

Generate operational meta data. Click this to have the job 
generate operational meta data for use in MetaStage. Clicking this 
enables the Operational meta data page (see "Specifying 
Operational Meta Data" on page 4-79).

NULL indicator location. Select Before column or After 
column to specify the position of NULL indicators in mainframe 
column definitions.

NULL indicator value. Specify the character used to indicate 
nullability of mainframe column definitions. NULL indicators must 
be single-byte, printable characters. Specify one of the following: 

– A single character value (1 is the default)

– An ASCII code in the form of a three-digit decimal number 
from 000 to 255

– An ASCII code in hexadecimal form of %Hnn or %hnn where 
'nn' is a hexadecimal digit (0-9, a-f, A-F)

Non-NULL Indicator Value. Specify the character used to 
indicate non-NULL column definitions in mainframe flat files. 
NULL indicators must be single-byte, printable characters. Specify 
one of the following: 

– A single character value (0 is the default)

– An ASCII code in the form of a three-digit decimal number 
from 000 to 255

– An ASCII code in hexadecimal form of %Hnn or %hnn where 
'nn' is a hexadecimal digit (0-9, a-f, A-F)

Short job description. An optional brief description of the job.

Full job description. An optional detailed description of the job.

Click OK to record your changes in the job design. Changes are not 

saved to the Repository until you save the job design.
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Specifying Mainframe Job Parameters
Mainframe jobs Instead of entering inherently variable factors as part of the job design 

you can set up parameters which represent processing variables. 

For mainframe jobs the parameter values are placed in a file that is 

accessed when the job is compiled and run on the mainframe. 

Job parameters are defined, edited, and deleted in the Parameters p

age of the Job Properties dialog box. 

All job parameters are defined by editing the empty row in the Job 

Parameters grid. For more information about adding and deleting 

rows, or moving between the cells of a grid, see Appendix A, “Editing 

Grids.” 

Warning Before you remove a job parameter definition, you 

must make sure that you remove the references to this 

parameter in your job design. If you do not do this, 

your job may fail to run. 

The mainframe job Parameters page is as follows:

It contains the following fields and columns:

Parameter file name. The name of the file containing the 
parameters.

COBOL DD name. The DD name for the location of the file.

Name. The name of the parameter.

Type. The type of the parameter. It can be one of:

– Char. A fixed-length string where the Length attribute is used 
to determine its length. The COBOL program defines this 
parameter with PIC X(length).
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– Decimal. A COBOL signed zoned-decimal number, the 
precision is indicated by Length and the scale by Scale. The 
COBOL program defines this parameter with PIC S9(length-
scale)V9(scale).

– Integer. A COBOL signed zoned-decimal number, where the 
Length attribute is used to define its length. The COBOL 
program defines this parameter with PIC S9(length).

Length. The length of a char or a decimal parameter.

Scale. The precision of a decimal parameter.

Description. Optional description of the parameter.

Save As… . Allows you to save the set of job parameters as a 
table definition in the DataStage Repository.

Load… . Allows you to load the job parameters from a table 
definition in the DataStage Repository.

Using Mainframe Job Parameters

You can use job parameters as part of mainframe expressions. The 

Expression Editor offers a list of the job parameters that have been 

defined. See "Programming in Mainframe Jobs" on page 10-6 for a 

general description of the Expression Editor, and Mainframe Job 

Developer’s Guide for a more detailed description.

The actual values for job parameters are specified in a separate file 

which is uploaded to the mainframe with the job. See Mainframe Job 

Developer’s Guide for more details.
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Specifying Mainframe Job Environment Properties
Mainframe jobs The environment properties of a mainframe job in the Job 

Properties dialog box allow you to specify information that is used 

when code is generated for mainframe jobs.

It contains the following fields:

DBMS. If your design includes relational stages, the code 
generation process looks here for database details to include in 
the JCL files. If these fields are blank, it will use the project 
defaults as specified in the DataStage Administrator. 

– System name. The name of the database used by the 
relational stages in the job. If not specified, the project default 
is used.

– User name and Password. These will be used throughout the 
job. If not specified, the project default is used. 

– Rows per commit. Defines the number of rows that are 
written to a DB2 database before they are committed. The 
default setting is 0, which means to commit after all rows are 
processed. If you enter a number, the commit occurs after the 
specified number of rows are processed. For inserts, only one 
row is written. For updates or deletes, multiple rows may be 
written. However, if an error is detected, a rollback occurs. 

Teradata. If your design includes Teradata stages, the code 
generation process looks here for database details to include in 
the JCL files. 
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– TDP id and Account id. The connection details used in 
Teradata stages throughout the job.

– User ID and Password. These will be used throughout the 
job. 

Specifying Extension Variable Values
If you have customized the JCL templates and added extension 

variables, you can supply values for these variables for a particular job 

in the Extension page of the Job Properties dialog box.

It contains a grid with the following columns:

Name. The name of the extension variable. The name must begin 
with an alphabetic character and can contain only alphabetic or 
numeric characters. It can be upper or lower case or mixed.

Value. The value that the extension variable will take in this job. 
No validation is done on the value.
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Specifying Operational Meta Data
If your job is going to generate operational meta data for use with 

MetaStage you can specify the details of how the meta data will be 

handled on this page.

The fields are:

Machine Profile. If you have already specified a machine profile 
that contains some or all of the required details, you can select it 
from the drop-down list and the relevant fields will be 
automatically filled in.

IP address. IP Host name/address for the machine running your 
program and generating the operational meta data.

File exchange method. Choose between FTP and connect direct.

User name. The user name for connecting to the machine.

Password. The password for connecting to the machine

XML file target directory and Dataset name for XML file. 
Specify the target directory and dataset name for the XML file 
which will record the operational meta data.

The Job Run Options Dialog Box
Server jobs & 
Parallel jobs

When the DataStage Designer needs you to specify information about 

the running of a server job or parallel job, it displays the Job Run 
Options dialog box. It has two pages: one to collect any parameters 

the job requires and one to let you specify any run-time limits. This 
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dialog box may appear when you are using the Data Browser, 

specifying a job control routine, or using the debugger.

The Parameters page lists any parameters that have been defined for 

the job. If default values have been specified, these are displayed too. 

You can enter a value in the Value column, edit the default, or accept 

the default as it is. Click Set to Default to set a parameter to its 

default value, or click All to Default to set all parameters to their 

default values. Click Property Help to display any help text that has 

been defined for the selected parameter (this button is disabled if no 

help has been defined). Click OK when you are satisfied with the 

values for the parameters. 

When setting a value for an environment variable, you can specify one 

of the following special values:

$ENV. Instructs DataStage to use the current setting for the 
environment variable.

$PROJDEF. The current setting for the environment variable is 
retrieved and set in the job’s environment (so that value is used 
wherever in the job the environment variable is used). If the value 
of that environment variable is subsequently changed in the 
Administrator client, the job will pick up the new value without the 
need for recompiling.

$UNSET. Instructs DataStage to explicitly unset the environment 
variable.

Note that you cannot use these special values when viewing data on 

Parallel jobs. You will be warned if you try to do this.
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The Limits page allows you to specify whether stages in the job 

should be limited in how many rows they process and whether run-

time error warnings should be ignored. 

To specify a row’s limits:

1 Click the Stop stages after option button.

2 Select the number of rows from the drop-down list box.

To specify that the job should abort after a certain number of 

warnings:

1 Click the Abort job after option button.

2 Select the number of warnings from the drop-down list box.

The General page allows you to specify that the job should generate 

operational meta data, suitable for use by MetaStage. It also allows 

you to disable any message handlers that have been specified for this 

job run. See DataStage Director Guide for more information about 

both these features.
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5
Containers

Server jobs
and 
Parallel jobs

A container is a group of stages and links. Containers enable you to 

simplify and modularize your server job designs by replacing complex 

areas of the diagram with a single container stage.

DataStage provides two types of container:

Local containers. These are created within a job and are only 
accessible by that job. A local container is edited in a tabbed page 
of the job’s Diagram window. Local containers can be used in 
server jobs or parallel jobs.

Shared containers. These are created separately and are stored 
in the Repository in the same way that jobs are. There are two 
types of shared container:

– Server shared container. Used in server jobs (can also be used 
in parallel jobs).

– Parallel shared container. Used in parallel jobs. 

You can also include server shared containers in parallel jobs as a 

way of incorporating server job functionality into a parallel stage 

(for example, you could use one to make a server plug-in stage 

available to a parallel job).

Local Containers
Server jobs
and 
Parallel jobs

The main purpose of using a DataStage local container is to simplify a 

complex design visually to make it easier to understand in the 

Diagram window. If the DataStage job has lots of stages and links, it 

may be easier to create additional containers to describe a particular 

sequence of steps. Containers are linked to other stages or containers 

in the job by input and output stages. 
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You can create a local container from scratch, or place a set of existing 

stages and links within a container. A local container is only accessible 

to the job in which it is created.

Creating a Local Container
If your job design is becoming complex, you can modularize the 

design by grouping stages and links into a container. 

To save an existing group of stages and links in a local container:

1 Choose the stages and links by doing one of the following:

– Click and drag the mouse over all the stages you want in the 
container. 

– Select a stage. Press Shift and click the other stages you want 
to add to the container.

All the chosen stages are highlighted in the system highlight color. 

2 Choose Edit ➤ Construct Container ➤ Local. The group is 
replaced by a Local Container stage in the Diagram window. A 
new tab appears in the Diagram window containing the contents 
of the new Local Container stage. You are warned if any link 
naming conflicts occur when the container is constructed. The 
new container is opened and focus shifts onto its tab.

To insert an empty local container, to which you can add stages and 

links, click the Container icon in the General group on the tool palette 

and click on the Diagram window, or drag and drop it onto the 

Diagram window.

A Container stage is added to the Diagram window, double-click on 

the stage to open it, and add stages and links to the container.

You can rename, move, and delete a container stage in the same way 

as any other stage in your job design (see "Stages" on page 4-5).

Viewing or Modifying a Local Container
To view or modify the stages or links in a container, do one of the 

following:

Double-click the container stage in the Diagram window.

Click the tab of the Container window to bring it to the front.

Select the container and choose Edit ➤ Properties… .

Select the container and choose Properties… from the shortcut 
menu.
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You can edit the stages and links in a container in the same way you 

do for a job. See "Using Input and Output Stages" on page 5-3 for 

details on how to link the container to other stages in the job.

Using Input and Output Stages
When you use a local container in a job design, a link is displayed 

going into or out of the container. In the container itself, you cannot 

have a link hanging in mid-air, so input and output stages are used to 

represent the stages in the main job to which the container connects. 

For example, the following Server Job Diagram window shows two 

ODBC stages linked to a local container: 

The first ODBC stage links to a stage in the container, and is 

represented by a Container Input stage. A different stage in the 

container links to the second ODBC stage, which is represented by a 

Container Output stage. The container Diagram window includes the 

input and output stages required to link to the two ODBC stages. Note 

that the link names match those used for the links between the ODBC 

stages and the container in the main Diagram window.

The way in which the Container Input and Output stages are used 

depends on whether you construct a local container using existing 

stages and links or create a new one:
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If you construct a local container from an existing group of stages 
and links, the input and output stages are automatically added. 
The link between the input or output stage and the stage in the 
container has the same name as the link in the main job Diagram 
window.

If you create a new container, you must add stages to the 
container Diagram window between the input and output stages. 
Link the stages together and edit the link names to match the ones 
in the main Diagram window.

You can have any number of links into and out of a local container, all 

of the link names inside the container must match the link names into 

and out of it in the job. Once a connection is made, editing meta data 

on either side of the container edits the meta data on the connected 

stage in the job.

Deconstructing a Local Container
If required you can convert a local container back into a group of 

discrete stages and links in the job where it is used. You can do this 

regardless of whether you created it from a group in the first place. To 

deconstruct a local container, do one of the following:

Select the container stage in the Job Diagram window and choose 
Deconstruct from the shortcut menu.

Select the container stage in the Job Diagram window and choose 
Edit ➤ Deconstruct Container from the main menu.

DataStage prompts you to confirm the action (you can disable this 

prompt if required). Click OK and the constituent parts of the 

container appear in the Job Diagram window, with existing stages 

and links shifted to accommodate them.

If any name conflicts arise during the deconstruction process between 

stages from the container and existing ones, you are prompted for 

new names. You can click the Use Generated Names checkbox to 

have DataStage allocate new names automatically from then on. If the 

container has any unconnected links, these are discarded. Connected 

links remain connected.

Deconstructing a local container is not recursive. If the container you 

are deconstructing contains other containers, they move up a level 

but are not themselves deconstructed.
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Shared Containers
Server jobs
and
Parallel jobs

Shared containers also help you to simplify your design but, unlike 

local containers, they are reusable by other jobs. You can use shared 

containers to make common job components available throughout 

the project. You can create a shared container from a stage and 

associated meta data and add the shared container to the palette to 

make this pre-configured stage available to other jobs.

You can also insert a server shared container into a parallel job as a 

way of making server job functionality available. For example, you 

could use it to give the parallel job access to the functionality of a 

plug-in stage. (Note that you can only use server shared containers on 

SMP systems, not MPP or cluster systems.)

Shared containers comprise groups of stages and links and are stored 

in the Repository like DataStage jobs. When you insert a shared 

container into a job, DataStage places an instance of that container 

into the design. When you compile the job containing an instance of a 

shared container, the code for the container is included in the 

compiled job. You can use the DataStage debugger on instances of 

shared containers used within jobs.

When you add an instance of a shared container to a job, you will 

need to map meta data for the links into and out of the container, as 

these may vary in each job in which you use the shared container. If 

you change the contents of a shared container, you will need to 

recompile those jobs that use the container in order for the changes to 

take effect. For parallel shared containers, you can take advantage of 

runtime column propagation to avoid the need to map the meta data. 

If you enable runtime column propagation, then, when the jobs runs, 

meta data will be automatically propagated across the boundary 

between the shared container and the stage(s) to which it connects in 

the job (see "Runtime Column Propagation" in Parallel Job 

Developer’s Guide for a description).

Note that there is nothing inherently parallel about a parallel shared 

container - although the stages within it have parallel capability. The 

stages themselves determine how the shared container code will run. 

Conversely, when you include a server shared container in a parallel 

job, the server stages have no parallel capability, but the entire 

container can operate in parallel because the parallel job can execute 

multiple instances of it.

You can create a shared container from scratch, or place a set of 

existing stages and links within a shared container.

Note If you encounter a problem when running a job which uses 

a server shared container in a parallel job, you could try 
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increasing the value of the DSIPC_OPEN_TIMEOUT 

environment variable in the Parallel ➤ Operator specific 

category of the environment variable dialog box in the 

DataStage Administrator (see "Setting Environment 

Variables" in DataStage Administrator Guide).

Creating a Shared Container
To save an existing group of stages and links in a shared container:

1 Choose the stages and links by doing one of the following:

– Click and drag the mouse over all the stages you want in the 
container. 

– Select a stage. Press Shift and click the other stages and links 
you want to add to the container.

All the chosen stages are highlighted in the system highlight color. 

2 Choose Edit ➤ Construct Container ➤ Shared. You are 
prompted for a name for the container by the Create New dialog 
box. The group is replaced by a Shared Container stage of the 
appropriate type with the specified name in the Diagram window. 
You are warned if any link naming conflicts occur when the 
container is constructed. Any parameters occurring in the 
components are copied to the shared container as container 
parameters. The instance created has all its parameters assigned 
to corresponding job parameters.

To create an empty shared container, to which you can add stages and 

links, choose File ➤ New from the DataStage Designer menu. The 

New dialog box appears, choose the server Shared Container icon or 

parallel shared container icon as appropriate and click OK.
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A new Diagram window appears in the Designer, along with a Tool 

palette which has the same content as for server jobs or parallel jobs, 

depending on the type of shared container. You can now save the 

shared container and give it a name. This is exactly the same as 

saving a job (see "Saving a Job" on page 4-3).

Naming Shared Containers
The following rules apply to the names that you can give DataStage 

shared containers:

Container names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.

Shared category names can be any length and consist of any 

characters, including spaces.

Viewing or Modifying a Shared Container Definition
You can open a shared container for viewing or modifying by doing 

one of the following:

Select its icon in the Repository window and select Edit from the 
shortcut menu.

Drag its icon from the DataStage Designer Repository window to 
the diagram area.

Select its icon in the job design and select Open from the shortcut 
menu.

Choose File ➤ Open from the main menu and select the shared 
container from the Open dialog box.

A Diagram window appears, showing the contents of the shared 

container. You can edit the stages and links in a container in the same 

way you do for a job. 

Note The shared container is edited independently of any job in 

which it is used. Saving a job, for example, will not save any 

open shared containers used in that job.

Editing Shared Container Definition Properties
A shared container has properties in the same way that a job does. To 

edit the properties, ensure that the shared container diagram window 

is open and active and choose Edit ➤ Properties. If the shared 

container is not currently open, select it in the Repository window and 
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choose Properties from the shortcut menu. The Shared Container 
Properties dialog box appears. This has two pages, General and 

Parameters.

The General page is as follows:

Category. The category containing the shared container.

Version. The version number of the shared container. A version 
number has several components:

– The version number N.n.n. This number checks the 
compatibility of the shared container with the version of 
DataStage installed. This number is automatically set when 
DataStage is installed and cannot be edited.

– The bug fix number n.n.N. This number reflects minor changes 
to the shared container design or properties. To change this 
number, select it and enter a new value directly or use the 
arrow buttons to increase the number.

Enable Runtime Column Propagation for new links. This checkbox 
appears for parallel shared containers if you have selected Enable 
Runtime Column propagation for Parallel jobs for this project in 
the DataStage Administrator. Check it to enable runtime column 
propagation by default for all new links in this shared container 
(see "Runtime Column Propagation" in Parallel Job Developer’s 
Guide for a description).

Short Container Description. An optional brief description of 
the shared container.

Full Container Description. An optional detailed description of 
the shared container.
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Shared containers use parameters to ensure that the container is 

reusable in different jobs. Any properties of the container that are 

likely to change between jobs can be supplied by a parameter, and the 

actual value for that parameter specified in the job design. Container 

parameters can be used in the same places as job parameters, see 

"Using Job Parameters in Server Jobs" on page 4-58.

The Parameters page is as follows:

Parameter name. The name of the parameter.

Type. The type of the parameter.

Help text. The text that appears in the Job Container Stage editor 
to help the designer add a value for the parameter in a job design 
(see "Using a Shared Container in a Job" on page 5-9).

Using a Shared Container in a Job
You can insert a shared container into a job design by dragging its 

icon from the Shared Container branch in the Repository window to 

the job’s Diagram window. DataStage inserts an instance of that 

shared container into the job design. This is the same for both server 

jobs and parallel jobs.

The stages in the job that connect to the container are represented 

within the container by input and output stages, in the same way as 

described for local stages (see "Using Input and Output Stages" on 

page 5-3). Unlike on a local container, however, the links connecting 

job stages to the container are not expected to have the same name 

as the links within the container. 
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Once you have inserted the shared container, you need to edit its 

instance properties by doing one of the following:

Double-click the container stage in the Diagram window.

Select the container stage and choose Edit ➤ Properties… .

Select the container stage and choose Properties… from the 
shortcut menu.

The Shared Container Stage editor appears:

This is similar to a general stage editor, and has Stage, Inputs, and 

Outputs pages, each with subsidiary tabs.

Stage Page

Stage Name. The name of the instance of the shared container. 
You can edit this if required.

Shared Container Name. The name of the shared container of 
which this is an instance. You cannot change this.

The General tab enables you to add an optional description of the 

container instance.
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The Properties tab allows you to specify values for container 

parameters. You need to have defined some parameters in the shared 

container properties for this tab to appear.

Name. The name of the expected parameter.

Value. Enter a value for the parameter. You must enter values for 
all expected parameters here as the job does not prompt for these 
at run time. (You can leave string parameters blank, an empty 
string will be inferred.)

Insert Parameter. You can use a parameter from a parent job (or 
container) to supply a value for a container parameter. Click 
Insert Parameter to be offered a list of available parameters 
from which to choose.

The Advanced tab appears when you are using a server shared 

container within a parallel job. It has the same fields and functionality 
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as the Advanced tab on all parallel stage editors. See "Stage Editors" 

in Parallel Job Developer’s Guide for details.

Inputs Page

When inserted in a job, a shared container instance already has meta 

data defined for its various links. This meta data must match that on 

the link that the job uses to connect to the container exactly in all 

properties. The inputs page enables you to map meta data as 

required. The only exception to this is where you are using runtime 

column propagation (RCP) with a parallel shared container. If RCP is 

enabled for the job, and specifically for the stage whose output 

connects to the shared container input, then meta data will be 

propagated at run time, so there is no need to map it at design time.

In all other cases, in order to match, the meta data on the links being 

matched must have the same number of columns, with corresponding 

properties for each.

The Inputs page for a server shared container has an Input field and 

two tabs, General and Columns. The Inputs page for a parallel 

shared container, or a server shared container used in a parallel job, 

has an additional tab: Partitioning.

Input. Choose the input link to the container that you want to 
map.
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The General page is as follows:

Map to Container Link. Choose the link within the shared 
container to which the incoming job link will be mapped. 
Changing the link triggers a validation process, and you will be 
warned if the meta data does not match and are offered the option 
of reconciling the meta data as described below.

Validate. Click this to request validation of the meta data on the 
two links. You are warned if validation fails and given the option of 
reconciling the meta data. If you choose to reconcile, the meta 
data on the container link replaces that on the job link. Surplus 
columns on the job link are removed. Job link columns that have 
the same name but different properties as a container column will 
have the properties overwritten, but derivation information 
preserved.

Note You can use a Transformer stage within the job to manually 

map data between a job stage and the container stage in 

order to supply the meta data that the container requires.

Description. Optional description of the job input link.

The Columns page shows the meta data defined for the job stage link 

in a standard grid. You can use the Reconcile option on the Load 
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button to overwrite meta data on the job stage link with the container 

link meta data in the same way as described for the Validate option.

The Partitioning tab appears for parallel shared containers and 

when you are using a server shared container within a parallel job. It 

has the same fields and functionality as the Partitioning tab on all 

parallel stage editors. See "Stage Editors" in Parallel Job Developer’s 

Guide for details.
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Outputs Page

The Outputs page enables you to map meta data between a 

container link and the job link which connects to the container on the 

output side. It has an Outputs field and a General tab and Columns 

tab which perform equivalent functions as described for the Inputs 

page.

The columns tab for parallel shared containers has a Runtime 
column propagation check box. This is visible provided RCP is 

enabled for the job. It shows whether RCP is switched on or off for the 

link the container link is mapped onto. This removes the need to map 

the meta data.

Pre-configured Components
You can use shared containers to make pre-configured stages 

available to other jobs.

To do this:

1 Select a stage and relevant input/output link (you need the link too 
in order to retain meta data). 

2 Choose Copy from the shortcut menu, or select Edit ➤ Copy.

3 Select Edit ➤ Paste special ➤ Into new shared container… . 
The Paste Special into new Shared Container dialog box 
appears (see page 4-36).

4 Choose to create an entry for this container in the palette (the 
dialog will do this by default). 

To use the pre-configured component, select the shared container in 

the palette and Ctrl+drag it onto canvas. This deconstructs the 

container so the stage and link appear on the canvas.

Converting Containers
Server jobs and 
Parallel jobs

You can convert local containers to shared containers and vice versa.

By converting a local container to a shared one you can make the 

functionality available to all jobs in the project.

You may want to convert a shared container to a local one if you want 

to slightly modify its functionality within a job. You can also convert a 

shared container to a local container and then deconstruct it into its 

constituent parts as described in "Deconstructing a Local Container" 

on page 5-4.
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To convert a container, select its stage icon in the job Diagram window 

and do one of the following:

Choose Convert from the shortcut menu.

Choose Edit ➤ Convert Container from the main menu.

DataStage prompts you to confirm the conversion.

Containers nested within the container you are converting are not 

affected.

When converting from shared to local, you are warned if link name 

conflicts occur and given a chance to resolve them. 

A shared container cannot be converted to a local container if it has a 

parameter with the same name as a parameter in the parent job (or 

container) which is not derived from the parent’s corresponding 

parameter. You are warned if this occurs and must resolve the conflict 

before the container can be converted.

Note Converting a shared container instance to a local container 

has no affect on the original shared container.
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Job Sequences

Server jobs
and 
Parallel jobs

DataStage provides a graphical Job Sequencer which allows you to 

specify a sequence of server jobs or parallel jobs to run. The sequence 

can also contain control information; for example, you can specify 

different courses of action to take depending on whether a job in the 

sequence succeeds or fails. Once you have defined a job sequence, it 

can be scheduled and run using the DataStage Director. It appears in 

the DataStage Repository and in the DataStage Director client as a job.

Note This tool is provided in addition to the batch job facilities of 

the DataStage Director and the job control routine facilities 

of the DataStage Designer.

Designing a job sequence is similar to designing a job. You create the 

job sequence in the DataStage Designer, add activities (as opposed to 

stages) from the tool palette, and join these together with triggers (as 

opposed to links) to define control flow.

Each activity has properties that can be tested in trigger expressions 

and passed to other activities further on in the sequence. Activities 

can also have parameters, which are used to supply job parameters 

and routine arguments.

The job sequence itself has properties, and can have parameters, 

which can be passed to the activities it is sequencing.

The sample job sequence shows a sequence that will run the job 

Demo. If demo runs successfully, the Success trigger causes the 

Job Sequence
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Overnightrun1 job to run. If demo fails, the Failure trigger causes the 

Failure job to run.

Job sequences are optionally restartable. If you run a restartable 

sequence and one of the jobs fails to finish correctly, you can fix the 

problem, then re-run the sequence from the point at which it left off.

The sequence records checkpoint information to enable it to do this. 

Checkpoint information enables DataStage to restart the sequence in a 

sensible way. You can enable or disable checkpointing at a project-

wide level, or for individual job sequences. If you have checkpointing 

enabled for a job, you can specify that individual components within a 

sequence are not checkpointed, forcing them to be re-executed 

whenever the sequence is restarted regardless of whether they were 

executed successfully before.

You can also specify that the sequence automatically handles any 

errors it encounters when executing jobs. This means you do not have 

to specify an error handling trigger for every job in the sequence. This 

can also be enabled on a project-wide basis, or for individual job 

sequences.
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Creating a Job Sequence
To create a job sequence, choose File ➤ New from the DataStage 

Designer menu. The New dialog box appears, choose the job 

sequencer icon and click OK.

The Diagram window appears, in the right pane of the Designer, along 

with the Tool palette for job sequences. You can now save the job 

sequence and give it a name. This is exactly the same as saving a job 

(see "Saving a Job" on page 4-3).

You create a job sequence by:
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1 Placing the stages representing the activities in your sequence on 
the canvas.

2 Linking the stages together.

3 Specifying properties details for each activity, defining what it 
does.

4 Specifying trigger information for each activity specifying what 
action is taken on success or failure of the activity.

You can open an existing job sequence in the same way you would 

open an existing job (see "Opening an Existing Job" on page 4-2).

Naming Job Sequences
The following rules apply to the names that you can give DataStage 

job sequences:

Job sequence names can be any length up to 700 characters.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.

Activity Stages
The job sequence supports the following types of activity:

Job. Specifies a DataStage server or parallel job.

Routine. Specifies a routine. This can be any routine in the 
DataStage Repository (but not transforms).

ExecCommand. Specifies an operating system command to 
execute.

Email Notification. Specifies that an email notification should 
be sent at this point of the sequence (uses SMTP).

Wait-for-file. Waits for a specified file to appear or disappear.

Exception Handler. There can only be one of these in a job 
sequence. It is executed if a job in the sequence fails to run (other 
exceptions are handled by triggers) or if the job aborts and the 
Automatically handle job runs that fail option is set for that 
job.
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Nested Conditions. Allows you to further branch the execution 
of a sequence depending on a condition. 

Sequencer. Allows you to synchronize the control flow of 
multiple activities in a job sequence. 

Terminator. Allows you to specify that, if certain situations occur, 
the jobs a sequence is running shut down cleanly.

Start Loop and End Loop. Together these two stages allow you 
to implement a For…Next or For…Each loop within your 
sequence.

User Variable. Allows you to define variables within a sequence. 
These variables can then be used later on in the sequence, for 
example to set job parameters.

The activity stages are controlled by the setting of their properties (see 

page 6-14).

To add an activity to your job sequence, drag the corresponding icon 

from the tool palette and drop it on the Diagram window. 

You can also add particular jobs or routines to the design as activities 

by dragging the icon representing that job or routine from the 

DataStage Designer’s Repository window and dropping it in the 

Diagram window. The job or routine appears as an activity in the 

Diagram window.

Activities can be named, moved, and deleted in the same way as 

stages in an ordinary server or parallel job (see Chapter 4, 

"Developing a Job.")

Triggers
The control flow in the sequence is dictated by how you interconnect 

activity icons with triggers. 

To add a trigger, select the trigger icon in the tool palette, click the 

source activity in the Diagram window, then click the target activity. 

Triggers can be named, moved, and deleted in the same way as links 

in an ordinary server or parallel job (see Chapter 4, "Developing a 

Job."). Other trigger features are specified by editing the properties of 

their source activity.

Activities can only have one input trigger, but can have multiple 

output triggers. Trigger names must be unique for each activity. For 

example, you could have several triggers called “success” in a job 

sequence, but each activity can only have one trigger called “success”.
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There are three types of trigger:

Conditional. A conditional trigger fires the target activity if the 
source activity fulfills the specified condition. The condition is 
defined by an expression, and can be one of the following types:

– OK. Activity succeeds.

– Failed. Activity fails.

– Warnings. Activity produced warnings.

– ReturnValue. A routine or command has returned a value.

– Custom. Allows you to define a custom expression.

– User status. Allows you to define a custom status message to 
write to the log.

Unconditional. An unconditional trigger fires the target activity 
once the source activity completes, regardless of what other 
triggers are fired from the same activity.

Otherwise. An otherwise trigger is used as a default where a 
source activity has multiple output triggers, but none of the 
conditional ones have fired.

Different activities can output different types of trigger:

Activity Type Trigger Type

Wait-for-file, 
ExecuteCommand

Unconditional
Otherwise
Conditional - OK
Conditional - Failed
Conditional - Custom
Conditional - ReturnValue

Routine Unconditional
Otherwise
Conditional - OK
Conditional - Failed
Conditional - Custom
Conditional - ReturnValue

Job Unconditional
Otherwise
Conditional - OK
Conditional - Failed
Conditional - Warnings
Conditional - Custom
Conditional - UserStatus

Nested condition Unconditional
Otherwise
Conditional - Custom
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Note If a job fails to run, for example because it was in the 

aborted state when due to run, this will not fire a trigger. 

Job activities can only fire triggers if they run. Non-running 

jobs can be handled by exception activities, or by choosing 

an execution action of reset then run rather than just run 

for jobs (see page 6-18).

Expressions
You can enter expressions at various places in a job sequence to set 

values. Where you can enter expressions, the Expression Editor is 

available to help you and to validate your expression. The expression 

syntax is a subset of that available in a server job Transformer stage 

or parallel job BASIC Transformer stage, and comprises:

Literal strings enclosed in double-quotes or single-quotes.

Numeric constants (integer and floating point).

The sequence's own job parameters. 

Prior activity variables (e.g., job exit status).

All built-in BASIC functions as available in a server job.

Certain macros and constants as available in a server or parallel 
job:

– DSHostName

– DSJobController

– DSJobInvocationId

– DSJobName

– DSJobStartDate

– DSJobStartTime

– DSJobStartTimestamp

– DSJobWaveNo

– DSProjectName

DS constants as available in server jobs.

Run-activity-on-
exception, Sequencer, 
Email notification, Start 
Loop, End Loop

Unconditional

Activity Type Trigger Type
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Arithmetic operators: + - * / ** ^

Relational operators: > < = # <> >= =< etc.

Logical operators (AND OR NOT) plus usual bracketing 
conventions.

The ternary IF … THEN … ELSE operator.

Note When you enter valid variable names (for example a job 

parameter name or job exit status) in an expression, you 

should not delimit them with the hash symbol (#) as you do 

in other fields in sequence activity properties.

For a full description of DataStage expression format, see "The 

DataStage Expression Editor" in Server Job Developer’s Guide.

Job Sequence Properties
To edit the properties of a job sequence, open its Diagram window 

and choose Edit ➤ Job Properties. The Properties dialog box 

appears, it has four pages; General, Parameters, Job Control, and 

Dependencies.

General Page
The General page is as follows:

The General page contains:

Category. The job category containing the job sequence.
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Version number. The version number of the job sequence. A 
version number has several components:

– The version number N.n.n. This number checks the 
compatibility of the job with the version of DataStage installed. 
This number is automatically set when DataStage is installed 
and cannot be edited.

– The release number n.N.n. This number is automatically 
incremented every time you release a job sequence. (You can 
release a job sequence in the same way as you release a job.)

– The bug fix number n.n.N. This number reflects minor changes 
to the job sequence design or properties. To change this 
number, select it and enter a new value directly or use the 
arrow buttons to increase the number.

Allow Multiple Instance. Select this to enable the DataStage 
Director to run multiple instances of this job sequence.

The compilation options specify details about restarting the sequence 

if one of the jobs fails for some reason.

Add checkpoints so sequence is restartable on failure. 
Select this to enable restarting for this job sequence. If you have 
enabled this feature on a project-wide basis in the DataStage 
Administrator, this check box is selected by default when the 
sequence is first created.

Automatically handle job runs that fail. Select this to have 
DataStage automatically handle failing jobs within a sequence 
(this means that you do not have to have a specific trigger for job 
failure). When you select this option, the following happens 
during job sequence compilation:

– For each job activity that does not have a specific trigger for 
error handling, code is inserted that branches to an error 
handling point. (If an activity has either a specific failure 
trigger, or if it has an OK trigger and an otherwise trigger, it is 
judged to be handling its own aborts, so no code is inserted.)

If the compiler has inserted error-handling code the following 

happens if a job within the sequence fails:

– A warning is logged in the sequence log about the job not 
finishing OK.

– If the job sequence has an exception handler defined, the code 
will go to it.

– If there is no exception handler, the sequence aborts with a 
suitable message.
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If you have enabled this feature on a project-wide basis in the 

DataStage Administrator, this check box is selected by default 

when the sequence is first created.

Note that, when using this feature, you should avoid using any 

routines within the job sequence that return any value other than 

0 to indicate success, as non-zero values will always be taken as 

indicating failure (all routines supplied with DataStage return 0).

Log warnings after activities that finish with status other 
than OK. Select this to have the sequence log a message in the 
sequence log if it runs a job that finished with a non-zero 
completion code (for example, warnings or fatal errors). Messages 
are also logged for routine or command activities that fail (i.e., 
return a non-zero completion code).

Log report messages after each job run. Select this to have 
the sequence log a status report for a job immediately the job run 
finishes. The following is an example of the information that will 
be logged:

**************************************************
STATUS REPORT FOR JOB: jobname
Generated: 2003-10-31 16:13:09
Job start time=2003-10-31 16:13:07
Job end time=2003-10-31 16:13:07
Job elapsed time=00:00:00
Job status=1 (Finished OK)

Stage: stagename1, 10000 rows input 
Stage start time=2003-10-31 16:17:27, end time=2003
-10-31 16:17:27, elapsed=00:00:00

Link: linkname1, 10000 rows
Stage: stagename2, 10000 rows input
Stage start time=2003-10-31 16:17:28, end time=2003
-10-31 16:17:28, elapsed=00:00:00

Link: linkname2, 10000 rows
Link: linkname3, 10000 rows

Short Description. An optional brief description of the job 
sequence.

Full Description. An optional detailed description of the job 
sequence.
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Parameters Page
The Parameters page is as follows:

The Parameters page allows you to specify parameters for the job 

sequence. Values for the parameters are collected when the job 

sequence is run in the Director. The parameters you define here are 

available to all the activities in the job sequence, so where you are 

sequencing jobs that have parameters, you need to make these 

parameters visible here. For example, if you were scheduling three 

jobs, each of which expected a file name to be provided at run time, 

you would specify three parameters here, calling them, for example, 

filename1, filename2, and filename 3. You would then edit the Job 

page of each of these job activities in your sequence to map the job’s 

filename parameter onto filename1, filename2, or filename3 as 

appropriate (see "Job Activity Properties" on page 6-18). When you 

run the job sequence, the Job Run Options dialog box appears, 

prompting you to enter values for filename1, filename2, and 

filename3. The appropriate filename is then passed to each job as it 

runs. 

You can also set environment variables at run time, the settings only 

take effect at run time, they do not affect the permanent settings of 

environment variables. To set a runtime value for an environment 

variable:
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1 Click Add Environment Variable… at the bottom of the 
Parameters page. The Choose environment variable list 
appears.

This shows a list of the available environment variables (the 

example shows parallel job environment variables).

2 Click on the environment variable you want to override at runtime. 
It appears in the parameter grid, distinguished from job 
parameters by being preceded by a $. 

You can also click New… at the top of the list to define a new 

environment variable. A dialog box appears allowing you to 

specify name and prompt. The new variable is added to the 

Choose environment variable list and you can click on it to add 

it to the parameters grid.

3 Set the required value in the Default Value column. This is the 
only field you can edit for an environment variable. Depending on 
the type of variable a further dialog box may appear to help you 
enter a value.

The Parameters grid has the following columns:

Parameter name. The name of the parameter.

Prompt. Text used as the field name in the run-time dialog box.

Type. The type of the parameter (to enable validation).
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Default Value. The default setting for the parameter. 

Help text. The text that appears if a user clicks Property Help in 
the Job Run Options dialog box when running the job sequence.

You can refer to the parameters in the job sequence by name. When 

you are entering an expression, you just enter the name directly. 

Where you are entering a parameter name in an ordinary single-line 

text box, you need to delimit the name with hash symbols, for 

example: #dayofweek#. 

Job Control Page
The Job Control page displays the code generated when the job 

sequence is compiled.

Dependencies Page
The Dependencies page is as follows:

The Dependencies page of the Properties dialog box shows you 

the dependencies the job sequence has. These may be functions, 

routines, or jobs that the job sequence runs. Listing the dependencies 

of the job sequence here ensures that, if the job sequence is packaged 

for use on another system, all the required components will be 

included in the package.

The details as follows:

Type. The type of item upon which the job sequence depends:
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– Job. Released or unreleased job. If you have added a job to the 
sequence, this will automatically be included in the 
dependencies. If you subsequently delete the job from the 
sequence, you must remove it from the dependencies list 
manually.

– Local. Locally cataloged BASIC functions and subroutines (i.e., 
Transforms and Before/After routines).

– Global. Globally cataloged BASIC functions and subroutines 
(i.e., Custom UniVerse functions).

– File. A standard file.

– ActiveX. An ActiveX (OLE) object (not available on UNIX-
based systems).

Name. The name of the function or routine. The name required 
varies according to the Type of the dependency:

– Job. The name of a released, or unreleased, job. 

– Local. The catalog name. 

– Global. The catalog name.

– File. The file name.

– ActiveX. The Name entry is actually irrelevant for ActiveX 
objects. Enter something meaningful to you (ActiveX objects 
are identified by the Location field).

Location. The location of the dependency. A browse dialog box is 
available to help with this. This location can be an absolute path, 
but it is recommended you specify a relative path using the 
following environment variables:

– %SERVERENGINE% – DataStage engine account directory 
(normally C:\Ascential\DataStage\ServerEngine).

– %PROJECT% – Current project directory.

– %SYSTEM% – System directory on Windows or /usr/lib on 
UNIX.

Activity Properties
When you have outlined your basic design by adding activities and 

triggers to the diagram window, you fill in the details by editing the 

properties of the activities. To edit an activity, do one of the following:

Double-click the activity in the Diagram window.

Select the activity and choose Properties… from the shortcut 
menu.
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Select the activity and choose Edit ➤ Properties.

The format of the Properties dialog box depends on the type of 

activity. All have a General page, however, and any activities with 

output triggers have a Triggers page.

The General page is as follows:.

The General page contains:

Name. The name of the activity, you can edit the name here if 
required.

Description. An optional description of the activity.

Logging text. The text that will be written to the Director log 
when this activity is about to run.
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The Triggers page is as follows:

The Triggers page contains:

Name. The name of the output trigger.

Expression Type. The type of expression attached to the trigger. 
Choose a type from the drop-down list (see "Triggers" on page 6-5 
for an explanation of the different types).

Expression. The expression associated with the trigger. For most 
predefined conditions, this is fixed and you cannot edit it. For 
Custom conditions you can enter an expression (see 
"Expressions" on page 6-7), and for UserStatus conditions you can 
enter a text message.

You can use variables when defining trigger expressions for Custom 

and ReturnValue conditional triggers. The rules are given in the 

following table:

Activity Type Variable Use

Job stage_label.$ExitStatus

stage_label.$UserStatus
stage_label.$JobName

Value of job completion status
Value of job’s user status
Name of job actually run, including 
invocation id, if present.

ExecCommand stage_label.$ReturnValue
stage_label.$CommandName

stage_label.$CommandOutput

Command status
Name of command executed (including 
path name if one was specified)
Output captured by executing the 
command
6-16 Designer Guide



Job Sequences Activity Properties
stage_label is name of the activity stage as given in the Diagram 

window. You can also use the job parameters from the job sequence 

itself. 

Custom conditional triggers in Nested condition and Sequencer 

activities can use any of the variable in the above table used by the 

activities connected to them.

The specific pages for particular activities are described in the 

following sections.

Routine stage_label.$ReturnValue

stage_label.$RoutineName

Value of routine’s return code
Name of routine called

Wait-for-File stage_label.$ReturnValue Value returned by DSWaitForFile before/
after subroutine

Exception Handler 
(these are available 
for use in the 
sequence of 
activities the stage 
initiates, not the 
stage itself)

stage_label.$ErrSource.

stage_label.$ErrNumber.

stage_label.$ErrMessage. 

The stage label of the activity stage that 
raised the exception (for example, the job 
activity stage calling a job that failed to 
run).

Indicates the reason the Exception 
Handler activity was invoked, and is one 
of:

1. Activity ran a job but it aborted, and 
there was no specific handler set up.

-1. Job failed to run for some reason.

The text of the message that will be 
logged as a warning when the exception 
is raised.

Activity Type Variable Use
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Job Activity Properties
In addition to the General and Triggers pages, The Properties 

dialog box for a job activity contains a Job page.

The Job page contains:

Job name. Allows you to specify the name of the job the activity 
is to run. You can select a job by browsing the Repository. If you 
have added the activity by dragging a job from the Repository 
window, the Job name will already be filled in.

Invocation ID Expression. This only appears if the job identified 
by Job Name has Allow Multiple Instance enabled. Enter a 
name for the invocation or a job parameter allowing the instance 
name to be supplied at run time. A job parameter name needs to 
be delimited by hashes (#). You can also click the browse button to 
be presented with a list of available job parameters you could use. 
You cannot leave this field blank. 

Execution Action. Allows you to specify what the activity will do 
with the job. Choose one of the following from the drop-down list:

– Run (the default)

– Reset if required then run

– Validate only

– Reset only
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Do not checkpoint job run. Set this to specify that DataStage 
does not record checkpoint information for this particular job. This 
means that, if another job later in the sequence fails, and the 
sequence is restarted, this job will be rerun regardless of the fact 
that it finished successfully before. This option is only visible if the 
sequence as a whole is checkpointed.

Parameters. Allows you to provide values for any parameters 
that the job requires. The grid displays all the parameters 
expected by the job. You can:

– Type in an expression giving a value for the parameter in the 
Value Expression column. Literal values must be enclosed in 
inverted commas. (For details about expressions, see 
"Expressions" on page 6-7.)

– Select a parameter and click Insert Parameter Value to use 
another parameter or argument in the sequence to provide the 
value. A dialog box appears displaying a tree of all the 
available parameters and arguments occurring in the sequence 
before the current activity, This includes parameters that you 
have defined for the job sequence itself in the Job Sequence 
Properties dialog box (see "Job Sequence Properties" on 
page 6-8). Choose the required parameter or argument and 
click OK. You can use this feature to determine control flow 
through the sequence. 

– Click Clear to clear the value expression from the selected 
parameter.

– Click Clear All to clear the expression values from all 
parameters.

– Select a parameter and click Set to Default to enter the 
default for that parameter as defined in the job itself.

– Click All to Default to set all the parameters to their default 
values.

When you select the icon representing a job activity, you can choose 

Open Job from the shortcut menu to open the job in the Designer 

ready for editing.
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Routine Activity Properties
In addition to the General and Triggers pages, the Properties dialog 

box for a routine activity contains a Routine page.

The Routine page contains:

Routine name. Allows you to specify the name of the routine the 
activity is to execute. You can select a routine by browsing the 
Repository. If you have added the activity by dragging a routine 
from the Repository window, the Routine name will already be 
filled in.

Do not checkpoint routine. Set this to specify that DataStage 
does not record checkpoint information for the execution of this 
particular routine. This means that, if a job later in the sequence 
fails, and the sequence is restarted, this routine will be re-
executed regardless of the fact that it was executed successfully 
before. This option is only visible if the sequence as a whole is 
checkpointed.

Arguments. Allows you to provide values for any arguments that 
the routine requires. The grid displays all the arguments expected 
by the routine. You can:

– Type in an expression giving the value for the argument in the 
Value Expression column. Literal values must be enclosed in 
inverted commas. (For details about expressions, see 
"Expressions" on page 6-7.)

– Click Clear to clear the value expression from the selected 
parameter.
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– Click Clear All to clear the expression values from all 
parameters.

– Select an argument and click Insert Parameter Value to use 
another parameter or argument in the sequence to provide the 
value. A dialog box appears displaying a tree of all the 
available parameters and arguments occurring in the sequence 
before the current activity. Choose the required parameter or 
argument and click OK. You can use this feature to determine 
control flow through the sequence.

You can access routine arguments in the activity triggers in the form 

routinename.argname. Such arguments can be also be accessed by 

other activities that occur subsequently in the job sequence. This is 

most useful for accessing an output argument of a routine, but note 

that BASIC makes no distinction between input and output 

arguments, it is up to you to establish which is which.

When you select the icon representing a routine activity, you can 

choose Open Routine from the shortcut menu to open the Routine 

dialog box for that routine ready to edit.

Email Notification Activity Properties
Besides a General page, the properties dialog box has a 

Notification page. An email notification activity can only have a 

single unconditional output trigger, so does not require a Triggers 

page.

There is an underlying email template file which dictates the format of 

the notification email sent. This is called dssendmail_template.txt and 

there is a copy in every project directory (e.g., 

c:\Ascential\DataStage\projects\myproject). This allows you to have 

different notification email formats for different projects. The template 

file is self- explanatory and you can edit it if required. 

The fields in the Notifications page correspond to the tokens in the 

template file. If your particular template does not use a particular field, 

then setting it in the Notification page has no effect. For example, 

UNIX systems generally require you to specify a Senders email 

address whereas Windows systems do not. So specifying this field 
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may be mandatory in a UNIX system, but have no effect in a Windows 

system.

The Notification page contains:

SMTP Mail server name. The name of the server or its IP 
address.

Senders email address. Given in the form 
bill.gamsworth@paddock.com.

Recipients email address. The address the email is to be sent 
to, given in the form bill.gamsworth@paddock.com.

Email subject. The text to appear as the email subject.

For all the above, you can specify a parameter whose value will be 

specified at run time. Click the Browse button to open the External 
Parameter Helper, which shows you all parameters available at this 

point in the job sequence. Parameters entered in these fields need to 

be delimited with hashes (#). Parameters selected from the External 
Parameter Helper will automatically be enclosed in hash symbols.

Attachments. Files to be sent with the email. Specify a path 
name, or a comma-separated list of pathnames (in the latter case 
this should be contained in single-quotes or double-quotes). You 
can also specify an expression that resolves to a pathname or 
comma-separated pathnames. The Arrow button offers you the 
choice of browsing for a file or inserting a job parameter whose 
value will be supplied at run time.
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Again, parameters entered in these fields need to be delimited with 

hashes (#). Parameters selected from the External Parameter 
Helper will automatically be enclosed in hash symbols.

Email body. The actual message to be sent. (Do not enclose the 
message in inverted commas unless you want them to be part of 
the message.)

Include job status in email. Select this to include available job 
status information in the message. This includes a message 
similar to the example shown on page 6-10.

Do not checkpoint notification. Set this to specify that 
DataStage does not record checkpoint information for this 
particular notification operation. This means that, if a job later in 
the sequence fails, and the sequence is restarted, this notification 
operation will be re-executed regardless of the fact that it was 
executed successfully before. This option is only visible if the 
sequence as a whole is checkpointed.

Wait-For-File Activity Properties
In addition to the General and Triggers pages, The Properties 

dialog box for a wait-for-file activity contains a Wait For File page.

The Wait For File page contains:

Filename. The full pathname of the file that the activity is to wait 
for. The Arrow button offer you the choice of browsing for a file or 
inserting a job parameter whose value will be supplied at run 
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time. For a job parameter, you can click the Browse button to open 
the External Parameter Helper, which shows you all 
parameters available at this point in the job sequence. Parameters 
entered in this field needs to be delimited with hashes (#). 
Parameters selected from the External Parameter Helper will 
automatically be enclosed in hash symbols.

Wait for file to appear. Select this if the activity is to wait for the 
specified file to appear.

Wait for file to disappear. Select this if the activity is to wait for 
the specified file to disappear.

Timeout Length (hh:mm:ss). The amount of time to wait for the 
file to appear or disappear before the activity times out and 
completes.

Do not timeout. Select this to specify that the activity should not 
timeout, i.e, it will wait for the file forever.

Do not checkpoint run. Set this to specify that DataStage does 
not record checkpoint information for this particular wait-for-file 
operation. This means that, if a job later in the sequence fails, and 
the sequence is restarted, this wait-for-file operation will be re-
executed regardless of the fact that it was executed successfully 
before. This option is only visible if the sequence as a whole is 
checkpointed.
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ExecCommand Activity Properties
In addition to the General and Triggers pages, The Properties 

dialog box for a ExecCommand activity contains an ExecCommand 
page.

The ExecCommand page contains:

Command. The full pathname of the command to execute. This 
can be an operating system command, a batch command file, or 
an executable. You can browse for a command.

Parameters. Allows you to pass parameters to the command. 
These should be entered in the format that the command expects 
them. You can also supply a parameter whose value is supplied at 
run time. For this, you can click the Browse button to open the 
External Parameter Helper, which shows you all parameters 
available at this point in the job sequence. Parameters entered in 
this field needs to be delimited with hashes (#). Parameters 
selected from the External Parameter Helper will automatically 
be enclosed in hash symbols.

Do not checkpoint run. Set this to specify that DataStage does 
not record checkpoint information for the execution of this 
particular command. This means that, if a job later in the 
sequence fails, and the sequence is restarted, this command will 
be re-executed regardless of the fact that it was executed 
successfully before. This option is only visible if the sequence as a 
whole is checkpointed.
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Exception Activity Properties
An exception activity handles the situation where a job in the 

sequence fails to run (other exceptions in the job sequence are 

handled by triggers). 

An exception activity can only have a single unconditional output 

trigger, so does not require a Triggers page. It has no input triggers. It 

serves as a starting point for a sequence of activities to run if an 

exception has occurred somewhere in the main sequence. Its 

Properties dialog box contains only a General page.

There are some exception handler variables that can be used in the 

sequence of activities that the Exception Activity stage initiates. These 

are:

stage_label.$ErrSource. This is the stage label of the activity stage 
that raised the exception (for example, the job activity stage 
calling a job that failed to run).

stage_label.$ErrNumber. Indicates the reason the Exception 
Handler activity was invoked, and is one of:

– 1. Activity ran a job but it aborted, and there was no specific 
handler set up.

– -1. Job failed to run for some reason.

stage_label.$ErrMessage. The text of the message that will be 
logged as a warning when the exception is raised.

Nested Condition Activity Properties
The nested conditions Properties dialog box comprises a General 
page and a Triggers page. A nested condition allows you to further 

branch the execution of a sequence depending on a condition. For 

example, you could use a nested condition to implement the 

following control sequence:

Load/init jobA
Run jobA
If ExitStatus of jobA = OK then /*tested by trigger*/

If Today = “Wednesday” then /*tested by nested condition*/
run jobW

If Today = “Saturday” then
run jobS

Else
run JobB

Each nested condition can have one input trigger and will normally 

have multiple output triggers. The conditions governing the output 

triggers are specified in the Triggers page as described under 

"Triggers" on page 6-5.
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The section of the job sequence implementing this nested condition 

might appear as follows:

The triggers for the WhichJob Nested Condition activity stage would 

be:

(In this case DayCommand$CommandOutput refers to the value 

returned by a command that returns today’s day and is executed by an 

ExecCommand activity called DayCommand.)

Sequencer Activity Properties
In addition to the General and Triggers pages, the Properties dialog 

box for a Sequencer control contains a Sequencer page.

A sequencer allows you to synchronize the control flow of multiple 

activities in a job sequence. It can have multiple input triggers as well 

as multiple output triggers.

The sequencer operates in two modes:

ALL mode. In this mode all of the inputs to the sequencer must 
be TRUE for any of the sequencer outputs to fire.

ANY mode. In this mode, output triggers can be fired if any of the 
sequencer inputs are TRUE.
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.

The Sequencer page contains:

Mode. Choose All or Any to select the mode of operation.

You can also change the mode by selecting the activity and using the 

shortcut menu. The sequencer has a slightly different icon depending 
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on whether All or Any mode is operational as shown in the examples 

below:

Examples of Using Sequencer Stage

The following is a job sequence that synchronizes the running of a job 

to the successful completion of three other jobs. The sequencer mode 

is set to All. When job1, job2, and job3 have all finished successfully, 
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the sequencer will start jobfinal (if any of the jobs fail, the 

corresponding terminator stage will end the job sequence).

The following is section of a similar job sequence, but this time the 

sequencer mode is set to Any. When any one of the Wait_For_File, job 

activity or routine activity stages complete successfully, 

Job_Activity_4 will be started.

Terminator Activity Properties
The Terminator Properties dialog box has a General page and 

Terminator page. It cannot have output links, and so has no Triggers 

page. The stage can have one input.
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A terminator stage can be placed in a job sequence to ensure that the 

sequence is stopped cleanly if certain situations arise. You can have 

multiple Terminator activities and can place them anywhere in the 

sequence. They are connected to other stages by triggers, which 

specify when a terminator will be invoked.

The terminator stage allows you to specify that stop requests be sent 

to all running jobs in the sequence (and optionally have the 

terminator wait for all jobs to finish), or that the sequence is aborted 

without sending stop requests. If you specify some final message text, 

this will be used as the text for the sequence abort message (this is in 

addition to the logging text on the General page, which is output 

when the activity starts). Do not enclose the message in inverted 

commas unless you want them to be part of the message.

Start Loop Activity Properties
In addition to the General and Triggers pages, the Properties dialog 

box for a Start Loop activity contains a Start Loop page.

The Start Loop stage marks the beginning of the loop and defines it. 

You can have a numeric loop (where you define a counter, a limit, and 

an increment value), or a List loop (where you perform the loop once 

for each item in a list). You can pass the current value of the counter as 

a parameter into the stages within your loop in the form 

stage_label.$Counter, where stage_label is the name of the Start Loop 

activity stage as given in the Diagram window. You mark the end of a 
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loop with an End Loop Activity stage, which has a link drawn back to 

its corresponding Start Loop stage.

You can nest loops if required.

You define the loop setting in the Start Loop page. Here is an 

example of a numeric loop:.

The page contains:

Loop type. Choose Numeric to implement a For…Next type 
loop, or List to implement a For…Each type loop.

When you choose Numeric, the page contains the following fields:

From. The initialization value for the counter.

Step. The increment value for the counter.

To. The final counter value.

You can use parameters for any of these, and specify actual values at 

run time. You can click the Browse button to open the External 
Parameter Helper, which shows you all parameters available at this 

point in the job sequence. Parameters entered in this field needs to be 

delimited with hashes (#). Parameters selected from the External 
Parameter Helper will automatically be enclosed in hash symbols.
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When you choose List, the page has different fields, as shown below:

Delimited values. Enter your list with each item separated by the 
selected delimiter.

Delimiter. Specify the delimiter that will separate your list items. 
Choose from:

– Comma (the default)

– Space

– Other (enter the required character in the text field)
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Examples of Using Loop Stages

The following is a section of a job sequence that makes repeated 

attempts to run a job until either it succeeds, or until the loop limit is 

reached. The job depends on network link that is not always available.

The Start Loop stage, networkloop, has Numeric loop selected and the 

properties are set as follows:

This defines that the loop will be run through up to 1440 times. The 

action differs according to whether the job succeeds or fails:

If it fails, the routine waitabit is called. This implements a 60 
second wait time. If the job continually fails, the loop repeats 1440 
times, giving a total of 24 hours of retries. After the 1440th 
attempt, the End Loop stages passes control onto the next activity 
in the sequence. 

If it succeeds, control is passed to the notification stage, 
emailsuccess, and the loop is effectively exited.
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The following is a section of a job sequence that makes use of the 

loop stages to run a job repeatedly to process results for different 

days of the week:

The Start Loop stage, dayloop, has List loop selected and properties 

are set as follows:

The Job Activity stage, processresults, properties are:

The job processresults will run five times, for each iteration of the 

loop the job is passed a day of the week as a parameter in the order 
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monday, tuesday, wednesday, thursday, friday. The loop is then exited 

and control passed to the next activity in the sequence.

End Loop Activity Properties
The end loop stage marks the end of the loop. All the stages in 

between the Start Loop and End Loop stages are included in that loop 

(as illustrated in the example on page 6-34). You draw a link back to 

the Start Loop activity stage that this stage is paired with.

The stage has no special properties.

User Variables Activity Properties
The user variable stage allows you to define global variables within a 

sequence. These variables can then be used elsewhere in the 

sequence, for example to set job parameters. Variables are used in the 

form stage_label.parameter_name, where stage_label is the name of 

the User Variable activity stage as given in the Diagram window. 

The values of the user variables are set by expressions in the stage’s 

properties. (For details about expressions, see "Expressions" on 

page 6-7.)

You would most likely start a sequence with this stage, setting up the 

variables so they can be accessed by subsequent sequence activities. 

The exit trigger would initiate the sequence proper. You can also use a 

User Variable activity further into a sequence to change the value of a 

variable previously defined by an earlier User Variable activity.

The variables are defined in the Properties page for the stage. To add 

a variable:

Choose Add Row from the shortcut menu.

Enter the name for your variable.
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Supply an expression for resolving the value of the variable.

In this example, the expression editor has picked up a fault with the 

definition. When fixed, this variable will be available to other activity 

stages downstream as MyVars.VAR1.

Compiling the Job Sequence
When you have finished designing your job sequence you must 

compile it before you can run it in the DataStage Director. To compile 

the job sequence, do one of the following:

Choose File ➤ Compile.

Click the Compile button in the toolbar.

Compiling the job sequence generates DataStage BASIC code. A 

dialog box displays the progress of the compilation and will highlight 

any errors. When the compilation is complete, you can click Show 
Error if an error occurs to highlight the offending stage in the 

Diagram window. The More button is enabled if further error 

information is available. The generated code is displayed in the Job 
Control page of the Job Sequence Properties dialog box.
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Restarting Job Sequences
If a sequence is restartable (i.e., is recording checkpoint information) 

and has one of its jobs fail during a run, then the following status 

appears in the DataStage Director:

Aborted/restartable

In this case you can take one of the following actions:

Run Job. The sequence is re-executed, using the checkpoint 
information to ensure that only the required components are re-
executed.

Reset Job. All the checkpoint information is cleared, ensuring 
that the whole job sequence will be run when you next specify run 
job.

Note If, during sequence execution, the flow diverts to an error 

handling stage, DataStage does not checkpoint anything 

more. This is to ensure that stages in the error handling 

path will not be skipped if the job is restarted and another 

error is encountered.

Integrating DataStage Jobs with Ascential 
QualityStage Jobs

You can use the job sequencer to integrate DataStage parallel jobs 

with QualityStage parallel extender jobs. 

To create a job sequence that uses both DataStage parallel jobs and 

QualityStage parallel extender jobs, do the following:

1 Add DataStage and QualityStage Parallel jobs to the Job 
Sequence Diagram window:

a Use the ExecCommand activity for each QualityStage parallel 
extender job in the sequence.

b Include DataStage parallel jobs as Job activities.

2 Link the activities with triggers appropriate for your job sequence.

3 For each QualityStage ExecCommand activity:

a Open the Properties dialog box.

b Select the ExecCommand page.

c Fill in the Command property with the full path of the 
QualityStage Parallel Extender mode script to execute.
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For example, to run the TEST.par Parallel Extender script that is 

located in /Projects/TEST/Scripts, type the following in the 

Command property: 

/Projects/TEST/Scripts/TEST.par

d Fill in the Parameters property with the parameters of the 
QualityStage Parallel Extender mode script.

Parameters for QualityStage Parallel Extender scripts are as 

follows:

–ipe.env job_env_file 
–ipe.env proj_env_file 
–noimport 1

job_env_file is the full path of the environment file associated with 

the job. It is located in the Scripts directory. Its file name is the 

name of the procedure with an .env extension.

proj_env_file is the full path of the project environment file. It is 

located in the project directory. Its file name is ipe.env.sh.

–noimport 1 indicates that the script should treat input and output 

data as Parallel Extender persistent data sets rather than as text 

files.

For example, the parameters associated with the command 

specified in the example from item c above are:

–ipe.env /Projects/TEST/Scripts/TEST.env 
–ipe.env /Projects/TEST/ipe.env.sh 
–noimport 1

e Fill in any other properties required (see "ExecCommand 
Activity Properties" on page 6-25).

4 To set up each DataStage Parallel job activity, follow the 
instructions in "Job Activity Properties" on page 6-18.

QualityStage Parallel Extender jobs read and write persistent data sets 

with schemas defined as follows:

There is only one field defined in the record. The field length = 
total record length.

The type of the field is raw.

A DataStage parallel job that interfaces with an QualityStage parallel 

extender job must account for the schema requirements of the 

QualityStage job in order for it to work properly.
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Job Reports

The job reporting facility allows you to generate an HTML report of a 

server, parallel, or mainframe job or shared containers. You can view 

this report in a standard Internet browser (such as Microsoft Internet 

Explorer) and print it from the browser.

The report contains an image of the job design followed by 

information about the job or container and its stages. Hotlinks 

facilitate navigation through the report. You can link directly from the 

image of the job to the job properties. The following illustration shows 

the first page of an example report, showing the job image and the 

contents list from which you can link to more detailed job component 

descriptions:
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The report is not dynamic, if you change the job design you will need 

to regenerate the report.

Additional stylesheets are available on the DataStage installation disk. 

Look in Utilities\Unsupported\Stylesheet.

Note Job reports work best using Microsoft Internet Explorer 6, 

they may not perform optimally with other browsers.

Generating a Job Report
To generate a job report:

1 Open the job you want to report on in the Designer and choose 
File ➤ Generate Report... (if you have updated the job since it 
was last saved, you are prompted to save it). The Generate 
Report dialog box opens.

2 Choose Use Default Stylesheet to use the default XSLT 
stylesheet supplied with DataStage (the report is generated in 
XML, the stylesheet converts it to HTML, suitable for viewing in a 
browser). You can also define a custom stylesheet for this 
purpose, in which case choose User defined stylesheet and 
type in, or browse for, the pathname of your stylesheet. The 
default stylesheet is DSJobReport.xsl or 
DSMainframeJobReport.xsl for mainframe jobs – both located in 
the DataStage client directory e.g., c:\program 
files\ascential\datastage.

3 Specify the directory in which you want the report saved in 
Directory to save report to. You can type in a directory path, or 
browse for it. The report will be saved within a subdirectory 
named after the job.
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4 Select Overwrite without query to overwrite any existing report 
files without DataStage asking you to confirm this action.

5 Select Retain intermediate XML file to have DataStage retain 
the XML file that it initially generates when producing a report. 
The intermediate file can be found in the same directory as the 
report and has the suffix .xml.

6 Click Generate to generate the report. The report file is called 
jobname.htm and is located in the directory specified in step 3.

7 Click View to view the generated report in your default Internet 
browser.

Requesting a Job Report from the Command 
Line

You can also request the generation of a job report from the command 

line on a DataStage client machine. The command is as follows:

dsdesign.exe /H=hostname /U=username /P=password /O=omitflag project 
job_name | shared_container_name /R [/RP=report_pathname] [/
RT=stylesheet_pathname]

The arguments are as follows:

hostname. The DataStage Server that will generate the report.

username. The user name to use for connecting to the DataStage 
Server (not needed if omitflag = 1)

password. The user’s password (not needed if omitflag = 1).

omitflag. Set this to 1 to omit the username and password (only 
possible if you are connected to the DataStage Server via LAN 
Manager).

Job_name | shared_container_name. The name of the job or 
shared container for which you want to generate a report.

/R. Indicates that you want to generate a report.

report_pathname. The directory where the report subdirectory will 
appear. The report is always written to a subdirectory named after 
the job. If no directory is specified, the report is written to a 
subdirectory in the client directory (e.g., C:\program files 
\ascential\datastage\myjob).

stylesheet_pathname. Specify an alternative XSLT stylesheet to 
use. If you do not specify a stylesheet, the default one will be used

/RX. Specify this option to retain the intermediate XML file.

For example, the command:
Designer Guide 7-3



Requesting a Job Report from the Command Line Job Reports
dsdesign /H=R101 /O=1 dstage ServerJob1 /R /RP=c:\JobReports

Would result in the report ServerJob1.htm being written to the 

directory c:\JobReports\ServerJob1 (another file, jobnumber.bmp, is 

also written, containing the graphic image of the job design).

The command:

dsdesign /H=R101 /O=1 dstage ServerJob1 /R /RP=c:\JobReports /RX

Would result in the files ServerJob1.htm, jobnumber.bmp, and 

ServJob1.xml being written to the directory c:\ServerJob1\JobReports.
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Intelligent Assistants

DataStage provides intelligent assistants which guide you through 

basic DataStage tasks. Specifically they allow you to:

Create a template from a server, parallel, or mainframe job. You 
can subsequently use this template to create new jobs. New jobs 
will be copies of the original job.

Create a new job from a previously created template.

Create a simple parallel data migration job. This extracts data 
from a source and writes it to a target. 

Creating a Template From a Job
To create a template from a job:

1 From the DataStage Designer File Menu, choose New ➤ New 
Template from Job or use the toolbar. A dialog box appears 
which allows you to browse for the job you want to create the 
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template from. All the Server, Enterprise, and Mainframe jobs in 
your current project are displayed. Since job sequences are not 
supported, they are not displayed. 

2 Select the job to be used as a basis for the template. Click OK. 
Another dialog box appears in order to collect details about your 
template:

3 Enter a template name, a template category, and an informative 
description of the job captured in the template.The restrictions on 
the template name and category should follow Windows naming 
restrictions. The description is displayed in the dialog for creating 
jobs from templates. Press OK. The Template-From-Job Assistant 
creates the template and saves it in the template directory 
specified during installation. Templates are saved in XML 
notation.

4 Enter a template name, a template category, and an informative 
description of the job captured in the template.The restrictions on 
the template name and category should follow Windows naming 
restrictions. The description is displayed in the dialog for creating 
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jobs from templates. Press OK. The Template-From-Job Assistant 
creates the template and saves it in the template directory 
specified during installation. Templates are saved in XML 
notation.

Administrating Templates
To delete a template, start the Job-From-Template Assistant and select 

the template. Click the Delete button. Use the same procedure to 

select and delete empty categories.

The Assistant stores all the templates you create in the directory you 

specified during your installation of DataStage. You browse this 

directory when you create a new job from a template. Typically, all the 

developers using the Designer save their templates in this single 

directory. 

After installation, no dialog is available for changing the template 

directory. You can, however change the registry entry for the template 

directory. The default registry value is:

[HKLM/SOFTWARE/Ascential Software/DataStage Client/currentVersion/
Intelligent Assistant/Templates]
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Creating a Job from a Template
To create a job from a template you have previously created:

1 From the DataStage Designer File Menu, choose New ➤ New 
Job from Template or use the toolbar. A dialog box appears 
which allows you to browse for the template you want to create 
the job from.

2 Select the template to be used as the basis for the job. All the 
templates in your template directory are displayed. If you have 
custom templates authored by Consulting or other authorized 
personnel, and you select one of these, a further dialog box 
prompts you to enter job customization details until the Assistant 
has sufficient information to create your job. 
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3 When you have answered the questions, click Apply. You may 
cancel at any time if your are unable to enter all the information. 
Another dialog appears in order to collect the details of the job 
you are creating:

4 Enter a new name and category for your job. The restrictions on 
the job name should follow DataStage naming restrictions (i.e., 
job names should start with a letter and consist of alphanumeric 
characters).

5 Select OK. DataStage creates the job in your project and 
automatically loads the job into the DataStage Designer.
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Using the Data Migration Assistant
The Data Migration Assistant creates you a parallel job which extracts 

data from a data source and writes it to a data target. You can read 

from and write to data sets, sequential files, and all the databases 

supported by parallel jobs.

To use the Data Migration Assistant:

1 From the DataStage Designer File Menu, choose New ➤ New 
Data Migration Job or use the toolbar. A wizard-type dialog 
appears, welcoming you to the Data Migration Assistant. Click 
Next to go to the select data source screen.

2 Select one of these stages to access your source table: Data Set, 
DB2, InformixXPS, Oracle, Sequential File, or Teradata. For 
an RDBMS Stage, you may need to enter a user name or database 
name or the host server to provide connection details for the 
database. 

3 When you have chosen your source, and supplied any information 
required, click Next. The DataStage Select Table dialog box 
appears in order to let you choose a table definition. The table 
definition specifies the columns that the job will read. If the table 
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definition for your source data isn’t there, click Import in order to 
import a table definition directly from the data source (see 
Chapter 8, "Intelligent Assistants," for more details).  

4 Select a Table Definition from the tree structure and click OK. The 
name of the chosen table definition is displayed in the wizard 
screen. If you want to change this, click Change to open the Table 
Definition dialog box again. This screen also allows you to 
specify the table name or file name for your source data (as 
appropriate for the type of data source).
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5 Click Next to go to the next screen. This allows you to specify 
details about the target where your job will write the extracted 
data. 

6 Select one of these stages to receive your data: Data Set, DB2, 
InformixXPS, Oracle, Sequential File, or Teradata. Enter 
additional information when prompted by the dialog. 
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7 Click Next. The screen that appears shows the table definition that 
will be used to write the data (this is the same as the one used to 
extract the data). This screen also allows you to specify the table 
name or file name for your data target (as appropriate for the type 
of data target).
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8 Click Next. The next screen invites you to supply details about the 
job that will be created. You must specify a job name and 
optionally specify a job category. The job name should follow 
DataStage naming restrictions (i.e., begin with a letter and consist 
of alphanumeric characters). 
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9 Select Create Job to trigger job generation. A screen displays the 
progress of the job generation. Using the information you 
entered, the DataStage generation process gathers meta data, 
creates a new job, and adds the created job to the current project

10 When the job generation is complete, click Finish to exit the 
dialog.

All jobs consist of one source stage, one transformer stage, and one 

target stage. 

In order to support password maintenance, all passwords in your 

generated jobs are parameterized and are prompted for at run time.
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Table Definitions

Table definitions are the key to your DataStage project and specify the 

data to be used at each stage of a DataStage job. Table definitions are 

stored in the Repository and are shared by all the jobs in a project. 

You need, as a minimum, table definitions for each data source and 

one for each data target in the data warehouse. 

When you develop a DataStage job you will typically load your stages 

with column definitions from table definitions held in the Repository. 

You do this on the relevant Columns tab of the stage editor. If you 

select the options in the Grid Properties dialog box (see "Grid 

Properties" in Appendix A), the Columns tab will also display two 

extra fields: Table Definition Reference and Column Definition 

Reference. These show the table definition and individual columns 

that the columns on the tab were derived from.

You can import, create, or edit a table definition using either the 

DataStage Designer or the DataStage Manager. (If you are dealing 

with a large number of table definitions, we recommend that you use 

the Manager).
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Table Definition Properties

The Table Definition Dialog Box
When you create, edit, or view a table definition using the DataStage 

Designer, the Table Definition dialog box appears:

This dialog box has up to eight pages:

General

Columns

Format 

NLS

Relationships

Parallel

Layout

Locator

Table Definition Dialog Box - General Page

The General page contains general information about the table 

definition. The following fields are on this page:
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Data source type. The type of data source, for example, 
UniVerse. 

Data source name. If you imported the table definition, this 
contains a reference to where the original data is found. For 
UniVerse and ODBC data sources, this is the data source name. 
For hashed file data sources, this is an account name. For 
sequential file sources, this is the last component of the directory 
path where the sequential file is found.

Table definition. The name of the table definition.

Mainframe platform type. The type of mainframe platform that 
the table definition applies to. Where the table definition does not 
apply to a mainframe data source, it displays <Not applicable>.

Mainframe access type. Where the table definition has been 
imported from a mainframe or is applicable to a mainframe, this 
specifies the type of database. If it is not a mainframe-type table 
definition, the field is set to <Not applicable>.

Meta data supports Multi-valued fields. Select this check box 
if the meta data supports multivalued data. If the check box is 
selected, three extra grid columns used for multivalued data 
support will appear on the Columns page. The check box is 
disabled for ODBC, mainframe, and stored procedure table 
definitions.

Fully Qualified Table Name. This read-only field shows the fully 
qualified table name, as derived from the locator (see "Table 
Definition Dialog Box - Locator Page" on page 9-11).

ODBC quote character. Allows you to specify what character an 
ODBC data source uses as a quote character. Specify 000 to 
suppress the quote character.

Short description. A brief description of the data.

Long description. A full description of the data. 

The combination of the data source type, data source name, and table 

or file name forms a unique identifier for the table definition. No two 

table definitions can have the same identifier. 
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Table Definition Dialog Box - Columns Page

The Columns page contains a grid displaying the column definitions 

for each column in the table definition. The grid has the following 

columns: 

Column name. The name of the column.

Key. Indicates whether the column is part of the primary key. 

SQL type. The SQL data type. 

Length. The data precision. This is the length for CHAR data and 
the maximum length for VARCHAR data. 

Scale. The data scale factor.

Nullable. Specifies whether the column can contain null values. 
This is set to indicate whether the column is subject to a NOT 
NULL constraint. It does not itself enforce a NOT NULL constraint.

Display. The maximum number of characters required to display 
the column data.

Data element. The type of data in the column.

Description. A text description of the column.

The following columns appear if you selected the Meta data 
supports Multi-valued fields check box on the General page:

Association. The name of the association (if any) that the column 
belongs to.

Position. The field number.

Type. The nesting type, which can be S, M, MV, or MS.

The following column may appear if NLS is enabled:
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NLS Map. This property is visible only if NLS is enabled and 
Allow per-column mapping has been selected on the NLS page 
of the Table Definition dialog box. It allows you to specify a 
separate character set map for a column (which overrides the map 
set for the project or table).

The following columns appear if the table definition is derived from a 

COBOL file definition mainframe data source:

Level number. The COBOL level number.

Mainframe table definitions also have the following columns, but due 

to space considerations, these are not displayed on the columns page. 

To view them, choose Edit Row… from the Columns page shortcut 

menu, the Edit Column Meta Data dialog appears, displaying the 

following field in the COBOL tab:

Occurs. The COBOL occurs clause.

Sign indicator. Indicates whether the column can be signed or 
not.

Sign option. If the column is signed, gives the location of the 
sign in the data.

Sync indicator. Indicates whether this is a COBOL-synchronized 
clause or not.

Usage. The COBOL usage clause.

Redefined field. The COBOL REDEFINED clause. 

Depending on. A COBOL OCCURS-DEPENDING-ON clause.

Storage length. Gives the storage length in bytes of the column 
as defined.

Picture. The COBOL PICTURE clause.

For more information about these fields, see page 9-17.

The Columns page for each link also contains a Clear All and a 

Load… button. The Clear All button deletes all the column 

definitions. The Load… button loads (copies) the column definitions 

from a table definition elsewhere in the Repository. 

A shortcut menu available in grids allows you to edit a cell, delete a 

row, or add a row. For more information about editing the columns 

grid, see Appendix A, “Editing Grids.”
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Server jobs Table Definition Dialog Box - Format Page

The Format page contains file format parameters for sequential files 

used in server jobs. These fields are automatically set when you 

import a table definition from a sequential file. 

There are three check boxes on this page:

Fixed-width columns. Specifies whether the sequential file 
contains fixed-width fields. This check box is cleared by default, 
that is, the file does not contain fixed-width fields. When this check 
box is selected, the Spaces between columns field is enabled.

First line is column names. Specifies whether the first line in 
the file contains the column names. This check box is cleared by 
default, that is, the first row in the file does not contain the column 
names. 

Omit last new-line. Specifies whether the last newline character 
in the file is ignored. By default this check box is cleared, that is, if 
a newline character exists in the file, it is used. 

The rest of this page contains five fields. The available fields depend 

on the settings for the check boxes. 

Spaces between columns. Specifies the number of spaces used 
between the columns in the file. This field appears when you 
select Fixed-width columns.

Delimiter. Contains the delimiter that separates the data fields. 
By default this field contains a comma. You can enter a single 
printable character or a decimal or hexadecimal number to 
represent the ASCII code for the character you want to use. Valid 
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ASCII codes are in the range 1 to 253. Decimal values 1 through 9 
must be preceded with a zero. Hexadecimal values must be 
prefixed with &h. Enter 000 to suppress the delimiter

Quote character. Contains the character used to enclose strings. 
By default this field contains a double quotation mark. You can 
enter a single printable character or a decimal or hexadecimal 
number to represent the ASCII code for the character you want to 
use. Valid ASCII codes are in the range 1 to 253. Decimal values 1 
through 9 must be preceded with a zero. Hexadecimal values must 
be prefixed with &h. Enter 000 to suppress the quote character. 

NULL string. Contains characters that are written to the file when 
a column contains SQL null values. 

Padding character. Contains the character used to pad missing 
columns. This is # by default.

The Sync Parallel button is only visible if your system supports 

parallel jobs. It causes the properties set on the Parallel tab to mirror 

the properties set on this page when the button is pressed. A dialog 

box appears asking you to confirm this action, if you do the Parallel 
tab appears and lets you view the settings.

Table Definition Dialog Box - NLS Page
Server jobs
and
Parallel jobs

If NLS is enabled, this page contains the name of the map to use for 

the table definitions. The map should match the character set used in 

the definitions. By default, the list box shows all the maps that are 

loaded and ready to use with server jobs. Show all Server maps 

lists all the maps that are shipped with DataStage. Show all Parallel 
maps lists the maps that are available for use with parallel jobs
Designer Guide 9-7



Table Definition Properties Table Definitions
Note You cannot use a server map unless it is loaded into 

DataStage. You can load different maps using the 

DataStage Administrator. For more information, see "NLS 

Configuration" in DataStage Administrator Guide.

Select Allow per-column mapping if you want to assign different 

character set maps to individual columns.

Server jobs
and
Parallel jobs

Table Definition Dialog Box - Relationships Page

The Relationships page shows you details of any relationships this 

table definition has with other tables, and allows you to define new 

relationships.

The page contains two grids:

Foreign Keys. This shows which columns in the table definition 
are foreign keys and which columns and tables they reference. 
You can define foreign keys manually by entering the information 
yourself. The table you reference does not have to exist in the 
DataStage Repository, but you will be informed if it doesn’t. 
Referencing and referenced table do have to be in the same 
category.

Tables which reference this table. This gives details of where 
other table definitions in the Repository reference this one using a 
foreign key. You cannot edit the contents of this grid. 
9-8 Designer Guide



Table Definitions Table Definition Properties
Table Definition Dialog Box - Parallel Page

This page is used when table definitions are used in parallel jobs and 

gives detailed format information for the defined meta data. 

The information given here is the same as on the Format tab in one 

of the following parallel job stages:

Sequential File Stage

File Set Stage

External Source Stage

External Target Stage

Column Import Stage

Column Export Stage

See "Stage Editors" in Parallel Job Developer’s Guide for details.

The Defaults button gives access to a shortcut menu offering the 

choice of:

Save current as default. Saves the settings you have made in 
this dialog box as the default ones for your table definition.

Reset defaults from factory settings. Resets to the defaults 
that DataStage came with.

Set current from default. Set the current settings to the default 
(this could be the factory default, or your own default if you have 
set one up).

Click the Show schema button to open a window showing how the 

current table definition is generated into an OSH schema. This shows 
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how DataStage will interpret the column definitions and format 

properties of the table definition in the context of a parallel job stage.

Table Definition Dialog Box – Layout Page

The Layout page displays the schema format of the column 

definitions in a table.

Select a button to view the data representation in one of three 

formats:

Parallel. Displays the OSH record schema. You can right-click to 
save the layout as a text file in *.osh format.

COBOL. Displays the COBOL representation, including the 
COBOL picture clause, starting and ending offsets, and column 
storage length. You can right-click to save the file view layout as 
an HTML file.

Standard. Displays the SQL representation, including SQL type, 
length, and scale.

The following diagrams show three different views of the same table.
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Table Definition Dialog Box - Locator Page

The Locator page allows you to view and edit the data resource 

locator associated with the table definition. The data resource locator 

is a property of the table definition that describes the real world 

object. 

When capturing process meta data, you define a table containing this 

information in the source/target database (see "Capturing Process 
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Meta Data" in DataStage Administrator Guide). This table provides 

some of the information displayed in this tab.

Locators are filled in when table definitions are imported using meta 

data import, and are manipulated when table definitions are copied, 

renamed, or moved. The fields can be edited, but you are advised not 

to do this unless you are well versed in MetaStage. 

The labels and contents of the fields in this dialog box varies 

according to the type of data source/target the locator originates from. 

See MetaStage documentation for details.

Importing a Table Definition
The easiest way to specify a table definition is to import it directly 

from the source or target database. A new table definition is created 

and the properties are automatically filled in with the details of your 

data source or data target. 

Standard data 
sources

You can import table definitions from an ODBC data source, certain 

plug-in stages (including Sybase Open Client and Oracle OCI), a 

UniVerse table, a hashed (UniVerse) file, a UniData file, or a sequential 

file. DataStage connects to the specified data source and extracts the 

required table definition meta data. You can use the Data Browser to 

view the actual data in data sources from which you are importing 

table definitions.

To import table definitions in this way:
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1 Select the Table Definitions branch in the DataStage Designer 
Repository window and choose Import ➤ Table Definitions ➤ 
Data Source Type from the shortcut menu.

For most data source types, a dialog box appears enabling you to 

connect to the data source (for plug-in data sources, a wizard 

appears and guides you through the process).

2 Fill in the required connection details and click OK. Once a 
connection to the data source has been made successfully, the 
updated dialog box gives details of the table definitions available 
for import.

3 Select the required table definitions and click OK. The table 
definition meta data is imported into the DataStage Repository.

Specific information about importing from particular types of data 

source is in DataStage Developer’s Help.

CFD and DCLGen 
files

You can also import meta data from CFD files and DCLGen files. The 

import derives the meta data from table definition files which are 

generated on a mainframe and transferred to the DataStage client. 

The table definitions are then derived from these files. The Data 

Browser is not available when importing meta data in this way.

To import table definitions in this way:

1 Select the Table Definitions branch in the DataStage Designer 
Repository window and choose Import ➤ Table Definitions ➤ 
COBOL File Definitions or Import ➤ Table Definitions ➤ 
DCLGen File Definitions from the shortcut menu. The Import 
Meta Data dialog box appears, allowing you to enter details of 
the file to import.

2 Enter details of the file, including name, location, and start 
position then click Refresh. A list of table definitions appears in 
the Tables list.

3 Select the table definitions you want to import, or click Select all 
to select all of them. Click OK. The table definition meta data is 
imported into the DataStage Repository.

More detailed information about importing from mainframe data 

sources is in DataStage Developer’s Help.

Manually Entering a Table Definition
If you are unable to import the table definitions for your source or 

target data, you must enter this information manually. 

To manually enter table definition properties, you must first create a 

new table definition. You can then enter suitable settings for the 

general properties before specifying the column definitions. You only 

need to specify file format settings for a sequential file table definition.
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Creating a Table Definition

To create a table definition:

1 In the DataStage Designer Repository window, select the Table 
Definitions branch and choose New Table Definition… from 
the shortcut menu.

The Table Definition dialog box appears. You must enter 

suitable values in the fields on the General page.

2 Enter the type of data source in the Data source type field. The 
name entered here determines how the definition appears under 
the Table Definitions branch. 

3 Enter the name of the data source in the Data source name field. 
This forms the second part of the table definition identifier and is 
the name of the branch created under the data source type branch. 

4 Enter the name of the table or file containing the data in the 
Table/file name field. This is the last part of the table definition 
identifier and is the name of the leaf created under the data source 
branch. 

5 Where the Data source type specifies a relational database, type 
the name of the database owner in Owner.

6 If you are entering a mainframe table definition, choose the 
platform type from the Mainframe platform type drop-down 
list, and the access type from the Mainframe access type drop-
down list. Otherwise leave both of these items set to <Not 
applicable>.

7 Select the Meta data supports Multi-valued fields check box if 
the meta data supports multivalued data. 

8 If required, specify what character an ODBC data source uses as a 
quote character in ODBC quote character.

9 Enter a brief description of the data in the Short description 
field. This is an optional field. 

10 Enter a more detailed description of the data in the Long 
description field. This is an optional field.

11 Click the Columns tab. The Columns page appears at the front of 
the Table Definition dialog box. You can now enter or load 
column definitions for your data. 

Entering Column Definitions

You can enter column definitions directly in the Columns grid using 

the standard controls described in Appendix A or you can use the 

Edit Column Meta Data dialog box to add one row at a time. To use 

the dialog box:
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1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.

– Press Ctrl-E.

– Double-click on the row number cell at the left of the grid.

The Edit Column Meta Data dialog box appears. It has a 

general area containing fields that are common to all data source 

type, plus three tabs containing fields specific to meta data used in 

server jobs and information specific to COBOL data sources and 

information about formats used in parallel jobs.

The exact fields that appear in this dialog box depend on the type 

of table definition as set on the General page of the Table 
Definition dialog box.

2 Enter the general information for each column you want to define 
as follows:

– Column name. Type in the name of the column. This is the 
only mandatory field in the definition.

– Key. Select Yes or No from the drop-down list.

– Native type. For data sources with a platform type of OS390, 
choose the native data type from the drop-down list. The 
contents of the list are determined by the Access Type you 
specified on the General page of the Table Definition dialog 
box. (The list is blank for non-mainframe data sources.)
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– SQL type. Choose from the drop-down list of supported SQL 
types. If you are a adding a table definition for platform type 
OS390, you cannot manually enter an SQL type, it is 
automatically derived from the Native type.

– Length. Type a number representing the length or precision of 
the column.

– Scale. If the column is numeric, type a number to define the 
number of decimal places.

– Nullable. Select Yes or No from the drop-down list. This is set 
to indicate whether the column is subject to a NOT NULL 
constraint. It does not itself enforce a NOT NULL constraint.

– Date format. Choose the date format that the column uses 
from the drop-down list of available formats.

– Description. Type in a description of the column.

Server Jobs

If you are specifying meta data for a server job type data source or 

target, then the Edit Column Meta Data dialog bog box appears 

with the Server tab on top. Enter any required information that is 

specific to server jobs: 

Data element. Choose from the drop-down list of available data 
elements.

Display. Type a number representing the display length for the 
column.

Position. Visible only if you have specified Meta data supports 
Multi-valued fields on the General page of the Table 
Definition dialog box. Enter a number representing the field 
number.

Type. Visible only if you have specified Meta data supports 
Multi-valued fields on the General page of the Table 
Definition dialog box. Choose S, M, MV, MS, or blank from the 
drop-down list.

Association. Visible only if you have specified Meta data 
supports Multi-valued fields on the General page of the Table 
Definition dialog box. Type in the name of the association that 
the column belongs to (if any). 

NLS Map. Visible only if NLS is enabled and Allow per-column 
mapping has been selected on the NLS page of the Table 
Definition dialog box. Choose a separate character set map for a 
column, which overrides the map set for the project or table. (The 
per-column mapping feature is available only for sequential, 
ODBC, or generic plug-in data source types.)
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Null String. This is the character that represents null in the data.

Padding. This is the character used to pad missing columns. Set 
to # by default.

Mainframe Jobs

If you are specifying meta data for a mainframe job type data source, 

then the Edit Column Meta Data dialog bog box appears with the 

COBOL tab on top. Enter any required information that is specific to 

mainframe jobs:

Level number. Type in a number giving the COBOL level number 
in the range 02 – 49. The default value is 05.

Occurs. Type in a number giving the COBOL occurs clause. If the 
column defines a group, gives the number of elements in the 
group.

Usage. Choose the COBOL usage clause from the drop-down list. 
This specifies which COBOL format the column will be read in. 
These formats map to the formats in the Native type field, and 
changing one will normally change the other. Possible values are:

– COMP – Binary

– COMP-1 – single-precision Float

– COMP-2 – packed decimal Float

– COMP-3 – packed decimal

– COMP-5 – used with NATIVE BINARY native types

– DISPLAY – zone decimal, used with Display_numeric or 
Character native types

– DISPLAY-1 – double-byte zone decimal, used with Graphic_G 
or Graphic_N

Sign indicator. Choose Signed or blank from the drop-down list 
to specify whether the column can be signed or not. The default is 
blank.

Sign option. If the column is signed, choose the location of the 
sign in the data from the drop-down list. Choose from the 
following:

– LEADING – the sign is the first byte of storage

– TRAILING – the sign is the last byte of storage

– LEADING SEPARATE – the sign is in a separate byte that has 
been added to the beginning of storage

– TRAILING SEPARATE – the sign is in a separate byte that has 
been added to the end of storage
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Selecting either LEADING SEPARATE or TRAILING SEPARATE 

will increase the storage length of the column by one byte.

Sync indicator. Choose SYNC or blank from the drop-down list 
to indicate whether this is a COBOL-synchronized clause or not.

Redefined field. Optionally specify a COBOL REDEFINES clause. 
This allows you to describe data in the same storage area using a 
different data description. The redefining column must be the 
same length, or smaller, than the column it redefines. Both 
columns must have the same level, and a column can only 
redefine the immediately preceding column with that level.

Depending on. Optionally choose a COBOL OCCURS-
DEPENDING ON clause from the drop-down list.

Storage length. Gives the storage length in bytes of the column 
as defined. The field cannot be edited.

Picture. Gives the COBOL PICTURE clause, which is derived from 
the column definition. The field cannot be edited.

The Server tab is still accessible, but the Server page only 

contains the Data Element and Display fields.

The following table shows the relationships between native 

COBOL types and SQL types:

Native 
Data
Type

Native 
Length 
(bytes)

COBOL Usage
Representation

SQL 
Type

Precision (p) Scale (s) Storage 
Length 
(bytes)

BINARY 2
4
8

PIC S9 to S9(4) 
COMP
PIC S9(5) to S9(9) 
COMP
PIC S9(10) to S9(18) 
COMP

SmallInt
Integer
Decimal

1 to 4
5 to 9
10 to 18

n/a
n/a
n/a

2
4
8

CHARACTER n n PIC X(n) Char n n/a n

DECIMAL (p+s)/2+1 PIC S9(p)V9(s) 
COMP-3

Decimal p+s s (p+s)/2+1

DISPLAY_
NUMERIC

p+s PIC S9(p)V9(s) Decimal p+s s (p+s)/2+1

FLOAT
(single)
(double)

4

8

PIC COMP-1
PIC COMP-2

Decimal
Decimal

p+s (default 18)
p+s (default 18)

s (default 4)
s (default 4)

4

8

GRAPHIC_G n*2 PIC G(n) DISPLAY-1 NChar n n/a n*2

GRAPHIC_N n*2 PIC N(n) NChar n n/a n*2
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Parallel Jobs

If you are specifying meta data for a parallel job type data source or 

target, then the Edit Column Meta Data dialog bog box appears 

with the Parallel tab on top. This allows you to enter detailed 

information about the format of the column. 

Field Level. This has the following properties:

Bytes to Skip. Skip the specified number of bytes from the end 
of the previous column to the beginning of this column.

Delimiter. Specifies the trailing delimiter of the column. Type an 
ASCII character or select one of whitespace, end, none, null, 
comma, or tab. 

whitespace. The last column of each record will not include any 
trailing white spaces found at the end of the record.

end. The end of a field is taken as the delimiter, i.e., there is no 
separate delimiter. This is not the same as a setting of ‘None’ 
which is used for fields with fixed-width columns.

none. No delimiter (used for fixed-width).

null. ASCII Null character is used.

GROUP n (sum of 
all the 
column 
lengths 
that 
make up 
the 
group)

Char n n/a n

NATIVE 
BINARY 

2
4
8

PIC S9 to S9(4) 
COMP-5
PIC S9(5) to S9(9) 
COMP-5
PIC S9(10) to S9(18) 
COMP-5

SmallInt
Integer
Decimal

1 to 4
5 to 9
10 to 18

n/a
n/a
n/a

2
4
8

VARCHAR n+2 PIC S9(4) COMP
PIC X(n)

VarChar n+2 n/a n+2

VARGRAPHIC 
_G

(n*2)+2 PIC S9(4) COMP
PIC G(n) DISPLAY-1

NVarChar n+2 n/a (n*2)+2

VARGRAPHIC 
_N

(n*2)+2 PIC S9(4) COMP 
PIC N(n)

NVarChar n+2 n/a (n*2)+2

Native 
Data
Type

Native 
Length 
(bytes)

COBOL Usage
Representation

SQL 
Type

Precision (p) Scale (s) Storage 
Length 
(bytes)
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comma. ASCII comma character used.

tab. ASCII tab character used.

Delimiter string. Specify a string to be written at the end of the 
column. Enter one or more characters. This is mutually exclusive 
with Delimiter, which is the default. For example, specifying ‘, ‘ 
(comma space – you do not need to enter the inverted commas) 
would have the column delimited by ‘, ‘.

Drop on input. Select this property when you must fully define 
the meta data for a data set, but do not want the column actually 
read into the data set.

Prefix bytes. Specifies that this column is prefixed by 1, 2, or 4 
bytes containing, as a binary value, either the column’s length or 
the tag value for a tagged column. You can use this option with 
variable-length fields. Variable-length fields can be either 
delimited by a character or preceded by a 1-, 2-, or 4-byte prefix 
containing the field length. DataStage inserts the prefix before 
each field.

This property is mutually exclusive with the Delimiter, Quote, and 

Final Delimiter properties, which are used by default.

Print field. This property is intended for use when debugging 
jobs. Set it to have DataStage produce a message for each of the 
columns it reads. The message has the format:

Importing N: D

where:

– N is the column name.

– D is the imported data of the column. Non-printable characters 
contained in D are prefixed with an escape character and written 
as C string literals; if the column contains binary data, it is 
output in octal format.

Quote. Specifies that variable length columns are enclosed in 
single quotes, double quotes, or another ASCII character or pair of 
ASCII characters. Choose Single or Double, or enter a character.

Start position. Specifies the starting position of a column in the 
record. The starting position can be either an absolute byte offset 
from the first record position (0) or the starting position of another 
column.

Tag case value. Explicitly specifies the tag value corresponding 
to a subfield in a tagged subrecord. By default the fields are 
numbered 0 to N-1, where N is the number of fields. (A tagged 
subrecord is a column whose type can vary. The subfields of the 
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tagged subrecord are the possible types. The tag case value of the 
tagged subrecord selects which of those types is used to interpret 
the column’s value for the record.)

String Type. This has the following properties:

Character Set. Choose from ASCII or EBCDIC (not available for 
ustring type (Unicode)).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Export EBCDIC as ASCII. Select this to specify that EBCDIC 
characters are written as ASCII characters (not available for ustring 
type (Unicode)).

Is link field. Selected to indicate that a column holds the length 
of another, variable-length column of the record or of the tag 
value of a tagged record field.

Import ASCII as EBCDIC. Select this to specify that ASCII 
characters are read as EBCDIC characters (not available for ustring 
type (Unicode)).

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. This is useful where you 
are storing numbers as text. If you are using a fixed-width 
character set, you can calculate the length exactly. If you are using 
variable-length character set, calculate an adequate maximum 
width for your fields. Applies to fields of all data types except date, 
time, timestamp, and raw; and record, subrec, or tagged if they 
contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Pad char. Specifies the pad character used when strings or 
numeric values are written to an external string representation. 
Enter a character (single-byte for strings, can be multi-byte for 
ustrings) or choose null or space. The pad character is used when 
the external string representation is larger than required to hold 
the written field. In this case, the external string is filled with the 
pad character to its full length. Space is the default. Applies to 
string, ustring, and numeric data types and record, subrec, or 
tagged types if they contain at least one field of this type.
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Date Type. –his has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

Days since. Dates are written as a signed integer containing the 
number of days since the specified date. Enter a date in the form 
%yyyy-%mm-%dd or in the default date format if you have defined 
a new one on an NLS system (see DataStage NLS Guide).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For dates, binary is equivalent to specifying the julian property for 

the date field, text specifies that the data to be written contains a 

text-based date in the form %yyyy-%mm-%dd or in the default 

date format if you have defined a new one on an NLS system (see 

DataStage NLS Guide).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Format string. The string format of a date. By default this is 
%yyyy-%mm-%dd. The Format string can contain one or a 
combination of the following elements:

– %dd: A two-digit day.

– %mm: A two-digit month.

– %year_cutoffyy: A two-digit year derived from yy and the 
specified four-digit year cutoff, for example %1970yy.

– %yy: A two-digit year derived from a year cutoff of 1900.

– %yyyy: A four-digit year.

– %ddd: Day of year in three-digit form (range of 1– 366).

– %mmm: Three-character month abbreviation.

The format_string is subject to the following restrictions:

– It cannot have more than one element of the same type, for 
example it cannot contain two %dd elements.
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– It cannot have both %dd and %ddd.

– It cannot have both %yy and %yyyy.

– It cannot have both %mm and %ddd.

– It cannot have both %mmm and %ddd.

– It cannot have both %mm and %mmm.

– If it has %dd, it must have %mm or %mmm.

– It must have exactly one of %yy or %yyyy.

When you specify a date format string, prefix each component 

with the percent symbol (%). Separate the string’s components 

with any character except the percent sign (%).

If this format string does not include a day, it is set to the first of 

the month in the destination field. If the format string does not 

include the month and day, they default to January 1. Note that 

the format string must contain a month if it also contains a day; 

that is, you cannot omit only the month.

The year_cutoff is the year defining the beginning of the century in 

which all twodigit years fall. By default, the year cutoff is 1900; 

therefore, a two-digit year of 97 represents 1997. 

You can specify any four-digit year as the year cutoff. All two-digit 

years then specify the next possible year ending in the specified 

two digits that is the same or greater than the cutoff. For example, 

if you set the year cutoff to 1930, the two-digit year 30 corresponds 

to 1930, and the two-digit year 29 corresponds to 2029.

Is Julian. Select this to specify that dates are written as a numeric 
value containing the Julian day. A Julian day specifies the date as 
the number of days from 4713 BCE January 1, 12:00 hours (noon) 
GMT.

Time Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).
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Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For time, binary is equivalent to midnight_seconds, text specifies 

that the field represents time in the text-based form %hh:%nn:%ss 

or or in the default date format if you have defined a new one on 

an NLS system (see DataStage NLS Guide).

Format string. Specifies the format of columns representing 
time as a string. By default this is %hh-%mm-%ss. The possible 
components of the time format string are:

– %hh: A two-digit hours component.

– %nn: A two-digit minute component (nn represents minutes 
because mm is used for the month of a date).

– %ss: A two-digit seconds component.

– %ss.n: A two-digit seconds plus fractional part, where n is the 
number of fractional digits with a maximum value of 6. If n is 0, 
no decimal point is printed as part of the seconds component. 
Trailing zeros are not suppressed.

You must prefix each component of the format string with the 

percent symbol. Separate the string’s components with any 

character except the percent sign (%).

Is midnight seconds. Select this to specify that times are written 
as a binary 32-bit integer containing the number of seconds 
elapsed from the previous midnight.

Timestamp Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.

– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text
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For timestamp, binary specifies that the first integer contains a 

Julian day count for the date portion of the timestamp and the 

second integer specifies the time portion of the timestamp as the 

number of seconds from midnight. A binary timestamp specifies 

that two 32-but integers are written. Text specifies a text-based 

timestamp in the form %yyyy-%mm-%dd %hh:%nn:%ss or in the 

default date format if you have defined a new one on an NLS 

system (see DataStage NLS Guide).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Format string. Specifies the format of a column representing a 
timestamp as a string. Defaults to %yyyy-%mm-%dd 
%hh:%nn:%ss. Specify the format as follows:

For the date:

– %dd: A two-digit day.

– %mm: A two-digit month.

– %year_cutoffyy: A two-digit year derived from yy and the 
specified four-digit year cutoff.

– %yy: A two-digit year derived from a year cutoff of 1900.

– %yyyy: A four-digit year.

– %ddd: Day of year in three-digit form (range of 1 - 366)

For the time:

– %hh: A two-digit hours component.

– %nn: A two-digit minute component (nn represents minutes 
because mm is used for the month of a date).

– %ss: A two-digit seconds component.

– %ss.n: A two-digit seconds plus fractional part, where n is the 
number of fractional digits with a maximum value of 6. If n is 0, 
no decimal point is printed as part of the seconds component. 
Trailing zeros are not suppressed. 

You must prefix each component of the format string with the 

percent symbol (%). Separate the string’s components with any 

character except the percent sign (%).

Integer Type. This has the following properties:

Byte order. Specifies how multiple byte data types are ordered. 
Choose from:

– little-endian. The high byte is on the right.
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– big-endian. The high byte is on the left.

– native-endian. As defined by the native format of the machine.

Character Set. Choose from ASCII or EBCDIC.

C_format. Perform non-default conversion of data from a string 
to integer data. This property specifies a C-language format string 
used for reading/writing integer strings. This is passed to sscanf() 
or sprintf().

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

In_format. Format string used for conversion of data from string 
to integer. This is passed to sscanf(). By default, DataStage 
invokes the C sscanf() function to convert a numeric field 
formatted as a string to either integer or floating point data. If this 
function does not output data in a satisfactory format, you can 
specify the in_format property to pass formatting arguments to 
sscanf().

Is link field. Selected to indicate that a column holds the length 
of another, variable-length column of the record or of the tag 
value of a tagged record field.

Out_format. Format string used for conversion of data from 
integer to a string. This is passed to sprintf(). By default, 
DataStage invokes the C sprintf() function to convert a numeric 
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field formatted as integer data to a string. If this function does not 
output data in a satisfactory format, you can specify the 
out_format property to pass formatting arguments to sprintf().

Pad char. Specifies the pad character used when the integer is 
written to an external string representation. Enter a character 
(single-bye for strings, can be multi-byte for ustrings) or choose 
null or space. The pad character is used when the external string 
representation is larger than required to hold the written field. In 
this case, the external string is filled with the pad character to its 
full length. Space is the default. 

Decimal Type. This has the following properties:

Allow all zeros. Specifies whether to treat a packed decimal 
column containing all zeros (which is normally illegal) as a valid 
representation of zero. Select Yes or No.

Character Set. Choose from ASCII or EBCDIC.

Decimal separator. Specify the character that acts as the 
decimal separator (period by default).

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

For decimals, binary means packed. Text represents a decimal in a 

string format with a leading space or '-' followed by decimal digits 

with an embedded decimal point if the scale is not zero. The 

destination string format is: [+ | -]ddd.[ddd] and any precision and 

scale arguments are ignored.

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
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your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Packed. Select an option to specify what the decimal columns 
contain, choose from:

Yes to specify that the decimal columns contain data in packed 
decimal format (the default). This has the following sub-
properties:

Check. Select Yes to verify that data is packed, or No to not 
verify.

Signed. Select Yes to use the existing sign when writing decimal 
columns. Select No to write a positive sign (0xf) regardless of the 
columns’ actual sign value.

No (separate) to specify that they contain unpacked decimal with 
a separate sign byte. This has the following sub-property:

Sign Position. Choose leading or trailing as appropriate.

No (zoned) to specify that they contain an unpacked decimal in 
either ASCII or EBCDIC text. This has the following sub-property:

Sign Position. Choose leading or trailing as appropriate.

No (overpunch) to specify that the field has a leading or end byte 
that contains a character which specifies both the numeric value of 
that byte and whether the number as a whole is negatively or 
positively signed. This has the following sub-property:

Sign Position. Choose leading or trailing as appropriate.

Precision. Specifies the precision where a decimal column is 
represented in text format. Enter a number. When a decimal is 
written to a string representation, DataStage uses the precision 
and scale defined for the source decimal field to determine the 
length of the destination string. The precision and scale properties 
override this default. When they are defined, DataStage truncates 
or pads the source decimal to fit the size of the destination string. 
If you have also specified the field width property, DataStage 
truncates or pads the source decimal to fit the size specified by 
field width.

Rounding. Specifies how to round the source field to fit into the 
destination decimal when reading a source field to a decimal. 
Choose from:

– up (ceiling). Truncate source column towards positive infinity. 
This mode corresponds to the IEEE 754 Round Up mode. For 
example, 1.4 becomes 2, -1.6 becomes -1.
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– down (floor). Truncate source column towards negative 
infinity. This mode corresponds to the IEEE 754 Round Down 
mode. For example, 1.6 becomes 1, -1.4 becomes -2.

– nearest value. Round the source column towards the nearest 
representable value. This mode corresponds to the COBOL 
ROUNDED mode. For example, 1.4 becomes 1, 1.5 becomes 2, -
1.4 becomes -1, -1.5 becomes -2.

– truncate towards zero. This is the default. Discard fractional 
digits to the right of the right-most fractional digit supported by 
the destination, regardless of sign. For example, if the 
destination is an integer, all fractional digits are truncated. If 
the destination is another decimal with a smaller scale, 
truncate to the scale size of the destination decimal. This mode 
corresponds to the COBOL INTEGER-PART function. Using this 
method 1.6 becomes 1, -1.6 becomes -1.

Scale. Specifies how to round a source decimal when its 
precision and scale are greater than those of the destination. By 
default, when the DataStage writes a source decimal to a string 
representation, it uses the precision and scale defined for the 
source decimal field to determine the length of the destination 
string. You can override the default by means of the precision and 
scale properties. When you do, DataStage truncates or pads the 
source decimal to fit the size of the destination string. If you have 
also specified the field width property, DataStage truncates or 
pads the source decimal to fit the size specified by field width. 
Specifies how to round a source decimal when its precision and 
scale are greater than those of the destination.

Float Type. This has the following properties:

C_format. Perform non-default conversion of data from a string 
to floating-point data. This property specifies a C-language format 
string used for reading floating point strings. This is passed to 
sscanf().

Character Set. Choose from ASCII or EBCDIC.

Default. The default value for a column. This is used for data 
written by a Generate stage. It also supplies the value to substitute 
for a column that causes an error (whether written or read).

Data Format. Specifies the data representation format of a 
column. Choose from:

– binary

– text

Field max width. The maximum number of bytes in a column 
represented as a string. Enter a number. Enter a number. This is 
useful where you are storing numbers as text. If you are using a 
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fixed-width character set, you can calculate the length exactly. If 
you are using variable-length character set, calculate an adequate 
maximum width for your fields. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

Field width. The number of bytes in a column represented as a 
string. Enter a number. This is useful where you are storing 
numbers as text. If you are using a fixed-width charset, you can 
calculate the number of bytes exactly. If it’s a variable length 
encoding, base your calculation on the width and frequency of 
your variable-width characters. Applies to fields of all data types 
except date, time, timestamp, and raw; and record, subrec, or 
tagged if they contain at least one field of this type.

In_format. Format string used for conversion of data from string 
to floating point. This is passed to sscanf(). By default, DataStage 
invokes the C sscanf() function to convert a numeric field 
formatted as a string to floating point data. If this function does 
not output data in a satisfactory format, you can specify the 
in_format property to pass formatting arguments to sscanf().

Is link field. Selected to indicate that a column holds the length 
of a another, variable-length column of the record or of the tag 
value of a tagged record field.

Out_format. Format string used for conversion of data from 
floating point to a string. This is passed to sprintf(). By default, 
DataStage invokes the C sprintf() function to convert a numeric 
field formatted as floating point data to a string. If this function 
does not output data in a satisfactory format, you can specify the 
out_format property to pass formatting arguments to sprintf().

Pad char. Specifies the pad character used when the floating 
point number is written to an external string representation. Enter 
a character (single-bye for strings, can be multi-byte for ustrings) 
or choose null or space. The pad character is used when the 
external string representation is larger than required to hold the 
written field. In this case, the external string is filled with the pad 
character to its full length. Space is the default.

Nullable. This appears for nullable fields.

Actual field length. Specifies the number of bytes to fill with the 
Fill character when a field is identified as null. When DataStage 
identifies a null field, it will write a field of this length full of Fill 
characters. This is mutually exclusive with Null field value.

Null field length. The length in bytes of a variable-length field 
that contains a null. When a variable-length field is read, a length 
of null field length in the source field indicates that it contains a 
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null. When a variable-length field is written, DataStage writes a 
length value of null field length if the field contains a null. This 
property is mutually exclusive with null field value.

Null field value. Specifies the value given to a null field if the 
source is set to null. Can be a number, string, or C-type literal 
escape character. For example, you can represent a byte value by 
\ooo, where each o is an octal digit 0 - 7 and the first o is < 4, or by 
\xhh, where each h is a hexadecimal digit 0 - F. You must use this 
form to encode non-printable byte values. 

This property is mutually exclusive with Null field length and 

Actual length. For a fixed width data representation, you can use 

Pad char (from the general section of Type defaults) to specify a 

repeated trailing character if the value you specify is shorter than 

the fixed width of the field. On reading, specifies the value given 

to a field containing a null. On writing, specifies the value given to 

a field if the source is set to null. Can be a number, string, or C-

type literal escape character.

Generator. If the column is being used in a Row Generator or 

Column Generator stage, this allows you to specify extra details about 

the mock data being generated. The exact fields that appear depend 

on the data type of the column being generated. They allow you to 

specify features of the data being generated, for example, for integers 

they allow you to specify if values are random or whether they cycle. 

If they cycle you can specify an initial value, an increment, and a limit. 

If they are random, you can specify a seed value for the random 

number generator, whether to include negative numbers, and a limit. 

See "Generator" in Parallel Job Developer’s Guide for more details.

Vectors. If the row you are editing represents a column which is a 

variable length vector, tick the Variable check box. The Vector 

properties appear, these give the size of the vector in one of two ways:

Link Field Reference. The name of a column containing the 
number of elements in the variable length vector. This should 
have an integer or float type, and have its Is Link field property set.

Vector prefix. Specifies 1-, 2-, or 4-byte prefix containing the 
number of elements in the vector.

If the row you are editing represents a column which is a vector of 

known length, enter the number of elements in the Vector Occurs 

box.

Subrecords. If the row you are editing represents a column which is 

part of a subrecord the Level Number column indicates the level of the 

column within the subrecord structure.
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If you specify Level numbers for columns, the column immediately 

preceding will be identified as a subrecord. Subrecords can be nested, 

so can contain further subrecords with higher level numbers (i.e., 

level 06 is nested within level 05). Subrecord fields have a Tagged 

check box to indicate that this is a tagged subrecord.

Extended. For certain data types the Extended check box appears to 

allow you to modify the data type as follows:

Char, VarChar, LongVarChar. Select to specify that the 
underlying data type is a ustring.

Time. Select to indicate that the time field includes microseconds.

Timestamp. Select to indicate that the timestamp field includes 
microseconds.

TinyInt, SmallInt, Integer, BigInt types. Select to indicate that 
the underlying data type is the equivalent uint field.

Use the buttons at the bottom of the Edit Column Meta Data dialog 

box to continue adding or editing columns, or to save and close. The 

buttons are:

Previous and Next. View the meta data in the previous or next 
row. These buttons are enabled only where there is a previous or 
next row enabled. If there are outstanding changes to the current 
row, you are asked whether you want to save them before moving 
on.

Close. Close the Edit Column Meta Data dialog box. If there are 
outstanding changes to the current row, you are asked whether 
you want to save them before closing.

Apply. Save changes to the current row.

Reset. Remove all changes made to the row since the last time 
you applied changes.

Click OK to save the column definitions and close the Edit Column 
Meta Data dialog box. 

Remember, you can also edit a columns definition grid using the 

general grid editing controls, described in "Editing the Grid Directly" 

on page A-5.

Loading Column Definitions

Instead of entering column definitions, you can load (copy) the 

column definitions from an existing table definition. To load column 

definitions:
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1 Click Load… . The Table Definitions dialog box appears: 

This dialog box displays all the table definitions in the project in 

the form of a table definition tree.

2 Double-click the appropriate branch to display the table definitions 
available. 

3 Select the table definition you want to use.

Note You can use the Find… button to enter the name of the 

table definition you want. The table definition is 

automatically highlighted in the tree when you click OK. 

You can use the Import button to import a table definition 

from a data source.

4 If you cannot find the table definition, you can click Import ➤ 
Data source type to import a table definition from a data source 
(see "Importing a Table Definition" on page 9-12 for details).

5 Click OK. The Select Columns dialog box appears. It allows you 
to specify which column definitions from the table definition you 
want to load.
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Use the arrow keys to move columns back and forth between the 

Available columns list and the Selected columns list. The 

single arrow buttons move highlighted columns, the double arrow 

buttons move all items. By default all columns are selected for 

loading. Click Find… to open a dialog box which lets you search 

for a particular column. The shortcut menu also gives access to 

Find… and Find Next. Click OK when you are happy with your 

selection. This closes the Select Columns dialog box and loads 

the selected columns into the stage.

For mainframe stages and certain parallel stages where the 

column definitions derive from a CFD file, the Select Columns 

dialog box may also contain a Create Filler check box. This 

happens when the table definition the columns are being loaded 

from represents a fixed-width table. Select this to cause 

sequences of unselected columns to be collapsed into filler items. 

Filler columns are sized appropriately, their datatype set to 

character, and name set to FILLER_XX_YY where XX is the start 

offset and YY the end offset. Using fillers results in a smaller set of 

columns, saving space and processing time and making the 

column set easier to understand.

If you are importing column definitions that have been derived 

from a CFD file into server or parallel job stages, you are warned if 

any of the selected columns redefine other selected columns. You 

can choose to carry on with the load or go back and select 

columns again.

6 Save the table definition by clicking OK. 

You can edit the table definition to remove unwanted column 

definitions, assign data elements, or change branch names.

Naming Columns and Table Definitions
The rules for naming columns depend on the type of job the table 

definition will be used in:

Server and Parallel Jobs. Column names can be any length. 
They must begin with an alphabetic character or $ and contain 
alphanumeric, underscore, period, and $ characters.

Mainframe Jobs. Column names can be any length. They must 
begin with an alphabetic character and contain alphanumeric, 
underscore, #, @, and $ characters.

The rules for name table definitions are as follows:

Table names can be any length.

They must begin with an alphabetic character.
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They can contain alphanumeric, period, and underscore 
characters. 

Table definition category names can be any length and consist of any 

characters, including spaces.

Viewing or Modifying a Table Definition
You can view or modify any table definition in your project. To view a 

table definition, select it in the Repository window and do one of the 

following:

Choose Properties… from the shortcut menu.

Double-click the table definition in the display area.

The Table Definition dialog box appears. You can edit any of the 

column definition properties or delete unwanted definitions. 

Editing Column Definitions

To edit a column definition in the grid, click the cell you want to 

change then choose Edit cell… from the shortcut menu or press Ctrl-
E to open the Edit Column Meta Data dialog box. 

For more information about adding and deleting rows, or moving 

between the cells of a grid, see Appendix A, “Editing Grids.” 

Deleting Column Definitions

If, after importing or defining a table definition, you subsequently 

decide that you do not want to read or write the data in a particular 

column you must delete the corresponding column definition. 

Unwanted column definitions can be easily removed from the 

Columns grid. To delete a column definition, click any cell in the row 

you want to remove and press the Delete key or choose Delete row 
from the shortcut menu. Click OK to save any changes and to close 

the Table Definition dialog box.

To delete several column definitions at once, hold down the Ctrl key 

and click in the row selector column for the rows you want to remove. 

Press the Delete key or choose Delete row from the shortcut menu 

to remove the selected rows. 

Finding Column Definitions

The Find facility allows you to locate a particular column definition in 

a table definition. To find a particular column definition, choose Find 
row… from the shortcut menu. The Find dialog box appears, 
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allowing you to enter a string to be searched for in the specified 

column.

Propagating Values

You can propagate the values for the properties set in a column to 

several other columns. Select the column whose values you want to 

propagate, then hold down shift and select the columns you want to 

propagate to. Choose Propagate values... from the shortcut menu 

to open the dialog box.

In the Property column, click the check box for the property or 

properties whose values you want to propagate. The Usage field tells 

you if a particular property is applicable to certain types of job only 

(e.g. server, mainframe, or parallel) or certain types of table definition 

(e.g. COBOL). The Value field shows the value that will be propagated 

for a particular property.

Using the Data Browser
Non-mainframe data 
sources 

When importing table definitions from a data source, you can view the 

actual data in the tables using the Data Browser. The Data Browser 

can be used when importing table definitions from the following 

sources:
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ODBC table

UniVerse table

Hashed (UniVerse) file

Sequential file

UniData file

Some types of plug-in

The Data Browser is opened by clicking the View Data… button on 

the Import Meta Data dialog box. The Data Browser window 

appears:

The Data Browser uses the meta data defined in the data source. If 

there is no data, a Data source is empty message appears instead 

of the Data Browser.

The Data Browser grid has the following controls:

You can select any row or column, or any cell with a row or 
column, and press CTRL-C to copy it.

You can select the whole of a very wide row by selecting the first 
cell and then pressing SHIFT+END.

If a cell contains multiple lines, you can double-click the cell to 
expand it. Single-click to shrink it again.

You can view a row containing a specific data item using the Find… 

button. The Find dialog box repositions the view to the row 
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containing the data you are interested in. The search is started from 

the current row.

The Display… button opens the Column Display dialog box. It 

allows you to simplify the data displayed by the Data Browser by 

choosing to hide some of the columns. It also allows you to normalize 

multivalued data to provide a 1NF view in the Data Browser.

This dialog box lists all the columns in the display, and initially these 

are all selected. To hide a column, clear it.

The Normalize on drop-down list box allows you to select an 

association or an unassociated multivalued column on which to 

normalize the data. The default is Un-Normalized, and choosing Un-
Normalized will display the data in NF2 form with each row shown 

on a single line. Alternatively you can select Un-Normalize 
(formatted), which displays multivalued rows split over several lines.

In the example, the Data Browser would display all columns except 

STARTDATE. The view would be normalized on the association 

PRICES.

Stored Procedure Definitions
You can access data in a database using a stored procedure, if 

required. To do so, you use an ODBC stage in a server job, or the STP 

plugin stage in a server or parallel job (the plugin stage has its own 

documentation, which is available when you install the plugin). 
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A stored procedure can:

Have associated parameters, which may be input or output

Return a value (like a function call)

Create a result set in the same way as an SQL SELECT statement 

Note ODBC stages support the use of stored procedures with or 

without input arguments and the creation of a result set, but 

do not support output arguments or return values. In this 

case a stored procedure may have a return value defined, 

but it is ignored at run time. A stored procedure may not 

have output parameters.

The definition for a stored procedure (including the associated 

parameters and meta data) can be stored in the Repository. These 

stored procedure definitions can be used when you edit an ODBC 

stage or STP plugin stage in your job design. For more information 

about the use of stored procedures in ODBC stages, see "ODBC 

Stages" in Server Job Developer’s Guide. For more information about 

the use of stored procedures with STP stages, see the documentation 

supplied with the plugin.

You can import, create, or edit a stored procedure definition using the 

DataStage Designer. 

Importing a Stored Procedure Definition
The easiest way to specify a definition for a stored procedure is to 

import it directly from the stored procedure on the source or target 

database using an ODBC connection. A new definition for the stored 

procedure is created and stored in the Repository. 

To import a definition for a stored procedure via an ODBC connection:

1 Select the Table Definitions branch in the Repository window and 
choose Import ➤ Table Definitions ➤ Stored Procedure 
Definitions… from the shortcut menu. A dialog box appears 
enabling you to connect to the data source containing the stored 
procedures.

2 Fill in the required connection details and click OK. Once a 
connection to the data source has been made successfully, the 
updated dialog box gives details of the stored procedures 
available for import.

3 Select the required stored procedures and click OK. The stored 
procedures are imported into the DataStage Repository.

Specific information about importing stored procedures is in 

DataStage Developer’s Help.
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The Table Definition Dialog Box for Stored Procedures
When you create, edit, or view a stored procedure definition, the 

Table Definition dialog box appears. This dialog box is described in 

"The Table Definition Dialog Box" on page 9-2. 

The dialog box for stored procedures has additional pages, having up 

to six pages in all:

General. Contains general information about the stored 
procedure. The Data source type field on this page must contain 
StoredProcedures to display the additional Parameters page. 

Columns. Contains a grid displaying the column definitions for 
each column in the stored procedure result set. You can add new 
column definitions, delete unwanted definitions, or edit existing 
ones. For more information about editing a grid, see "Editing 
Column Definitions" on page 9-35.

Parameters. Contains a grid displaying the properties of each 
input parameter.

Note If you cannot see the Parameters page, you must enter 

StoredProcedures in the Data source type field on 

the General page..

The grid has the following columns: 

– Column name. The name of the parameter column.

– Key. Indicates whether the column is part of the primary key. 

– SQL type. The SQL data type. 

– Extended. This column gives you further control over data 
types used in parallel jobs when NLS is enabled. Selecting a 
value from the extended drop-down list is the equivalent to 
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selecting the Extended option in the Edit Column Meta 
Data dialog box Parallel tab. The available values depend on 
the base data type

– I/O Type. Specifies the  type of parameter. Can be one of IN, 
INOUT, OUT, or RETURN. Note that the ODBC stage only 
supports IN and INOUT parameters. The STP stage supports all 
parameter types.

– Length. The data precision. This is the length for CHAR data 
and the maximum length for VARCHAR data. 

– Scale. The data scale factor.

– Nullable. Specifies whether the column can contain null 
values. This is set to indicate whether the column is subject to 
a NOT NULL constraint. It does not itself enforce a NOT NULL 
constraint.

– Display. The maximum number of characters required to 
display the column data.

– Data element. The type of data in the column.

– Description. A text description of the column.

Format. Contains file format parameters for sequential files. This 
page is not used for a stored procedure definition.

NLS. Contains the name of the character set map to use with the 
table definitions.

Error codes. The Error Codes page allows you to specify which 
raiserror calls within the stored procedure produce a fatal error 
and which produce a warning. 

This page has the following fields:
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– Fatal errors. Enter the raiserror values that you want to be 
regarded as a fatal error. The values should be separated by a 
space.

– Warnings. Enter the raiserror values that you want to be 
regarded as a warning. The values should be separated by a 
space.

Manually Entering a Stored Procedure Definition
ODBC data 
sources 

If you are unable to import the definition for your stored procedure, 

you must enter this information manually. 

To manually enter a stored procedure definition, first create the 

definition. You can then enter suitable settings for the general 

properties, before specifying definitions for the columns in the result 

set and the input parameters. 

Note You do not need to edit the Format page for a stored 

procedure definition. 

Creating a Stored Procedure Definition

To create a stored procedure definition:

1 In the Repository window, select the Table Definitions branch and 
choose New Table Definition… from the shortcut menu. The 
Table Definition dialog box appears. You must enter suitable 
values in the fields on the General page.

2 Enter StoredProcedures in the Data source type field. This 
specifies that the new definition will be stored under the Table 
Definitions ➤ StoredProcedures branch in the Repository. The 
Parameters page appears in the Table Definition dialog box. 

3 Enter the name of the data source in the Data source name field. 
This forms the second part of the table definition identifier and is 
the name of the branch created under the data source type branch. 

4 Enter the name of the procedure in the Procedure name field. 
This is the last part of the table definition identifier and is the 
name of the leaf created under the data source branch. 

5 Optionally enter a brief description of the data in the Short 
description field. 

6 Optionally enter a detailed description of the data in the Long 
description field. 

7 Specify the column definitions for the result set on the Columns 
page and the input parameters (if any) for the stored procedure on 
the Parameters page. 
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8 If NLS is enabled and you do not want to use the default project 
NLS map, select the required map from the NLS page.

Specifying Column Definitions for the Result Set

To specify the column definitions for the result set, click the Columns 

tab in the Table Definition dialog box. The Columns page appears 

at the front of the Table Definition dialog box. You can now enter or 

load column definitions. For more information, see "Entering Column 

Definitions" on page 9-14 and "Loading Column Definitions" on 

page 9-32.

Note You do not need a result set if the stored procedure is used 

for input (writing to a database). However, in this case, you 

must have input parameters.

Specifying Input Parameters

To specify input parameters for the stored procedure, click the 

Parameters tab in the Table Definition dialog box. The 

Parameters page appears at the front of the Table Definition dialog 

box. 

You can enter parameter definitions are entered directly in the 

Parameters grid using the general grid controls described in 

Appendix A, “Editing Grids.”, or you can use the Edit Column Meta 
Data dialog box. To use the dialog box:. 

1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.

– Press Ctrl-E.

The Edit Column Meta Data dialog box appears. The Server 

tab is on top, and only contains a Data Element and a Display 

field.

2 In the main page, specify the SQL data type by choosing an 
appropriate type from the drop-down list in the SQL type cell. 

3 Enter an appropriate value for the data precision in the Length 
cell. 

4 Enter an appropriate data scale factor in the Scale cell. 

5 Specify whether the parameter can contain null values by 
choosing an appropriate option from the drop-down list in the 
Nullable cell. 
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6 Enter text to describe the column in the Description cell. This cell 
expands to a drop-down text entry box if you enter more 
characters than the display width of the column. You can increase 
the display width of the column if you want to see the full text 
description. 

7 In the Server tab, enter the maximum number of characters 
required to display the parameter data in the Display cell. 

8 In the Server tab, choose the type of data the column contains 
from the drop-down list in the Data element cell. This list 
contains all the built-in data elements supplied with DataStage 
and any additional data elements you have defined. You do not 
need to edit this cell to create a column definition. You can assign 
a data element at any point during the development of your job. 

9 Click APPLY and CLOSE to save and close the Edit Column 
Meta Data dialog box. 

10 You can continue to add more parameter definitions by editing the 
last row in the grid. New parameters are always added to the 
bottom of the grid, but you can select and drag the row to a new 
position in the grid. 

Specifying NLS Mapping

If NLS is enabled and you want to use a different character set map 

than that defined as the project default, click the NLS tab in the Table 
Definition dialog box. The NLS page appears at the front of the 

Table Definition dialog box. 

Choose the name of the map to use from the list box. By default, the 

list box shows all the maps that are loaded and ready to use. Show 
all maps lists all the maps that are shipped with DataStage. 

If you intend to use the stored procedure in a parallel job, ensure that 

the Show all Parallel maps option is selected.

Click Allow per-column mapping if you want to assign different 

character set maps to individual columns.

Note You cannot use a map unless it is loaded into DataStage. 

You can load different maps using the DataStage 

Administrator. For more information, see "NLS 

Configuration" in DataStage Administrator Guide.

Viewing or Modifying a Stored Procedure Definition
ODBC data 
sources 

You can view or modify any stored procedure definition in your 

project. To view a stored procedure definition, select it in the 

Repository window and do one of the following:

Choose Properties… from the shortcut menu.
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Double-click the stored procedure definition in the display area.

The Table Definition dialog box appears. You can edit or delete any 

of the column or parameter definitions. 

Editing Column or Parameter Definitions

You can edit the settings for a column or parameter definition by 

editing directly in the Columns or Parameters grid. To edit a definition, 

click the cell you want to change. The way you edit the cell depends on 

the cell contents. If the cell contains a drop-down list, choose an 

alternative option from the drop-down list. If the cell contains text, 

you can start typing to change the value, or press F2 or choose Edit 
cell… from the shortcut menu to put the cell into edit mode. 

Alternatively you can edit rows using the Edit Column Meta Data 

dialog box. 

For more information about adding and deleting rows, or moving 

between the cells of a grid, see Appendix A, “Editing Grids.” 

Deleting Column or Parameter Definitions

If, after importing or defining stored procedure columns, you 

subsequently decide that you do not want to read or write the data in 

a particular column you must delete the corresponding column 

definition.

Unwanted column or parameter definitions can be easily removed 

from the Columns or Parameters grid. To delete a column or 

parameter definition, click any cell in the row you want to remove and 

press the Delete key or choose Delete row from the shortcut menu. 

(You can delete all the rows by clicking Clear All). Click OK to save 

any changes and to close the Table Definition dialog box.

To delete several column or parameter definitions at once, hold down 

the Ctrl key and click in the row selector column for the rows you want 

to remove. Press the Delete key or choose Delete row from the 

shortcut menu to remove the selected rows.
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10
Programming in DataStage

This chapter describes the programming tasks that you can perform in 

DataStage. 

The programming tasks that might be required depend on whether 

you are working on server jobs, parallel jobs, or mainframe jobs. This 

chapter provides a general introduction to the subject, telling you 

what you can do. Details of programming tasks are in Server Job 

Developer’s Guide, Parallel Job Developer’s Guide, and Mainframe 

Job Developer’s Guide.

Note When using shared libraries you will need to ensure that 

they libraries are in the right order in the LD_LIBRARY PATH 

environment variable (UNIX servers).

Programming in Server Jobs
For many DataStage server jobs you may not need to perform any 

programming tasks. You can just choose ready made transforms and 

routines from the built-in ones supplied with DataStage and stored in 

the Repository. For more complex tasks and custom transforms, 

DataStage provides powerful procedural programming facilities.

At the heart of server job programming in DataStage is the BASIC 

language. For more information about BASIC syntax, see "BASIC 

Programming" in DataStage Server Job Developer’s Guide. 

There are several areas within a server job where you may need to 

enter some code:
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Defining custom routines to use as building blocks in other 
programming tasks. For example, you may define a routine which 
will then be reused by several custom transforms. You can view, 
edit, and create your own BASIC routines using the DataStage 
Manager. 

Defining custom transforms. The function specified in a transform 
definition converts the data in a chosen column. 

Defining derivations, key expressions, and constraints while 
editing a Transformer stage. 

Defining before-stage and after-stage subroutines. These 
subroutines perform an action before or after a stage has 
processed data. These subroutines can be specified for 
Aggregator, Transformer, and some plug-in stages. 

Defining before-job and after-job subroutines. These subroutines 
perform an action before or after a job is run and are set as job 
properties. 

Defining job control routines. These subroutines can be used to 
control other jobs from within the current job. 

The Expression Editor
The DataStage Expression Editor helps you to enter correct 

expressions when you edit Transformer stages and define custom 

transforms in the DataStage Manager. The Expression Editor can:

Facilitate the entry of expression elements

Complete the names of frequently used variables

Validate variable names and the complete expression

When you are entering expressions, the Expression Editor offers 

choices of operands and operators from context-sensitive shortcut 

menus.

Programming Components
There are different types of programming components used in server 

jobs. They fall within these three broad categories:

Built-in. DataStage has several built-in programming 
components that you can reuse in your server jobs as required. 
Some of the built-in components are accessible using the 
DataStage Manager or DataStage Designer, and you can copy 
code from these. Others are only accessible from the Expression 
Editor, and the underlying code is not visible.
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Custom. You can also define your own programming 
components using the DataStage Manager or DataStage Designer, 
specifically routines and custom transforms. These are stored in 
the DataStage Repository and can be reused for other jobs and by 
other DataStage users.

External. You can use certain types of external component from 
within DataStage. If you have a large investment in custom 
UniVerse functions or ActiveX (OLE) functions, then it is possible 
to call these from within DataStage. This is done by defining a 
wrapper routine which in turn calls the external functions. Note 
that the mechanism for including custom UniVerse functions is 
different from including ActiveX (OLE) functions. 

The following sections discuss programming terms you will come 

across when programming server jobs. 

Routines
Routines are stored in the Routines branch of the DataStage 

Repository, where you can create, view, or edit them using the 

Routine dialog box. The following program components are 

classified as routines:

Transform functions. These are functions that you can use 
when defining custom transforms. DataStage has a number of 
built-in transform functions which are located in the Routines ➤ 
Examples ➤ Functions branch of the Repository. You can also 
define your own transform functions in the Routine dialog box. 

Before/After subroutines. When designing a job, you can 
specify a subroutine to run before or after the job, or before or 
after an active stage. DataStage has a number of built-in before/
after subroutines, which are located in the Routines ➤ Built-in ➤ 
Before/After branch in the Repository. You can also define your 
own before/after subroutines using the Routine dialog box.

Custom UniVerse functions. These are specialized BASIC 
functions that have been defined outside DataStage. Using the 
Routine dialog box, you can get DataStage to create a wrapper 
that enables you to call these functions from within DataStage. 
These functions are stored under the Routines branch in the 
Repository. You specify the category when you create the routine. 
If NLS is enabled, you should be aware of any mapping 
requirements when using custom UniVerse functions. If a function 
uses data in a particular character set, it is your responsibility to 
map the data to and from Unicode.

ActiveX (OLE) functions. You can use ActiveX (OLE) functions 
as programming components within DataStage. Such functions 
are made accessible to DataStage by importing them. This creates 
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a wrapper that enables you to call the functions. After import, you 
can view and edit the BASIC wrapper using the Routine dialog 
box. By default, such functions are located in the Routines ➤ 
Class name branch in the Repository, but you can specify your 
own category when importing the functions.

When using the Expression Editor, all of these components appear 

under the DS Routines… command on the Suggest Operand 
menu.

A special case of routine is the job control routine. Such a routine is 

used to set up a DataStage job that controls other DataStage jobs. Job 

control routines are specified in the Job control page on the Job 
Properties dialog box. Job control routines are not stored under the 

Routines branch in the Repository.

Transforms
Transforms are stored in the Transforms branch of the DataStage 

Repository, where you can create, view or edit them using the 

Transform dialog box. Transforms specify the type of data 

transformed, the type it is transformed into, and the expression that 

performs the transformation.

DataStage is supplied with a number of built-in transforms (which you 

cannot edit). You can also define your own custom transforms, which 

are stored in the Repository and can be used by other DataStage jobs.

When using the Expression Editor, the transforms appear under the 

DS Transform… command on the Suggest Operand menu.

Functions
Functions take arguments and return a value. The word “function” is 

applied to many components in DataStage:

BASIC functions. These are one of the fundamental building 
blocks of the BASIC language. When using the Expression Editor, 
you can access the BASIC functions via the Function… command 
on the Suggest Operand menu.

DataStage BASIC functions. These are special BASIC functions 
that are specific to DataStage. These are mostly used in job 
control routines. DataStage functions begin with DS to distinguish 
them from general BASIC functions. When using the Expression 
Editor, you can access the DataStage BASIC functions via the DS 
Functions… command on the Suggest Operand menu.

The following items, although called “functions,” are classified as 

routines and are described under "Routines" on page 10-3. When 
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using the Expression Editor, they all appear under the DS Routines… 

command on the Suggest Operand menu.

Transform functions

Custom UniVerse functions

ActiveX (OLE) functions

Expressions
An expression is an element of code that defines a value. The word 

“expression” is used both as a specific part of BASIC syntax, and to 

describe portions of code that you can enter when defining a job. 

Areas of DataStage where you can use such expressions are:

Defining breakpoints in the debugger

Defining column derivations, key expressions and constraints in 
Transformer stages

Defining a custom transform

In each of these cases the DataStage Expression Editor guides you as 

to what programming elements you can insert into the expression.

Subroutines
A subroutine is a set of instructions that perform a specific task. 

Subroutines do not return a value. The word “subroutine” is used 

both as a specific part of BASIC syntax, but also to refer particularly to 

before/after subroutines which carry out tasks either before or after a 

job or an active stage. DataStage has many built-in before/after 

subroutines, or you can define your own.

Before/after subroutines are included under the general routine 

classification as they are accessible under the Routines branch in the 

Repository.

Macros
DataStage has a number of built-in macros. These can be used in 

expressions, job control routines, and before/after subroutines. The 

available macros are concerned with ascertaining job status.

When using the Expression Editor, they appear under the DS 
Macro… command on the Suggest Operand menu.
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Programming in Mainframe Jobs
There are two types of programming task supported in mainframe 

jobs; defining expressions and calling external routines. Expressions 

are used to perform processing in various mainframes stages. 

External routines are used to call a COBOL library function.

Expressions
Expressions are defined using a built-in language based on SQL3. For 

more information about this language, see Mainframe Job 

Developer’s Guide. You can use expressions to specify:

Column derivations 

Key expressions 

Constraints

Stage variables 

You specify these in various mainframe job stage editors as follows:

Transformer stage – column derivations for output links, stage 
variables, and constraints for output links

Relational stage – key expressions in output links

Complex Flat File stage – key expressions in output links

Fixed-Width Flat File stage – key expressions in output links

Join stage – key expression in the join predicate

External Routine stage – constraint in each stage instance

The Expression Editor helps you with entering appropriate 

programming elements. It operates for mainframe jobs in much the 

same way as it does for server jobs. It helps you to enter correct 

expressions and can:

Facilitate the entry of expression elements

Validate variable names and the complete expression

When the Expression Editor is used in a mainframe job it offers a set 

of the following, depending on the context in which you are using it:

Link columns

Variables

Job parameters

SQL3 functions

Constants
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More details about using the mainframe Expression Editor are given 

in Mainframe Job Developer’s Guide.

Routines
The External Routine stage enables you to call a COBOL subroutine 

that exists in a library external to DataStage in your job. You must first 

define the routine, details of the library, and its input and output 

arguments. The routine definition is stored in the DataStage 

Repository and can be referenced from any number of External 

Routine stages in any number of mainframe jobs.

Defining and calling external routines is described in more detail in 

the Mainframe Job Developer’s Guide.

Programming in Parallel Jobs
Programming tasks in parallel jobs comprise:

defining expressions within parallel jobs

defining functions to be used in expressions

defining routines to be executed before or after an active stage.

A general point to note with programming in parallel jobs is that you 

must always bear in mind the parallel nature of the processing. You 

cannot, for example, rely on the consecutive calling of different 

functions that all assume data is being stored in a common memory 

location. In a parallel system the functions could be executed in any 

order as processing power becomes available. In such a situation you 

should write functions so that the required information can be passed 

through a pipe.

Expressions
Expressions are used to define:

Column derivations 

Constraints

Stage variables 

Expressions are defined using a built-in language. The Expression 

Editor available from within the Transformer stage helps you with 

entering appropriate programming elements. It operates for parallel 

jobs in much the same way as it does for server jobs and mainframe 

jobs. It helps you to enter correct expressions and can:
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Facilitate the entry of expression elements

Validate variable names and the complete expression

For more details about the expression editor, and about the built-in 

language, see "The DataStage Expression Editor" in Parallel Job 

Developer’s Guide.

Functions
For many expressions you can choose ready made functions from the 

built-in ones supplied with DataStage. You can also, however, define 

your own functions that can be accessed from the expression editor, 

such functions must be supplied within a UNIX shared library or in a 

standard object file (filename.o) and then referenced by defining a 

parallel routine within the DataStage project which calls it. For details 

of how to define a function, see "Working with Parallel Routines" in 

DataStage Manager Guide.

Routines
Parallel jobs also have the ability of executing routines before or after 

an active stage executes. These routines are defined and stored in the 

DataStage Repository, and then called in the Triggers page of the 

particular Transformer stage Properties dialog box (see"Transformer 

Stage Properties" in Parallel Job Developer’s Guide for more details). 

These routines must be supplied in a UNIX shared library or an object 

file, and do not return a value. For details of how to define a routine, 

see "Working with Parallel Routines" in DataStage Manager Guide.

Naming Routines and Functions
Routines and Transforms are stored in the DataStage repository and 

have certain rules about names they can have.

Naming Routines
Slightly different rules apply to mainframe job routines and to server 

and parallel job routines.

Mainframe Job Routines

Routine names can be one to eight characters in length. They must 

begin with an alphabetic character and can contain alphanumeric, $, #, 

and @ characters.
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Routine category names can be any length and consist of any 

characters, including spaces.

Server/Parallel Job Routines

Routine names can be any length. They must begin with an alphabetic 

character and can contain alphanumeric and period characters.

Routine category names can be any length and consist of any 

characters, including spaces.

Naming Transforms
The following rules apply to naming custom transforms:

Names can be any length.

They must begin with an alphabetic character.

They can contain alphanumeric characters and underscores.

Transform category names can be any length and consist of any 

characters, including spaces.
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Editing Grids

DataStage uses grids in many dialog boxes for displaying data. This 

system provides an easy way to view and edit tables. This appendix 

describes how to navigate around grids and edit the values they 

contain. 

Grids
The following screen shows a typical grid used in a DataStage dialog 

box: 

On the left side of the grid is a row selector button. Click this to select 

a row, which is then highlighted and ready for data input, or click any 

of the cells in a row to select them. The current cell is highlighted by a 

chequered border. The current cell is not visible if you have scrolled it 

out of sight. 

Some cells allow you to type text, some to select a checkbox and 

some to select a value from a drop-down list. 

You can move columns within the definition by clicking the column 

header and dragging it to its new position. You can resize columns to 

the available space by double-clicking the column header splitter.
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You can move rows within the definition by right-clicking on the row 

header and dragging it to its new position. The numbers in the row 

header are incremented/decremented to show its new position.

The grid has a shortcut menu containing the following commands:

Edit Cell. Open a cell for editing.

Find Row… . Opens the Find dialog box (see"Finding Rows in the 
Grid" on page A-4).

Edit Row… . Opens the relevant Edit Row dialog box (see 
"Editing in the Grid" on page A-4).

Insert Row. Inserts a blank row at the current cursor position.

Delete Row. Deletes the currently selected row.

Propagate values… . Allows you to set the properties of several 
rows at once (see "Propagating Values" on page A-6).

Properties. Opens the Properties dialog box (see "Grid 
Properties" on page A-2).

Grid Properties
The Grid Properties dialog box allows you to select certain features 

on the grid.
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Select and order columns. Allows you to select what columns 
are displayed and in what order. The Grid Properties dialog box 
displays the set of columns appropriate to the type of grid. The 
example shows columns for a server job columns definition. You 
can move columns within the definition by right-clicking on them 
and dragging them to a new position. The numbers in the position 
column show the new position.

Allow freezing of left columns. Choose this to freeze the 
selected columns so they never scroll out of view. Select the 
columns in the grid by dragging the black vertical bar from next to 
the row headers to the right side of the columns you want to 
freeze.

Allow freezing of top rows. Choose this to freeze the selected 
rows so they never scroll out of view. Select the rows in the grid 
by dragging the black horizontal bar from under the column 
headers to the bottom edge of the rows you want to freeze.

Enable row highlight. Select this to enable highlighting of 
selected rows, disable it to highlight only the current cell.

Excel style headers. Select this to specify that selected row and 
column header buttons should be shown as raised when selected.

Apply settings to current display only. Select this to apply the 
selected properties to only this grid.

Save settings for future display. Select this to apply setting to 
all future displays of grids of this type.

Navigating in the Grid
You can move around the grid by using the mouse and scroll bars, or 

the keyboard. Table A-1 shows the keys that are used for navigation in 

the grid. 

Table A-1 Keys Used in Grid Navigation

Key Action

Right Arrow Move to the next cell on the right.

Left Arrow Move to the next cell on the left.

Up Arrow Move to the cell immediately above.

Down Arrow Move to the cell immediately below.

Tab Move to the next cell on the right. If the current cell is in the 
rightmost column, move forward to the next control on the form.
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Finding Rows in the Grid
The Find facility allows you to locate a particular row in a table 

definition. To find a particular row, choose Find row… from the 

shortcut menu. The Find dialog box appears, allowing you to specify 

the column to search and what is to be searched for.

Editing in the Grid
You can edit grids by using mouse and keyboard to directly modify 

the fields, or you can choose Edit Row… from the shortcut menu to 

open a dialog box enabling you to edit individual rows. The dialog 

box differs slightly depending on what type of grid you are editing. 

Additional controls are available to make the task simpler if you are 

editing a grid that defines one of the following:

Column definitions in a Table Definition dialog box

Column definitions in a server or mainframe stage editor

Arguments in a mainframe routine definition

Shift-Tab Move to the next cell on the left. If the current cell is in the 
leftmost column, move back to the previous control on the form.

Page Up Scroll the page down.

Page Down Scroll the page up.

Home Move to the first cell in the current row.

End Move to the last cell in the current row.

Table A-1 Keys Used in Grid Navigation

Key Action
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Editing the Grid Directly
These edit commands work on any type of grid. You can edit the 

contents of the current cell in three ways:

Start typing in the cell.

Press the F2 key to put the cell into edit mode.

Choose the Edit cell… command from the shortcut menu.

When you start editing, the current contents of the cell are highlighted 

ready for editing. If the cell is currently empty, an edit cursor appears. 

Table A-2 shows the keys that are used for editing in the grid. 

Adding Rows

You can add a new row by entering data in the empty row. When you 

move the focus away from the row, the new data is validated. If it 

passes validation, it is added to the table, and a new empty row 

appears. Alternatively, press the Insert key or choose Insert row… 

from the shortcut menu, and a row is inserted with the default column 

name Newn, ready for you to edit (where n is an integer providing a 

unique Newn column name).

Table A-2 Keys Used in Grid Editing

Key Action

Esc Cancel the current edit. The grid leaves edit mode, and the cell 
reverts to its previous value. The focus does not move.

Enter Accept the current edit. The grid leaves edit mode, and the cell 
shows the new value. When the focus moves away from a modified 
row, the row is validated. If the data fails validation, a message box is 
displayed, and the focus returns to the modified row.

Up Arrow Move the selection up a drop-down list or to the cell immediately 
above. 

Down 
Arrow

Move the selection down a drop-down list or to the cell immediately 
below.

Left Arrow Move the insertion point to the left in the current value. When the 
extreme left of the value is reached, exit edit mode and move to the 
next cell on the left.

Right Arrow Move the insertion point to the right in the current value. When the 
extreme right of the value is reached, exit edit mode and move to the 
next cell on the right.

Ctrl-Enter Enter a line break in a value.
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Deleting Rows

To delete a row, click anywhere in the row you want to delete to select 

it. Press the Delete key or choose Delete row from the shortcut 

menu. To delete multiple rows, hold down the Ctrl key and click in the 

row selector column for the rows you want to delete and press the 

Delete key or choose Delete row from the shortcut menu.

Propagating Values

You can propagate the values for the properties set in a grid to several 

rows in the grid. Select the column whose values you want to 

propagate, then hold down shift and select the columns you want to 

propagate to. Choose Propagate values... from the shortcut menu 

to open the dialog box.

In the Property column, click the check box for the property or 

properties whose values you want to propagate. The Usage field tells 

you if a particular property is applicable to certain types of job only 

(e.g. server, mainframe, or parallel) or certain types of table definition 

(e.g. COBOL). The Value field shows the value that will be propagated 

for a particular property.

Editing Column Definitions in a Table Definitions Dialog 
Box

To edit column definitions:

1 Do one of the following:

– Right-click in the column area and choose Edit row… from the 
shortcut menu.
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– Press Ctrl-E.

– Double-click on the row number cell at the left of the grid.

The Edit Column Meta Data dialog box appears. It has a 

general section containing fields that are common to all data 

source types, plus three tabs containing fields specific to meta 

data used in server jobs or parallel jobs and information specific 

to COBOL data sources.

Descriptions of each of the fields in this dialog box are in "Entering 

Column Definitions" on page 9-14.

2 Enter the general information for each column you want to define.

3 If you are specifying meta data for a server job type data source or 
target, then the Edit Column Meta Data dialog bog box appears 
with the Server tab on top. Enter any required information that is 
specific to server jobs.

4 If you are specifying meta data for a parallel job type data source 
or target, then the Edit Column Meta Data dialog bog box 
appears with the Parallel tab on top. Enter any required format 
information that is required by a parallel job.

5 If you are specifying meta data for a mainframe job type data 
source or target, then the Edit Column Meta Data dialog bog 
box appears with the COBOL tab on top. Enter any required 
information that is specific to mainframe jobs.

6 Use the buttons at the bottom of the Edit Column Meta Data 
dialog box to continue adding or editing columns, or to save and 
close. The buttons are:
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– <Previous and Next>. View the meta data in the previous or 
next row. These buttons are enabled only where there is a 
previous or next row enabled. If there are outstanding changes 
to the current row, you are asked whether you want to save 
them before moving on.

– Close. Close the Edit Column Meta Data dialog box. If there 
are outstanding changes to the current row, you are asked 
whether you want to save them before closing.

– Apply. Save changes to the current row.

– Reset. Remove all changes made to the row since the last time 
you applied changes.

7 Click OK to save the column definitions and close the Edit 
Column Meta Data dialog box. 

You can also edit a columns definition grid using the general grid 

editing controls, described in "Editing the Grid Directly" on page A-5.

Editing Column Definitions in a Mainframe Stage Editor
Editing the columns in a mainframe stage editor is similar to editing 

any column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited. 

There are three versions of the Edit Column Meta Data dialog box, 

depending on what type of mainframe stage you are editing.

The fields for all variants of the Edit Column Meta Data dialog box 

for mainframe stage types are described in Mainframe Job 

Developer’s Guide.
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The dialog box for the Complex Flat File stage is:

The dialog box for the Fixed Width Flat File and Relational stages is:

(Note there is no Date Format field in relational stages.)
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The dialog box for other stages is:

Editing Column Definitions in a Server Job Stage
Editing the columns in a server job stage editor is similar to editing 

any column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited. 

There are different versions of the Edit Column Meta Data dialog 

box, depending on what type of server job stage you are editing and 

whether it is an input or output link. The fields in the top portion of the 

dialog box are the same, but fields in the Server tab differ.

The fields for all variants of the Edit Column Meta Data dialog box 

for server stage types are described in Server Job Developer’s Guide.
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The following is an example dialog box for a Sequential File stage:

Editing Arguments in a Mainframe Routine Dialog Box
Editing the arguments for a mainframe routine is similar to editing 

column definitions. The same controls are available; the differences 

lie in the fields that are presented to be edited. 

There are three types of mainframe routine, external routine, external 

target routine, and external source routine. The fields are described in 

Mainframe Job Developer’s Guide.
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The Edit Routine Argument dialog box for external routines is as 

follows:

The Edit Routine Argument dialog box for external source routines 

is as follows:
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The Edit Routine Argument dialog box for external target routines 

is as follows:

Editing Column Definitions in a Parallel Job Stage
Editing the columns in a parallel job stage editor is similar to editing 

server job column definitions. The same controls are available; the 

differences lie in the fields that are presented to be edited in the Edit 
Column Meta Data dialog box. 
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Troubleshooting

This appendix describes problems you may encounter with DataStage 

and gives solutions. 

Cannot Start DataStage Clients
Check that the DataStage Engine is actually running on the server. 

On Windows servers, ensure that the DataStage Engine Resource 

service, DS RPC service, and DataStage Telnet service are all started.

On UNIX servers, ensure that the RPC daemon (dsrpcd) is started.

Problems While Working with UniData 
For more information about connecting to UniData5.2 and 6 sources, 

see the document Accessing UniVerse and UniData Databases from 

DataStage. This is supplied with the DataStage online documentation.

Connecting to UniData Databases
When the DataStage server is installed, a copy of the UniData API 

configuration file UNIAPI.INI is installed in the Windows directory. If, 

when you first attempt to connect to your UniData server, you get an 

error message similar to:

UniData Client error: call to UniOpenPos returned 45 - Client version (11) 
and server version (12) are incompatible

then you must edit the UNIAPI.INI file and change the value of the 

PROTOCOL variable. In this case, change it from 11 to 12:
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Problems Using BCPLoad Stage with SQL Server Troubleshooting
PROTOCOL = 12

Importing UniData Meta Data
When importing UniData meta data, note that the server name 

required in the DataStage Manager dialog box is the UniData server 

node name, not the ObjectCall (UNIAPI.INI) file entry name. 

If the UniData server is on the same node as the DataStage server, 

then the name localhost can be used.

Using the UniData Stage
The UniData stage uses the UniData Basic ITYPE function to evaluate 

virtual attributes and this requires that the virtual attributes are 

compiled. If they are not, when the link is opened an error occurs 

which indicates the first uncompiled I-type/virtual attribute it finds. In 

this instance, the solution is to compile all of the I-types/virtual 

attributes, not just the first one reported in the error message.

There are certain verbs that need to be available for use on the 

UniData database when the job containing the UniData stage is first 

run, or when the Data Browser is first used in the stage. These are:

BASIC

CATALOG

NEWPCODE

The BP directory file must also be available.

After the initial job run or first use of the Data Browser, these can be 

removed or disabled if required for security reasons.

Problems Using BCPLoad Stage with SQL 
Server

If the following error is returned when using the BCPLoad stage with 

data in YMD format, and the Date Format has been set: 

Attempt to convert data stopped by syntax error in source field. If your 
table contains date fields in ymd format make sure the Date Format 
property is set

then uncheck the Use International Settings checkbox in the DB-
Library option page of the SQL Server Client Network Utility.

If your job uses data in the upper 128 characters of the character set 

and the data is not appearing correctly on the database then uncheck 
B-2 Designer Guide



Troubleshooting Problems Running Jobs
the Automatic ANSI to OEM conversion checkbox in the DB-
Library option page of the SQL Server Client Network Utility. 

Problems Running Jobs

Server Job Compiles Successfully but Will Not Run
Check that your job design does not have cyclic dependencies within a 

sequence of active stages. This may cause your job to fail as one 

stage waits for another, which is in turn waiting for it.

Server Job from Previous DataStage Release Will Not 
Run

If you run a job created using an earlier DataStage release, you may 

get the message:

Job has not been compiled with compatible compiler

The solution is to recompile, rerelease, and, if necessary, repackage 

jobs under the later release of DataStage.

Mapping Errors when Compiling on UNIX
If you get mapping errors when compiling jobs that contain certain 

non-ascii characters, you should check that the UNIX server is set up 

correctly. 

You need to edit the $DSHOME/dsenv file to specify the locale that the 

server uses (this is separate from the default locales for projects or 

jobs, which can be different if required). This enables server jobs to 

compile correctly. Locate the following section in dsenv:

#LANG="<langdef>";export LANG
#LC_ALL="<langdef>";export LC_ALL
#LC_CTYPE="<langdef>";export LC_CTYPE
#LC_COLLATE="<langdef>";export LC_COLLATE
#LC_MONETARY="<langdef>";export LC_MONETARY
#LC_NUMERIC="<langdef>";export LC_NUMERIC
#LC_TIME="<langdef>";export LC_TIME
#LC_MESSAGES="<langdef>"; export LC_MESSAGES

Take the following steps:
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1 Replace all occurrences of <langdef> with the locale used by the 
server (the locale must be one of those listed when you use the 
locale -a command).

2 Remove the #s at the start of the lines.

3 Stop and restart the DataStage server:

To stop the server:

$DSHOME/bin/uv -admin -stop

To start the server:

$DSHOME/bin/uv -admin -start

Ensure that you allow sufficient time between executing stop and 

start commands (minimum of 30 seconds recommended).

Miscellaneous Problems

Browsing for Directories
When browsing directories within DataStage, you may find that only 

local drive letters are shown. If you want to use a remote drive letter, 

you should type it in rather than relying on the browse feature.
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